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Overview

1 Overview

TreeSize is a powerful and flexible hard disk space manager for Windows.

Why TreeSize:

· Manage and clean up disk space efficiently

· Visualize disk usage

· Analyze in detail, down to all directory levels

· Find and remove redundant files

· Numerous export and reporting possibilities

Manage disk space and scan your hard disks

Find out which folders are the largest on your drives and recover precious disk
space. Use TreeSize as a hard disk cleanup tool: find space hogs and remove
them. Graphical analyses provide a quick visualization of disk space usage.
TreeSize shows you folder size and allocated disk space as well as owner and
permissions, the last access date, the NTFS compression rate, and much
more information for selected folders or drives.

Search for Redundant Files

The integrated versatile file search  helps you find old, big, temporary, and
duplicate files on drives, entire servers or the entire network. Search results
can be moved, deleted or exported to a ZIP file. 

Print or Export Results

You can print detailed reports or export the collected data to different formats
(XML, XLS, TXT, CSV and many more). TreeSize also enables you to track
disk space usage development over time via XML report comparison or
snapshots.

The application has an intuitive Explorer-like user interface and supports drag-
and-drop. It is fast, multi-threaded and supports Unicode- and NTFS-specific
features. TreeSize can be started from the context menu of every folder or
drive.

Take a visual tour or read our product data sheet to learn how to manage disk
space with TreeSize.

97

https://www.jam-software.com/treesize/screens.shtml
https://www.jam-software.com/sites/default/files/2019-04/TreeSizeProfessional_Data_Sheet_EN.pdf
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Installation

2 Installation

To install TreeSize, execute the setup file and follow the instructions. TreeSize
requires Windows Vista/2008 or upwards as well as the .Net framework 4.5,
which will be installed automatically when missing (Information regarding disk
space management on other operating systems can be found on:
https://www.diskspacemanagement.com/). The setup program will copy the
necessary files to your hard disk and will create a new program group in the
Start menu/screen. TreeSize can be uninstalled using the Software applet in
the Windows Control Panel. You will find the installation key for the registered
version on the license document (PDF) sent to you after the purchase. During
your maintenance period the key will be provided in your customer area.

A portable installation on USB removable device can be created using the
ribbon bar "Tools" .

Unattended Installation

Starting the EXE-based installer with the command line parameters 

/SILENT /SUPPRESSMSGBOXES /PASSWORD=YourInstallKey  

will perform a silent and automatic installation with the default settings. Please
replace  YourInstallKey  with the installation key that you received after your
registration. Using /VERYSILENT instead of /SILENT will prevent any visual
feedback. The option /DIR="x:\dirname" can be used to override the default
install path.

Customer with 25 or more licenses are able to download a 64Bit MSI installer
in out customer area. To perform a silent and unattended installation using the
MSI-Installer, you need to use a command line like this for MsiExec:

msiexec /qn /i "TreeSizeProfessional-x64-Full-EN.msi"
INSTALLATION_KEY="XXXXXX-XXXXXX-XXXXXX-XXXXXX-XXXXXX"

Please prefix the MSI file with the path of the network share, in which the MSI
file is stored, and adjust the installation key. You may also set the property
INSTALLATION_KEY by modifying the MSI file using a tool like Orca. 

3 Quickstart

After the installation, TreeSize can be started using the Windows Start
menu/screen or the context menu of a folder or drive. These are the important
elements of the TreeSize main window:

26

https://www.diskspacemanagement.com/
https://customers.jam-software.de/?language=EN
https://msdn.microsoft.com/de-de/library/aa370557(v=vs.85).aspx
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Quickstart

1
.

The Ribbon Bar provides access to all commands of TreeSize. It is divided
into logical sections such as the "Home " tab containing commonly used
functions and elements, or the "View " tab enabling you to customize the
appearance of TreeSize. The colored tab to the right is a context-sensitive
depending on the currently active view. Use the "Select directory for
scan" to start the scanning process for a drive or folder.

2
.

This section contains a drop-down list enabling you to select a drive or
folder to be scanned. You can enter paths directly in the control field.
Press enter or click the scan button on the right to start a scan for the
entered path. TreeSize will remember recently used paths and add them
to the list.

3
.

The Directory Tree  of the scanned folder or drive provides an
immediate overview of the size of each folder.

4
.

The Drive List  provides an overview of all local and mapped network
drives. Additional network drives can be added using the context menu.
Double-click on a drive to start a scan in TreeSize.

5
.

This section will provide additional information regarding the scanned path
(e.g. its total size and the number of folders contained).

6
.

The view section contains several different tabs, each of them providing a
highly specialized data view of the currently selected drive or folder. As
soon as a view is activated, the corresponding context tab will become
active on which you will find useful commands for this view. These are the
available views of TreeSize:
· The "Chart " view visualizes folder information either as a "Pie

Chart , "Bar Chart " or as a "Tree Map ". 
· The "Details " view will provide you detailed information on all files

and folders contained in the current selected item in the Directory
Tree

· The "Extensions " view presents information on size grouped by file
types. Thus, you'll gain an overview of the types of files that use up
most of the disk space. 

· The "Users " view shows information on size grouped by users. You
will see at a glance which user uses how much space in which folder. 

22

27

31

56

34

36 38 39

40

31

45

47



8

TreeSize 
 
                                                                                                                                                                                                                                             ©1995-2020 by Joachim Marder e.K.

Quickstart

· The "Age of Files " view shows the distribution of the age of scanned
files, based on a certain date attribute.

· The "Top 100 Files " view lists the 100 largest files in the scanned
path along with several other details.

· The "History " view shows changes in for the scanned path in a line
chart.

7
.

The Quick Access Toolbar  is a customizable shortcut to many useful
functions of TreeSize.

4 What's New

See What's New online.

5 FAQ

5.1 General / Registration

Q:Which operating system does TreeSize run on? What are the system
requirements?

A: See chapter "Installation ".

Q:How can I order TreeSize? What does ... cost?
A: For questions regarding prices please have a look at our price list and our

ordering FAQ.

Q:How many licenses do I need?
A: Please use our license calculator and check our license agreement.

Q:What is the difference between the Professional and the Personal
Edition?

A: Please check our comparison matrix.

Q:What is the difference between the evaluation copy and the full
version? Will there be additional features?

A: The evaluation copy allows you to test the software before you buy it. The
maximum time to do this is 30 days. Further usage of the software after this
period is not permitted and violates the law. In order to allow our customers
to fully test our software products, the evaluation copy does not contain
functional limitations, except: In the File Search the "Delete/Move/Archive"
operation processes only a certain amount of checked files per execution,
and the software may remind you from time to time that you should
purchase the software after your testing is finished.

Q: I just purchased your product. How do I activate my trial version?
A: You have to download the full version of the software from our customer

area. The login data can be found in the email or in the printed license which
you have received after the purchase. If you do not have your login data any
more, you can request them to be sent to the email address that you have
used for purchasing the software.

Q:Why don't you use activation codes that turn the trial version into a
full version?

49

51

53
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https://www.jam-software.com/treesize/changes.shtml
https://customers.jam-software.de/prices.php?language=EN#101
https://knowledgebase.jam-software.com/customers/
https://customers.jam-software.de/prices.php?language=EN&startLicenseDialog=1
https://www.jam-software.com/company/license_agreement.shtml
https://www.jam-software.com/treesize/comparison.shtml
https://customers.jam-software.de/?language=EN
https://customers.jam-software.de/?language=EN
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A: We do not work with activation codes because you can find them very easily
on the internet. Typically software manufacturers protect against this
problem using online activation, but this would make customer dependent
on the availability of our activation servers and an internet connection.
We are working with separate trial and full versions instead, where the full
version is not freely available for download and must be installed over the
trial version. After purchasing our software, customers get an account for
our customer area where they can download the full version for at least 12
months. We will also send a CD at additional cost (can be ordered
separately). Our customers will also receive a personalized installation key,
with which they can install the full version. Login data and key should be
stored in a safe place. Installing the full version over the trial version will
preserve your existing data and settings.

Q:Although I have purchased the full version of your software product,
it still shows "UNREGISTERED" in the window title. Why?

A: There are 3 possible reasons why "UNREGISTERED" still shows up:
1. You did not download and install the full version from our customer area
2. You have accidentally installed the trial version again. (Have you been
asked for an installation key during installation?)
3. You have installed the full version to a different folder than the trial version
which is now still on your disk.

Q:How do I upgrade to the latest version?
A: On the "Help" ribbon bar you can use "Check for update" to check online

whether there are updates available. Within your maintenance period you
can download the latest version of TreeSize from our customer area. The
login details for our customer area have been emailed to you after the
purchase and are printed on the license document. To upgrade older
versions, simply run the installation file. Your user settings will still be
preserved during the upgrade.

Q: Is one user license sufficient if the software is installed on one
computer but two or three users may access the software?

A: Basically you need as many licenses as you have PCs, server or clients on
which our software is available for execution. If these three users work on
the same PC at different times, then one license is sufficient. If they work on
three different PCs and start the software there, then you will need three
licenses. You can find the full license information on our website.

Q:Can I scan my Linux/Unix servers or my Linux based NAS with
TreeSize?

A: TreeSize can scan Linux / UNIX servers using the SSH protocol (see "Scan
Targets "). Alternatively, If Samba is installed and running on the Linux /
UNIX system, then our tools can access a share on this system using its
UNC name, e.g. \\ComputerName\ShareName. If the file system on the
Linux / UNIX system is accessible through NFS, then it can be accessed if
the NFS support for Windows is installed. For Windows 7 higher
(Professional / Enterprise Edition) please go to the Control Panel and
activate the "Services for NFS" under "Programs and Features > Turn
Windows Features on or off". Then you can mount an NFS share to a drive
letter using this command:
mount \\ComputerName\ShareName N:

It might be necessary to create the following registry values if you have
trouble connecting the NFS drive:

31

https://customers.jam-software.de/?language=EN
https://customers.jam-software.de/?language=EN
https://customers.jam-software.de/?language=EN
https://www.jam-software.com/company/license_agreement.shtml
https://www.samba.org/
https://en.wikipedia.org/wiki/Network_File_System_%28protocol%29
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HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\ClientForNFS\CurrentVersion\Defa

ult\AnonymousUid as DWORD with the decimal value 10011.
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\ClientForNFS\CurrentVersion\Defa

ult\AnonymousGid as DWORD with the decimal value 10012.

Q: Is it possible to monitor specific folders and get notified if their
permissions change?

A: With our monitoring tool Server Sentinel, this is possible. It is designed to
monitor local resources, as well as server and network services
automatically. For more information about this, and other available features,
please visit our website.

Q: Is TreeSize able to delete readonly files?
A: If you start TreeSize with administrative privileges, it will try to delete write-

protected files when you are removing them from disk. In case this is not
possible, e.g. because the file is locked by another application, the file will be
marked for deletion. This means that Windows will try to delete the file on
the next system restart. Please note that there is a difference between
moving files to the recycle bin (shortcut "Del") and removing files from disk
(shortcut "Shift" +"Del").

5.2 Main Program

Q:Why is the allocated space that Windows shows in the properties
dialog of the drive different to the allocated space reported by
TreeSize?

A: Please see our knowledge base entry for this problem.

Q:Are there any limitations on the amount of data that TreeSize can
query at one time?

A: There are no explicit limitations in what TreeSize is able to scan. The more
folders the file system tree has that you want to scan, the more free
memory will be necessary to store the queried data. You can reduce the
memory consumption by turning off the user statistics , the file extensions
statistics  and/or the file age statistics  in the Options  dialog. For
large server our product SpaceObServer may be suitable as well, which
stores the collected data in a database on file level.

Q: If the NTFS deduplication (available since Windows Server 2012) is
enabled, TreeSize displays some strange values for the size of files
and folders. A lot of files have a size of "0 Byte" while a folder called
"System Volume Information" requires a huge amount of disk space.
What is the reason for this?

A: This is a result of the Automatic Data Deduplication .

Q:Why can I not see any network drives within TreeSize?
A: Since Windows Vista and later, Microsoft enforces more strict security rules

on the operating system. One side effect of this is that you may not see your
mapped network drives anymore (Windows 8 and later), or they appear
disconnected (typically in Windows Vista and 7) in applications which run
with administrator privileges. This is because Windows uses different user

47

45 49 62

175

https://jam-software.com/serversentinel/
https://www.jam-software.com/serversentinel/file-system-sensor.shtml
https://jam-software.com/serversentinel/features.shtml
https://knowledgebase.jam-software.com/7164
https://www.jam-software.com/spaceobserver/
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environments for non-elevated and elevated processes. There are some
workarounds to gain access to those network drives anyway: 
- Do not run TreeSize as administrator unless it is truly needed.
- Manually enter the UNC path (e.g. "\\server\share") for the network drive
into the path drop-down list and press enter.
- Use the "Map network drive" or "Add drive or UNC path" dialog from the
Drive List  menu bar.

Q:Why do all files on my disk have the same last access date which is
not far in the past?

A: The date values in the file system are maintained by Windows. Windows
updates the last access date of a file each time when an application
accesses or reads a file. Many backup and anti-virus tools access every file
on your hard disk regularly without restoring the prior last access date.

Q:Why doesn't TreeSize include my disk into its calculation, which is
mapped to a directory using the Disk Manager of Windows?

A: By changing the option "Follow mount points and symbolic links" in the
Options  of TreeSize, you can control if mount points and symbolic links
should be followed or if they should be excluded from the calculations.

Q:What is the easiest way to scan all drives of a remote server?
A: TreeSize accepts wildcards in paths, simply tell TreeSize to scan \

\Server\?$ in the folder combo on the top left or at the command line.

Q:Scanning a server disk via network is very slow. Is it possible to
speed up this process?

A: Scanning a drive via network is normally much slower than scanning a local
disk because speed of the network is much lower, latency and overhead are
higher compared to a local hard disk. Additionally, server drives are usually
much bigger and contain more files than local hard disks. But you can use
scheduled Scans  to perform your scans overnight. Network drives and
command line options are supported by the Professional Edition only. 
For continuous analyzing of disk usage on large servers we recommend our
product SpaceObServer. It collects the data using a background agent and
stores it in a SQL database. It uses less RAM than TreeSize, and it offers
more flexible reporting capabilities like historical development because it is
built on a database. More information is available at: https://www.jam-
software.com/spaceobserver/

Q: Is it possible to have the program ignore folders that are less than a
certain size when displaying them in the tree?

A: In the context menu of the topmost folder you may choose to hide folders
below a certain size. To achieve this, right-click on the topmost icon (or use
the "Expand" button on the ribbon bar), select "Expand > Hide Folders
smaller than: XX MB".

Q: Is it possible to add the free space to the bar chart?
A: The free space is added to the pie chart if the root of the scanned drive is

selected and the according option is activated in the context menu of the pie
chart. In other situations (e.g. if a sub-folder is selected or the "Number of
files" mode is active), it doesn't make sense to add the free space because
the relationship between the free space and the other values displayed is
wrong.

56

62

144

https://www.jam-software.com/spaceobserver/
https://www.jam-software.com/spaceobserver/
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Q:Can I scan network drives and hidden shares like" \\Server\C$"
without connecting them to a drive letter?

A: Yes, in the Professional Edition you can use UNC names like "\
\SERVERNAME\Share" to access a network drive by entering them in the
drive combo box on the top of the main window. You can also use UNC
names on the command line .

Q: I would like to save a set of drives and folders that are scanned each
time I start TreeSize. How can I do that?

A: You can specify the startup behaviour of TreeSize in the Options  dialog.
Or you can simply create a shortcut to treesize.exe on your desktop or the
Start menu and add those drives and folders to the command line,
separated with a space character.

Q:How can I limit a scan to just one user's files?
A: Please make sure that the option "Create Statistics on File Owners" is

activated in the Options  of TreeSize. After the scan is finished please
right-click on this user on the "Users" tab and choose "Limit to this user"
from the context menu. You may also use the Custom File Search  to
search files of certain users.

Q: Is it possible to perform a silent installation of this software?
A: Yes, please see chapter "Installation ".

Q: Is it possible to search for file extensions of file types with TreeSize?
A: You can for example apply a filter  for a scan in the Options  by adding

patterns like *.bmp as include filter. A second possibility is to enable the
"Create Statistics on File Extensions" feature in the Options . This will
provide a detailed statistics for the file types in each sub-tree on the
"Extensions " tab and you will be able to limit the values in the directory
tree to one file type. A third possibility is to use the Custom File Search  of
the File Search Module of TreeSize. Our product SpaceObServer has
extended and more flexible reporting features if needed.

Q:The folder "System Volume Information" in the root of my drive uses a
lot of disk space. What is the purpose of this folder? 

A: This folder is part of the Windows System Restore. You shouldn't delete any
files in this folder manually. Its size can be reduced by changing the
appropriate setting in the "System" applet of the Windows Control Panel.
Windows Vista only allows to turn off the System Restore here. The space
used by this service can only be reduced using the Windows command line
utility vssadmin.

Q:Can TreeSize be installed on a cluster?
A: Yes, TreeSize can be installed on a cluster. It is not cluster aware, but does

not need to be. If you obtain a license for each server and install TreeSize
on all machines of the cluster, then you will have TreeSize available at any
time on any server of the cluster.Our product SpaceObServer has more
advanced cluster support.

Q:Are there any known problems when using TreeSize on a Citrix
server?

156
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A: TreeSize runs in a Citrix environment, there are currently no known
problems. Please note that you need one license for each Citrix client in
which TreeSize can be started.

Q:Where does TreeSize store the data shown on the "History" tab?
A: The history data can exported or imported on the "History" ribbon. This data

is stored in the file named ScanHistory.xml which is stored in you user
profile directory under %AppData%\JAM Software\TreeSize. 

5.3 Printing / Export

Q:How can I specify the columns that should be included in the printed
report / exported Excel file?

A: Under "Tools > Options > Export > Printer" you may choose the columns
included in a printed report. They will also be used for scheduled scans
as long as they are started under the same user account..

Q:How can I generate a list of files that belong to a certain user?
A: Please make sure that the option "Tools > Options  > Scan > General >

Create statistics for file owner" is activated. Scan the folder in question. Go
to the "Users" tab in the right pane, right-click on a user and select "Show
files of this user". The list will be compiled and can be exported in various
formats.

Q:How can I export also the the file names to my Excel / HTML / text
file?

A: Please go to "Tools > Options > Export", select your export type and
activate the options "Include single files in export" and "Export the full
directory branch" are activated. You may also consider using the custom
search type of the TreeSize File Search  to list all or some files of a
directory branch. These lists can be exported as well, e.g. to Excel files.

Q:When I double click on a CSV file they open in MS Excel but the data
is not divided into columns. Can this be changed?

A: In the Windows Control Panel, please set the list separator under "Control
Panel > Regional Options > Customize" to semicolon.

5.4 File Search

Q:How can I search for files of the type XYZ?
A: Please open the TreeSize File Search via the Windows "Start" menu or the

TreeSize "File Search" menu, check the drives that should be searched,
activate only the custom search  type and there add "*.XYZ" to the "Filter
Patterns" that should be matched, then press the "Start" button. Another
possibility: Set a filter  in the Options dialog of the main application. Then
TreeSize will only include matching files when calculating the folder sizes.
The results will provide a good overview of the distribution of these file
type(s) and can be exported to a text file using the context menu. Our
product SpaceObServer, which keeps the data of watched file system trees
in an SQL database, has faster and more flexible search and report
features.
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Q: Is it possible for TreeSize to move files to a specified location based
on last change date and retain directory structure?

A: Yes. Please open the TreeSize File Search via the Windows "Start" menu
or the TreeSize "File Search" menu, check the drives that should be
searched, activate only the custom search  type and there adjust the date
or days value. You may also use the Custom file search if you need more
flexible filter options. Then hit the "Start" button. All listed files that are
checked can then be moved using the "Move items". If you choose another
file system folder as destination, the directory structure will be preserved
when moving the files.

Q:How can I search my entire network for AVI files?
A: Please open the TreeSize File Search via the Windows "Start" menu or the

TreeSize "File Search" menu, hit "Browse and add path", choose "Network".
Make sure that only the Custom Search type is activated and there add the
pattern *.avi and hit "Start".

Q: Is it possible to check several or all results in the File Search window
at one time instead of checking them individually?

A: To check all results, click on "Check All". To check some results based on
their name, use the "Check if" button. You may select multiple files using a
left mouse click while holding the <Shift>- or <Ctrl>-key down. Using
"Check" from the context menu checks all currently selected files. Some
successive files can also be easily checked by pressing the space bar
several times. The space bar checks the currently focused file and
advances to the next file in the list.

Q:Which files can I safely delete?
A: Unfortunately there is no short and easy answer to this question because

usually one cannot know where a file came from and what it is used for.
Generally temporary files and cache files of the internet browsers can nearly
always be deleted safely. Besides deleting files, the TreeSize File Search
offers you to move files to a different drive or to a compressed ZIP file
(preserving the file system hierarchy) which can then be archived. That way
files that are still needed can be easily restored, either manually or by using
the restore script that TreeSize is able to generate optionally.

Q:Does TreeSize have the capability to delete files in specified
directories over a certain age and if so, can this be scheduled? 

A: The TreeSize File Search can search, report and delete or move files over a
certain age in using the "Oldest Files " search type or the custom
search  type. Check the files you want to delete (use "Check All" to
check-mark all files) and use the "Move" button to move them to the Recycle
Bin or to another folder. 
Any saved search options can be used to automatize such tasks by
creating a scheduled TreeSize task , which allows you to create a
scheduled task or to compile and copy the full command line with all
necessary command line options .

Q:How can I change XY for each file in the search results in a scheduled
File Search?

A: Please start the TreeSize File Search and configure the custom file search
appropriately, turn off all other search types and save your search options to
an XML config file using the "File" menu. As an example we will describe
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how to apply NTFS compression to all files in the search results. This is not
built into TreeSize, but TreeSize can pass each search result to an
executable or script, which is a very powerful and flexible feature. Please
create a small Batch file NTFSCompress.bat containing:
  COMPACT /C %1

To NTFS compress the search results, you can use a command line like
this:
  TreeSize.exe /SEARCH /MOVETO NTFSCompress.bat MySearchOptions.xml

This solution applies to the Professional Edition only.

Q: Is it possible to scan all our 200 workstations with TreeSize for
finding e.g. who stores PST files locally on his workstation?

A: What you can do is using the Custom Search  type of the TreeSize File
Search. It allows to search the entire network or IPv4 address ranges for
certain files, like *.pst. Simply specify  \\*  or \\192.168.123.* as path to
search. TreeSize will then enumerate all available PCs in e network or that
IPv4 network segment and search their drives (or more exactly: their public
and hidden shares) for the files matching the search criteria.

Q:Does TreeSize support paths with more than 255 characters when
searching files?

A: Yes. And Long path can be explicitly searched for using the Custom
Search . Simply activate the search option "Full Path longer than X
characters" with a value of 255.

Q:How do you search for files over a certain number GB and older than
a certain date?  I'm trying to find data to archive on my file server

A: Please open the TreeSize File Search via the Windows "Start" menu or the
TreeSize "File Search" menu, check the drives that should be searched,
activate the "Custom Search" type only and there adjust the search
parameters on the "Date" ans "Size/Attributes" tab accordingly. 

Q:Does TreeSize change any of the modified / accessed / changed date
& time information on files or folders when scanning?

A: No, TreeSize does not change file dates when scanning a file system
branch. 

Q:How do I perform a duplicate file search on multiple network drives?
A: Open the TreeSize File search using the Windows Start menu or the

TreeSize Tools menu, add the network paths to the list of "Drives and Paths
to Search", activate the Duplicate Search only and start the search. You
may change the way TreeSize compares the files on the "Duplicate Files"
tab.

Q:After deduplicating files, the Windows "Properties" dialog still shows
the same size for the containing folder. Why is this?

A: When deduplicating files , TreeSize replaces duplicate files by hard
links , after which the physical data exists only once on the hard disk.
There are however X links to this data. Each of these links is shown with the
size of the physical data, this is why the Windows Explorer and by default
also TreeSize shows the same size for these files and the folders they are
included in. If you take a look at the allocated space of the physical drive
(e.g. in the "Drive List " in TreeSize or in the "Properties" of the drive in the
Windows Explorer) you will notice the difference. To get the correct
physically allocated size of a folder, you need to look at the column
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"Allocated Space". In the TreeSize main application  make sure that the
option "Track NTFS alternate data streams and NTFS hardlinks " is
turned on in the Options dialog .

Q:Does TreeSize allow to search for directories?
A: Yes. You can use the Custom Search  type of the TreeSize File Search

to do that. Please open the TreeSize File Search via the Windows "Start"
menu or the TreeSize "File Search" menu, check the drives that should be
searched, activate only the custom search  type and there check-mark
"Include Folders" but not "Include Files" on the tab "Size/Attributes". Press
"Start", TreeSize will now search for directories only, for which you can
define name patterns on the tab "Filter Patterns".

6 Using TreeSize

After the installation, TreeSize can be started using the Windows Start
menu/screen or the context menu of a folder or drive. These are the important
elements of the TreeSize main window:

1
.

The Ribbon Bar provides access to all commands of TreeSize. It is divided
into logical sections such as the "Home " tab containing commonly used
functions and elements, or the "View " tab enabling you to customize the
appearance of TreeSize. The colored tab to the right is a context-sensitive
depending on the currently active view. Use the "Select directory for
scan" to start the scanning process for a drive or folder.

2
.

This section contains a drop-down list enabling you to select a drive or
folder to be scanned. You can enter paths directly in the control field.
Press enter or click the scan button on the right to start a scan for the
entered path. TreeSize will remember recently used paths and add them
to the list.

3
.

The Directory Tree  of the scanned folder or drive provides an
immediate overview of the size of each folder.

4
.

The Drive List  provides an overview of all local and mapped network
drives. Additional network drives can be added using the context menu.
Double-click on a drive to start a scan in TreeSize.

6

62

62

119

119

22

27

31

56



17

TreeSize 
 
                                                                                                                                                                                                                                             ©1995-2020 by Joachim Marder e.K.

Using TreeSize

5
.

This section will provide additional information regarding the scanned path
(e.g. its total size and the number of folders contained).

6
.

The view section contains several different tabs, each of them providing a
highly specialized data view of the currently selected drive or folder. As
soon as a view is activated, the corresponding context tab will become
active on which you will find useful commands for this view. These are the
available views of TreeSize:
· The "Chart " view visualizes folder information either as a "Pie

Chart , "Bar Chart " or as a "Tree Map ". 
· The "Details " view will provide you detailed information on all files

and folders contained in the current selected item in the Directory
Tree

· The "Extensions " view presents information on size grouped by file
types. Thus, you'll gain an overview of the types of files that use up
most of the disk space. 

· The "Users " view shows information on size grouped by users. You
will see at a glance which user uses how much space in which folder. 

· The "Age of Files " view shows the distribution of the age of scanned
files, based on a certain date attribute.

· The "Top 100 Files " view lists the 100 largest files in the scanned
path along with several other details.

· The "History " view shows changes in for the scanned path in a line
chart.

7
.

The Quick Access Toolbar  is a customizable shortcut to many useful
functions of TreeSize.

6.1 The Ribbon Bar

The Ribbon Bar provides access to all commands of TreeSize. It is divided into
the following logical sections, called "Tabs":

· File Allows you to select folders for scanning, to load, save, compare,
export, and print collected data.

· Home Contains the most commonly used actions and elements of
TreeSize.

· Scan Contains all actions and elements related to the current scan.

· Tools Contains useful TreeSize and Windows-specific functions.

· View Contains all actions and elements influencing the general
appearance of the application.

· Help Provides common help features, version information, and
management functions for your product license.

In addition to these permanent tabs there are several so-called "context tabs"

which depend on the currently active view  of TreeSize. They are highlighted

in different colors.
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6.1.1 Application Menu

The Application Menu (or "File" menu) allows you to select folders for scanning,
loading, saving, exporting, or comparing collected data. It also provides access
to the application settings and allows you to exit TreeSize.

Recently
Scanned

List of recently scanned paths and drives. Clicking a path will start
a scan of this path.

Select
directory
for scan

Shows a dialog which lets you choose a folder for scanning. When
the selection has been confirmed, TreeSize starts scanning the
selected path. You can also enter a path directly into the drive
combo box in the toolbar.

Load scan
from XML

Load a saved TreeSize scan from an XML file. That way you can
view earlier results without performing a whole scan again.

Save scan
to XML

Save the current scan to an XML file. This file can be loaded in
TreeSize again or can be used to perform a comparison at a later
time. Please note that the information about single files is not
saved to the XML since this would increase the size of the XML
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files too much. Only the information about folders is included in the
file. If you need reporting on file level, our software SpaceObServer
may be useful for you.

Compare
current
scan

Compare the current scan against a previously saved scan (XML
file) or a Snapshot  (only supported for local NTFS drives). After
comparison, folders unchanged in size will show up with a size of
0 while folders that have grown will have values greater than 0 and
will be displayed in red color. Folders that became smaller
compared to the loaded report will have negative values and will be
displayed in green color.

Send by
Email

Send the Directory Tree  (left pane) via email.

Export
Export the Directory Tree, chart or list content to a file. See chapter
Export submenu .

Print
report

Print the Directory Tree, chart or list content. See chapter Print
submenu .

Options
Open the options dialog of TreeSize. The submenu also contains
commands that allow you to import/export and reset the current
options. 

About
Show version number and contact information.

Exit
Closes TreeSize.

6.1.1.1 Export Submenu

The menu items in the export submenu allow you to export the collected scan
data in several different ways. You can customize the kind of data (columns)
that will be exported as well as other export options using the options dialog
of TreeSize. You can also choose whether only those folders currently visible
(expanded) in the Directory Tree  or all folders will be exported. Please use
the Expand  button on the Home  or Scan  tab (or in the context menu
of the Directory Tree) to expand and collapse or expand folders to a certain
level.

Plain text
Export the Directory Tree to a tab-separated text file.
To configure the behavior for text exports, go to
Options -> Text .

CSV file
Export the Directory Tree to a CSV file (comma
separated values). To configure the behavior for CSV
exports, go to Options -> CSV .

Excel file
Export the Directory Tree to a Microsoft Excel file.
Supported formats are the conventional .XLSX file
format (introduced with Excel 2007) as well as the
former used .XLS  (Excel 97-2003). Paths are
exported as clickable hyperlinks. This allows you to
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quickly jump to the appropriate path in the Windows
Explorer. To configure the behavior for Excel exports
and the charts  that should be included, go to
Options -> Excel .

HTML file
Enables you to save a report as an HTML file which
can be viewed with any HTML browser later. HTML
files are easier to read than text files and don't require
a special application like MS Excel. The HTML file will
be UTF8-encoded and thus includes Unicode
characters. To configure the behavior for HTML
exports and the charts  that should be included, go
to Options -> HTML . There you can also define a
custom CSS stylesheet that will be used for the
HTML export.

PDF file
Enables you to save a report as an PDF file which can
be viewed with any PDF Viewer later. PDF files are
easier to read than text files and only require a free
PDF viewer, which is included in Windows 8 and later.
To configure the behavior for PDF exports and the
charts  that should be included, go to Options ->
PDF .

Copy to clipboard
Copy the Directory Tree to clipboard in text format.

Copy list of files
Copy a list of all files in the current folder (and its sub-
folders) to the clipboard. You can paste this list to your
favorite spreadsheet or word processor. The settings
for the text export  in the options dialog determine
which columns will be included in the list.

Customize
Opens the options dialog enabling you to customize
the output columns for the different export formats.

Set title
Allows you to set a title for the currently selected scan
which will be used when the folder data is printed or
exported. The default title includes the path of the
scanned folder and the volume name of the drive the
folder resides in. The use of environment variables is
allowed.

6.1.1.2 Print Submenu

TreeSize offers a wide variety of flexible printing functions. You may, for
example, print the content of the Directory Tree, the contents of a selected
folder or any available chart (Charts  view, History  view, etc.).

The following commands are available in the "Printer" submenu:

Quick print
Print a report for the current scan on the default printer
without print dialog or preview.

Quick print right pane
Print the chart  or list shown the right pane of the
window on the default printer without preview.
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Print report 
Print report for the currently selected scan without
preview.

Print right pane
Print the chart  or list currently shown the right pane
of the window.

Print with preview
Shows a print preview for the report of the currently
selected scan.

Print report for all
Print a report for all scans currently listed in the
Directory Tree (left pane).

Set title
Allows you to set a title for the currently selected scan
which will be used when the folder data is printed or
exported. The default title includes the path of the
scanned folder and the volume name of the drive
where the folder resides in. The use of environment
variables is allowed.

Page setup
Change page layout settings.

Print setup
Change printer settings.

Customize report
Customize exported columns, included charts , etc.

6.1.2 Quick Access Toolbar

The Quick Access Toolbar is a customizable toolbar containing a set of
commands that are independent of the currently displayed tab. You can move
the Quick Access Toolbar to one of the two possible locations, and you can
add buttons representing commands to the Quick Access Toolbar.

Move the Quick Access Toolbar

The Quick Access Toolbar can be located in one of two places:

· Upper-left corner, next to the TreeSize icon.

· Below the Ribbon bar.

To switch the Quick Access Toolbar between those positions, click the small
drop-down arrow and select "Show below the Ribbon" respectively "Show
above the Ribbon". 

34
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Add a command to the Quick Access Toolbar

You can add any command displayed in TreeSize to the Quick Access
Toolbar.

1. On the Ribbon, click on the appropriate tab or group to display the
command that you want to add to the Quick Access Toolbar.

2. Right-click the command, and then click "Add to Quick Access Toolbar" on
the shortcut menu.

 

Note

· You cannot split the Quick Access Toolbar to multiple lines.

6.1.3 Home Tab

The ribbon tab Home contains the most commonly used actions and elements
of TreeSize.
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Select
directory
for scan

Opens a dialog enabling you to select a folder for scanning.
TreeSize will start scanning the selected path once the selection
has been confirmed. You can also enter a path directly into the drive
combo box in the toolbar.

Stop
Stops the currently selected scan. This will abort the current scan
process but not remove it from the Directory Tree .

Refresh
Refreshes the currently selected scan. The Refresh button also
offers a drop-down menu providing access to the "Refresh all" and
the "Automatic updates" buttons. Refresh all will trigger a full
refresh for all scans of TreeSize. With Automatic updates enabled,
TreeSize keeps track of the Windows change notifications and
updates the size information as well as several other information
automatically. It will also update the size of a folder if it gets listed on
the details sheet. If you don't want the size information to change
after the scan has finished, you should turn off "Automatic Updates".
This option can be enabled or disabled for individual scans.

Remove
scan

Removes the currently selected scan from the TreeSize window.

Size
Shows the size of files and folders.

Allocated
space

Shows occupied disk space on the hard disk.

Number
of files

Shows the number of files in the selected folders.

Percent
Shows how much percent of the parent folder each folder occupies.

Optical
media

Shows how much storage space the files and folders would occupy
on an optical medium like a CD or DVD.

Auto
If this option is activated, TreeSize will automatically select the most
appropriate size unit. Other units are available via the drop-down
element (small arrow).

GB
Show size values in gigabyte (GB).

MB
Show size values in megabyte (MB).

31
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KB
Show size values in kilobyte (KB).

Expand
Using the "Expand" button, you can expand or collapse the
Directory Tree  to a certain directory level. You can also use this
menu to trigger a "Full expand" so that you will see any folder that is
available in the current scan. More information on the "Expand"
button can be found here .

Send by
email

Sends the Directory Tree  via email. This will create an email
containing the contents of the directory tree using the current email
settings. Emails can either be send using a MAPI client like
Microsoft Outlook or via SMTP (recommended). Email settings
can be configured in the options dialog of TreeSize.

Export
This button provides several different export options such as
"Excel", "Plain text", or "HTML file". You can also copy the
directory tree or the contents of the "Details" view to the clipboard.
The drop-down menu enables you to customize any export type.

Open
TreeSize
File
Search

Start the TreeSize File Search with all available types of file
search (largest files, oldest files, etc.) for the currently selected
branch. For more information on the TreeSize File Search, see
chapter Using TreeSize File Search .

Start as
administr
ator

Restart TreeSize with administrator privileges. 

Please note: This button is available only if TreeSize was not
started with administrator privileges.

Options
Opens the options dialog for TreeSize. The drop-down button also
provides access to the menu allowing export/import and reset of
the application settings.

6.1.4 Scan Tab

The ribbon tab Scan contains all actions and elements related to the current
scan.

Refresh
Refreshes the currently selected scan. The Refresh
button also offers a drop-down menu providing access
to the "Refresh all" and the "Automatic updates"
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buttons. Refresh all will trigger a full refresh for all
scans of TreeSize. With Automatic updates enabled,
TreeSize keeps track of the Windows change
notifications and updates the size information as well as
several other information automatically. It will also
update the size of a folder if it gets listed on the details
sheet. If you don't want the size information to change
after the scan has finished, you should turn off
"Automatic Updates". This option can be enabled or
disabled for individual scans.

Stop
Stops the currently selected scan. When a scan is
stopped, TreeSize will abort the current scan process
but not remove it from the Directory Tree .

Remove scan
Removes the currently selected scan from the
TreeSize window.

Expand
Using the "Expand" button, you can expand or collapse
the Directory Tree  to a certain directory level. You
can also use this menu to trigger a "Full expand" so that
you will see any folder that is available in the current
scan. You can also use this menu to show only folders
exceeding a certain size value.

Find
Searches for a certain folder in the Directory Tree .

Compare with saved
scan

Loads a saved scan from an XML file and compares it
with the current scan. The differences in size will be
displayed as positive and negative values in the user
interface.

Compare with
snapshot

Selects a Snapshot  of a scanned drive to compare it
with the current data. The differences in size will be
displayed as positive and negative values in the user
interface.

Compare with path
In rare cases it can be useful to compare the current
scan with another path, e.g. in case that the other path
is a copy or a backup of the currently displayed path.
After choosing the other path using a directory picker
dialog, the differences in size will be displayed as
positive and negative values in the user interface.

Show size changes
Show size changes instead of current values in the
Directory Tree. This view option can be toggled if the
current scan was compared with an XML report or
snapshot.
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Schedule this scan
Creates a scheduled Windows task  for the currently
active scan.
This is supported in the Professional edition only.

Compress item
Compresses this file or folder using NTFS
compression.

Decompress item
Turns off NTFS compression for this file or folder.

6.1.5 Tools Tab

On the Tools tab, you will find several useful TreeSize- and Windows-specific
functions.

Options
Opens the options dialog for TreeSize. The drop-down button also
provides access to the menu items facilitating the export/import
and reset of the application settings.

Open
TreeSize
File Search

Starts the TreeSize File Search with all available types of file
search (largest files, oldest files, etc.) for the currently selected
branch. For more information about the TreeSize File Search,
please refer to chapter Using TreeSize File Search .

Manage
scheduled
scans

Shows all scheduled tasks of TreeSize. Tasks can be
customized here.

Create
snapshot

Creates a new Snapshot  for this system. Snapshots can be
used at a later time to analyze size development by comparing
the data of the snapshot with that of a recent scan.

Create
portable
installation

Creates an installation of the Professional edition as a portable
version, e.g. on a USB Stick. All of the settings will be saved to the
specified installation directory.

Empty
recycle bin

Deletes all items in the recycle bin to free up disk space.

Remove
obsolete
software

Opens the Windows Control Panel applet to uninstall software.

Configure
Windows

Define how much space the Windows System Restore feature
can use on your local hard drive.
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System
Restore

Defragment
disks

Open the Windows Disk Defragmenter.

Map
network
drive

Opens the Windows "Map Network Drive" dialog.

6.1.6 View Tab

The ribbon tab View contains all actions and elements influencing the general
appearance of the application.

Select
active
View

Selects the view that is shown in the right panel of the application

Size
Shows the size of files and folders.

Allocated
space

Shows occupied disk space on the hard disk, aka "size on disk ".

Number
of files

Show the number of files in folders.

Percent
Show how much percent of the parent folder each folder occupies.

Optical
Media

Show how much storage space the files and folders would occupy
on an optical medium like a CD or DVD.

Auto
If this option is activated, TreeSize will automatically select the most
appropriate size unit. 

TB
Show size values in terabyte (TB).

GB
Show size values in gigabyte (GB).

MB
Show size values in megabyte (MB).
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KB
Show size values in kilobyte (KB).

B
Show size values in byte (B).

Decimals
Sets the number of decimals shown in displayed values.

Sort by
size

Sort items by size (descending order).

Sort by
name

Sort items in alphabetical order.

No sorting
Do not sort items. This can be useful when scanning large folders
drives because folders don't permanently change their position.

Group
scans

Groups all scans in the Directory Tree  to receive the total results
for all scans. See also "Group scans in the Directory Tree ".

Show
size
changes

Shows size changes instead of current values in the Directory
Tree . This view option can only be toggled if the current scan
was compared with an XML report or snapshot. See also "Size
comparison ".

Drive list
Show or hide Drive List .

Scan
overview

Show or hide scan overview toolbar (provides information such as
total size and number of files and folders for the currently selected
scan). Right clicking on the overview allows you to define whether it
should wrap around or truncate the shown information in case it
does not fit.

Status
bar

Show or hide status bar (provides information on active scan filters
and or errors that occurred during scan process).

Hide
empty
folders

If activated, all folders with zero files will be hidden. This is
particularly useful if there a lot of such folders because a filter is
applied.

Hide
elements
smaller
than

If activated elements smaller than the specified size will be hidden.

6.1.7 Help Tab

The ribbon tab Help provides common help features, version information, and
management functions for your product license.
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Show help
Open the product manual of TreeSize.

Show PDF
manual

Open the product manual as PDF (optimized for printing).

Frequently
Asked
Questions

Shows the Frequently Asked Questions (FAQ).

About
Shows version number and contact information.

Check for
update

Checks if a newer version of this software is available.

What is
new?

Shows recent changes.

Change
installation
key

Changes the installation key of the software.

Extend
maintenanc
e

Extends the maintenance period. Updates and support are free
within the selected maintenance period.

Please note: For the trial version of TreeSize, the Ribbon group "License"
contains different controls:

Purchase
full version

Navigates to the JAM Software website and shows a list of all
available license models.

Change to
full
version...

Helps you switch to the full version after purchasing the software.
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6.2 Scan Targets

Originally TreeSize was designed to analyze file system paths. The current
version enables users to scan targets not accessible via a file system path.
Among them is every folder that appears in the left pane of the Windows
Explorer. In this chapter we will describe all targets that can be scanned using
TreeSize:

Local File System Paths

To scan a file system path, enter the path into the drive drop-down box on top
of the directory tree  or use the button "Select directory for scan" on the
ribbon tab "Home ".You can also double-click on the drive in the TreeSize
drive list  on the bottom left corner of the window to start a scan.

Remote File System Paths
If a remote path is mapped to a drive letter, scan it just like a local drive (as
described above). Additionally TreeSize supports UNC paths like "\
\severname\share", which can be entered in the drop-down box on top of the
directory tree . You can also select the remote path using the button "Select
directory for scan" on the ribbon tab "Home " and browse to the path in the
"Network" folder. To search your entire network, choose the "Network" folder
here or use the path \\*. 
UNC paths can also be added to the drive list  using the right-click menu.
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Mobile Devices and Smartphones

Mobile devices and smartphones can be scanned with TreeSize if they support
the MTP protocol. Those devices are typically listed under "This PC" in the
Windows Explorer and in the dialog which appears when using the button
"Select directory for scan" on the ribbon "Home ". TreeSize also support
entering paths to mobile devices like this: "This PC\Galaxy Tab A" in the drop-
down box on top of the directory tree .

FTP Server

If the FTP server is listed under "This PC" in the Windows Explorer, you can
use the button "Select directory for scan" on the ribbon tab "Home " to select
this FTP server for scanning. You may also enter the FTP server address into
the drop-down box on top of the directory tree using this syntax:
"ftp://username@servername.com/path/".

WebDAV and SharePoint Server

If the WebDAV or SharePoint server is listed under "This PC" in the Windows
Explorer, you can use the button "Select directory for scan" on the ribbon
"Home " to select this server for scanning. You can also enter the  HTTP(S)
server address into the dropdown box on top of the directory tree using this
syntax: "https://servername.com/path/".

Linux/Unix Server

With TreeSize you can scan Linux or Unix server, even though they are not
integrated into your Windows storage environment, using the SSH network
protocol. You can enter address of server shares to scan via SSH into the
dropdown box on top of the directory tree using this syntax:
"ssh://servername/share".

Please note: TreeSize will request login information (user name and password)
for the SSH connection. Alternatively, you can obtain these directly in the
address: "ssh://user:password@servername/share"

Amazon S3 Cloud Storage

You can scan Amazon S3 cloud storage with TreeSize. To scan your entire S3
storage, simply type s3:// in the dropdown box on the top left and press enter.
To scan a certain bucket use: s3://Bucketname/

TreeSize will ask for an access token and the corresponding secret access
token with the option to save it for future use. You may also supply this
information as part of the URL: s3://Token:SecretToken@Bucketname/

In the column "Description" the storage class of a file (e.g. reduced redundancy
oder standard) will be shown.

6.3 The Directory Tree

The Directory Tree of TreeSize is a powerful tool for visualizing the size of
files and folders. The gradient bar in the background serves as a size indicator,
providing a quick and intuitive overview: you will see at a glance which
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folders occupy the most space on your disk. The Directory Tree can be
browsed just like a folder tree in the Windows Explorer.

Contents

· Notes

· Expand or collapse the Directory Tree

· Group scans in the Directory Tree

Notes

·  If you place your mouse cursor on a folder, you'll be shown a tool tip with
detailed information if the corresponding option  is active.

· The Directory Tree supports an incremental search. To jump to a certain
folder, simply type the initial characters of its name after clicking anywhere in
the Directory Tree. The Search will then select the first matching folder.

· The Find  dialog (Scan  tab) provides a simple search function enabling
you to search for certain folders in the Directory Tree.

· When you right-click on a folder or file in the tree to the left, TreeSize will
display the Explorer context menu. Additionally, you will find the TreeSize
submenu providing various additional options.

· Very large folders are marked in bold text. The threshold can be configured in
the options dialog (Options > View > General ).

· The color for the gradient bar can be configured in the options dialog
(Options > View > Directory Tree ).
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Expand or collapse the Directory Tree

Using the Expand submenu (accessible via tabs Home  and Scan ) you
can expand/collapse and hide certain folders in the tree, based on a certain
directory level or an user-defined size value. For example, you can hide any file
and folder occupying less than 500 MB (see screenshot below). This way, the
most relevant elements will be shown in the tree while unimportant
information is hidden.  

Group scans in the Directory Tree

With the "Group scans " button (available on the View  tab or via the
context menu), you can merge multiple scans into a single "virtual root". The
virtual root shows a summary of all scans that are part of this group. This way
you will gain total sizes and values for arbitrary scans.

22 62
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6.4 The TreeSize Views

The following viewing options are available in TreeSize:

· Chart Visualizes folder information in several different types of charts.

· Details Provides an Explorer-like list of files and folders contained in
the currently selected item in the Directory Tree .

· Extensions Shows information on size grouped by file types.

· Users Shows information on size grouped by users.

· Age of
Files

Shows the distribution of the age of scanned files, based on a
certain date attribute.

· Top 100
Files

Lists the 100 biggest files in the scanned branch in detailed
view.

· History Visualizes the size development of the selected root folder.

6.4.1 Chart

TreeSize is able to visualize folder information in several different types of
charts. The information is based on the currently active view mode  of
TreeSize. There are three basic types of charts, namely:

· Pie Chart

· Bar Chart

· Tree Map

Context tab: Chart

Please note: a context tab will be activated when the Chart view is selected. It
allows you to manipulate the charts in several ways, for example zooming,
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turning on or off the grid lines, switching between 2D and 3D mode, changing
colors, etc. Using the tab, you can also copy the current chart to the clipboard
or save it as a file.

More options to individualize the Charts are available with the Options
Dialog .

Some elements are available exclusively for certain types of charts (e.g. "Level
of Details" for "Tree Map" chart only).

For all directory charts the following commands are commonly available:

Pie Chart
Switches to pie chart view.

Bar Chart
Switches to bar chart view.

Tree Map
Switches to hierarchical chart view.

Save
Saves the current chart as a graphic file.

Email
Export the current chart and send it via email. You can
configure your email settings in options dialog.

Clipboard
Copies the current chart to the clipboard (can be pasted in
other applications).

Print chart
Prints the current chart.

Color
Use the color picker to choose a color for the chart below:
select a color, then click on the part of the pie the color
should be applied to.

Show chart in 3D
View chart in 3D or 2D.

Zoom in
Zooms in on the chart.

Zoom out
Zooms out of the chart.

Zoom 100%
Resets zoom to 100%.

Dependent on the displayed chart type, there are additional options available:

For pie charts:

75
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Show Free Space
Show the free space of a drive as additional slice.

For bar charts:

Show Grid
Show or hide grid lines for this chart.

For the Tree Map chart:

Level of detail
Change the detail level of the tree map.

Show Free Space
Show the free space of a drive as a separate tile.

Included Elements
The Tree Map allows you to specify which elements should
be included with the chart. The size of each tile represents
the size of the according element (usually the summarized
size of the contained files), just as for folders.

Activating more than one type of elements to be included, a
hierarchical structure will be implied: Each file belongs to
an extension, each extension belongs to a file type group,
and each group belongs to a folder.

The legend of the chart will adapt to the selected elements.

There are several options available:

Show single files
Include a separate tile for each file.

Show extensions
Include a separate tile for each extension contained within
a folder.

Show file type
groups

Include a separate tile for each file type group  contained
within a folder.

Context Menu

Right-clicking on any chart shows a popup menu offering additional features,
such as opening the corresponding item in the Windows Explorer.

Pie Chart

The Pie Chart shows the relative portions of each subfolder of the currently
selected item in the Directory Tree . 

The diagram contains the name of each folder, its size (or allocated space, or
number of files; for more information please see view modes ), and its
percentage value. Small folders may be summarized in a slice named "Other". 

If a root of any drive is displayed in a pie chart and you have switched to the
"Allocated Space" mode, the free space of this drive will also be displayed as
one slice of the pie. This behaviour can be switched on or off in the options
menu. The pie chart shows the free space as one slice among the others and
calculates the percentage appropriately (relatively to the others), so the percent
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value might differ from the "% Free" value of the drive if TreeSize didn't see all
files. An FAQ entry  deals with the possible reasons. 

Hovering over a slice will show detailed information about the corresponding
folder, double clicking will change into the selected folder. 

Double-clicking on a slice will show the pie chart view for the selected folder. In
case the clicked slice represents a file, it would be executed. Right click a slice
in order to perform file operations like delete, copy, paste, properties etc. To
manage several folders at once hold the shift key while selecting the desired
segments in chart.

Please note that the Pie Chart not only visualizes the sizes of each subfolder of
the currently selected item in the Directory Tree, but also the distribution of file
extensions and even the file and directory owners (user statistics). To
change the type of the Pie Chart, please click on the drop-down arrow right
beside the caption of the Ribbon button (see image below).

10
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Bar Chart

The Bar Chart visualizes folder sizes in form of horizontal bars. Grid lines in
the background of the chart allow for easy determination of folder sizes and
comparison of each folder in relation to other folders on the same directory
level. As with the pie chart, hovering over a bar will call up more detailed
information about the corresponding folder. Double-clicking on a bar will show
the bar chart view for the selected folder.
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Tree Map

The Tree Map is a hierarchical chart that is able to visualize the sizes of each
subfolder (not only direct child folders) of a selected directory branch. 

Each folder is shown as a rectangle. The area of the rectangle represents the
size of the corresponding folder. The rectangles of subfolders are located
inside the rectangle of their parent folder. If a folder has no subfolders and the
file extensions  statistics was activated during the scan, the file types are
now shown as subitems.

The color of the rectangle face indicates the directory level. The colors range
from a darker blue (top level directories) to a lighter blue (directories with a
deep file system level). These colors can be adjusted using the color picker
in the context tab. The context menu of the Tree Map also allows you to apply a
predefined color scheme. The shown rectangles must have a minimum size to
be displayed. You can customize this minimum value using the Level of
Detail  track bar in the context tab. If this value is small, the chart might look
very complex and confusing. 

If you place the mouse cursor over the chart, you will see a tooltip containing
information about the directory the cursor hovers over. Double-clicking on one
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of the rectangles will navigate to the corresponding directory in the Directory
Tree . Drag and drop operations are supported in the tree map.

6.4.2 Details

The Details provides an Explorer-like list of files and folders that are contained
in the current selected item in the Directory Tree . 
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More Columns

Detailed information on each file or folder can be shown by selecting the
desired attribute in the column list, available by right-clicking the header of
the list or via the Details page  in the options dialog of  TreeSize. Individual
file types, users or Age of files intervals can be added as columns as well. To
do so, right click on the extensions, user, or interval and select "Add column ...
to Details". These columns will be exported as well, if in the Options  the
checkbox "Use same columns as in Details view" is checked.

Context tab: Details

Like every view in TreeSize, the Details view comes with a Ribbon tab that is
activated when the the list is clicked. The Ribbon tab provides commonly used
list functions such as select operations or export features.

The following commands are available on the "Details" tab:

68
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Delete
Deletes the selected items. Hold the "Shift" key to remove the
item(s) from the disk permanently (Please note: You cannot
recover files that have been removed permanently!).

Properties
Shows the properties for the selected item.

Move selected
items

Opens a dialog for the execution of file operations. The dialog
allows to move the selected items to another location. It also
provides functionalities to archive, copy, or delete them, using a
variety of additional options, such as the creation of a log file of
the operation.

Rename
selected items

Opens a dialog that allows to rename multiple files  at the
same time.

Export
Exports the contents of the "Details" view to a file. If two or more
items are selected, only the selected items will be exported.
Available file formats are "Text Files (.txt)", "HTML Files (.htm)",
"Rich Text Format (.rtf)", "Microsoft Excel (.xlsx)", and "Comma
Separated Values (.csv)".

Email
Sends the content of the "Details" view via email.

Clipboard
Exports the contents of the "Details" view to the clipboard. If two
or more items are selected, only the selected items will be
exported.

Print right
pane

Prints the selected items of the "Details" list.

Select all
Selects all items in the list.

Select none
Unselects the list items.

Invert
selection

Inverts the selection.

Open
command
prompt

Opens command prompt at the current directory of the "Details"
view.

Open in
Windows
Explorer

Opens Windows Explorer and shows the parent folder of the
currently selected items in the "Details" view.

Compress
Compresses this file or folder using NTFS compression.

Decompress
Turns off NTFS compression for this file or folder.

Copy path
Copies the path of the selected items to the clipboard.

132
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Preview pane
Enables or disables the preview pane, which shows the content
of the selected file in the "Details" list.

Context Menu on the Details view

The list on the Details view shows the Windows Explorer context menu when
you right-click on an item. An additional submenu labeled TreeSize is included
which shows all information that is available about the selected item including
the columns that are currently not activated. This submenu may also be used
to activate or deactivate columns (for a description of available columns, see
here) .

6.4.2.1 Available Columns

These are the available columns that can be configured individually for the
Details  view and any export type (Excel, HTML, etc.) using the Options
dialog of  TreeSize.

Column name Description

Name The name of the file or folder.

Full Path The full path, including the object's name.

Size The size of the object.

Allocated The space that the object currently occupies on disk (see
also: Wasted Space  and NTFS Compression ).

Files The number of files in a directory branch.

Folders The number of sub-folders in a directory branch.

Growth The absolute size difference (e.g. in MB) of this element.
Only available if the scan was compared with a saved scan
or snapshot. Please refer to the topic "Directory Tree  >
Compare scans " for more information. The value in this
column depends on the selected view mode and unit (see
tabs Home  and View ).

% Growth The relative size difference of this element

% of Parent The amount of space in percent that a folder or file
occupies relative to its parent folder.

Last Modified The last modification date of the object. TreeSize calculates
the last modified and last access date more precisely than
the Windows Explorer, because it takes all files in all sub-
folders into account. So the values shown in the Windows
Explorer may differ. This behavior can be changed in the
options  dialog, under "Scan > General > Folder date
calculation" (Expert mode).

Last Access The last access date of the object.
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Compr. The size in percent by which an object has been
compressed using the built in compression of the file
system (see also: Notes on NTFS ).

Owner The name of the user that is assigned as owner of the
folder or file in the filesystem.

Optical media
size

The amount of space that an object would occupy on an
optical medium such as a CD or DVD with ISO file system.

Current Date The current date. This column can be useful if you want to
process the collected data, e.g. in a database.

Attributes The file attributes Readonly (R), Hidden (H), System (S),
Directory (D), Archive (A), Compressed (C), Sparse (Q
since Windows 10, P on older Windows versions),
Temporary (T), Offline (O), Reparse Point (L) Encrypted
(E), Pinned (P - only available on Windows 10 or later), 
Unpinned (U), Recall on data access (M), and Alternate
Data Streams (Z).

Type The file type, e.g. "Text file".

Dir Level The level of an object in the file system.

Dir Level
(Relative)

The level of an object in the file system in relation to the
path that was used as starting point for the scan. 

Creation Date The date at which the object has been created.

Containing Path The full path to the current object, not containing the
object's name.

Avg. File Size The average size of a file in a folder.

Permissions The access permissions of the object in the UNIX-like
format: Username1: +/-R +/-W +/-X   Username2: ... where
"+" means the right is granted and "-" means that the right
is denied. "R" stands for read access and "W" for right
access. For files "X" means the right to execute, for
directories the right to list the directory content.
TreeSize maps the actual permissions to a very compact
presentation: Multiple access control elements for one user
are merged to one, and most special permission are not
displayed.

Please note: 
You want to get notified if the permissions of certain
important folders change? This can be done using our
monitoring tool "Server Sentinel". The file system sensor
allows you to monitor specific file system events, send
automatic notifications, and react to them accordingly.

Inherited
Permissions

These are the permissions inherited from the parent
directories.

Own
Permissions

These are the own permissions defined specifically for this
file system object.
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File Version The version number that is included in EXE, DLL OCX and
similar binary files.

Author This column shows the author information that is extracted
from the meta data of the file, taken from MS Office and
compatible files.

Last Save Date This column shows the date on which the file was saved
the last time, taken from MS Office and compatible files.
This information is extracted from the meta data of the file.

Hardlinks The number of hardlinks  to a file. Empty in case of
folders.

Error In case a folders could not be scanned, this column will
contain the message of the error that occurred.

Full User Name Shows the full user name of the owner of that file or folder.

Link Target Shows the target path of a link.

MD5 Checksum Shows a string representation of the MD5 checksum for
this file's content.

SHA256
Checksum

Shows a string representation of the SHA256 checksum for
this file's content.

Extension The extension of the file, e.g. ".txt" for a text file.

Path Length Shows the number of characters included in the full path of
this file or folder.

Alternate Data
Streams

Shows the size hold by "Alternate Data Streams " for this
file (not available for directories).

Space Free Shows the amount of space that is available on the current
drive.

Description For folders and shares this column shows the comment
associated with them. For office files and pictures their
embedded title is shown. In case non of this data is
available, but the folder's of file's name is an SID (like in the
"\$Recycle.Bin" folder), this SID is resolved to a username
in this column.

More Columns:

In addition to the predefined columns that are mentioned above, TreeSize
supports all columns that can be selected in Windows Explorer. The selection
dialog provides a large number of additional meta data, such as the number of
pages in an office document, the width and height of image files, or the artist
for MP3 files.

The TreeSize File Search  allows to search for files that contain any arbitrary
value of the available meta data.

6.4.3 Extensions

The Extensions view shows information on size grouped by file types, thus
granting an overview of the types of files that use up most of the disk space.
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Statistics on file extensions can be activated and deactivated in the Options
dialog.

Context tab: Extensions

Use the Extensions tab in order to select specific information for viewing and
sorting the data. In addition to these filtering options, the tab also provides
commands to export the list contents.

The following commands are available on the "Extensions" tab:

Show files of this
extension

Show a list of all files of the selected file type.

Filter by this
extension

Show only files with the selected file extension.

62
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Clear filter
Remove the filter from the tree and show size information
for all file types.

Add column for this
file type group to
the Details list

Adds a new column to the Details list, which shows how
many files of the selected extensions exist within the
current directory.

Export
Save the contents of this list to a file. If multiple items are
selected, only the selected items will be saved. Available
file formats are "Text Files (.txt)", "HTML Files (.html)",
"Rich Text Format (.rtf)", "Microsoft Excel (.xlsx)", and
"Comma Separated Values (.csv)".

Email
Send the content of the "Extensions" view via email.

Clipboard
Copy the content of this list to the clipboard. If multiple
Items are selected, only the selected items will be copied.

Print right pane
Print the contents of this list.

Select all
Select all items in the list.

Select none
Unselect the list items.

Invert selection
Invert the selection.

Show chart
Turn on or off a chart that shows the distribution of file
extensions.

Group file types
Group similar file types in one group (e.g. "Audio Files",
"Video Files", or "System Files"). You can configure the file
groups in the Options dialog (See: "Options > View > File
Groups ").

6.4.4 Users

The Users view shows information on size grouped by users. At a glance you
can see which user uses how much space in which folder. User statistics may
be enabled/disabled in the options dialog (Options > Scan > General ).
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Context tab: Users

Use the "Users" tab in order to select specific information for viewing sorting
the data. In addition to these filtering options, the tab also provides commands
to export the list contents. 

The following commands are available on the "Users" tab:

Show files of this
user

Show a list of all files that are owned by the selected
user(s).

Limit to this user
Show only the files owned by the selected user.

Clear filter
Remove the user filter and show the complete file and
folder information of the currently selected branch.
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Add column for this
user to the Details
list

Adds a new column to the Details list, which shows how
many files of the selected user exist within the current
directory.

Export
Save the contents of this list to a file. If multiple items are
selected, only the selected items will be saved.

Email
Send the content of the "Users" view via email.

Clipboard
Copy the content of this list to the clipboard. If multiple
Items are selected, only the selected items will be copied.

Print right pane
Print the contents of this list.

Select all
Select all items in the list.

Select none
Unselect the list items.

Invert selection
Invert the selection.

Show chart
Turn on or off a chart that shows the distribution of file
ownership.

Additional columns

By right-clicking on the column header you can enable the following additional
columns:

Full User Name
The full name of the user, queried from Windows or
Active Directory.

User Comment
The user comment from Active Directory.

Quota Usage
The usage queried from Windows quota management.
To see values in the quota columns, you must run
TreeSize as administrator and quota must be enabled
on the local drive that you were scanning.

Quota Limit
The size limit that is set for the user in the Windows
quota manager.

6.4.5 Age of Files

The Ages of Files view shows the distribution of the age of scanned files,
based on one of the following date attributes:

· Last Access Date
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· Last Change Date

· Creation Date

Values for the specified period do not include the other, younger periods.

Context tab: Age of Files

The Ribbon tab for the "Age of Files" view offers export features equal to the
Charts tab and enables you to customize the intervals . The boundaries of
the intervals are always rounded to full days, i.e. to 00:00 a.m.

The following commands are available on the "Age of Files" tab:

Save
Save the current chart as graphic file.
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Email
Export the current chart and send it via email. You can
configure your email settings in options dialog.

Clipboard
Copy the current chart to the clipboard, to paste it in other
applications.

Print right pane
Print the current chart.

Customize file age
intervals

Customize file age intervals (requires a scan refresh).

Add Age of Files to
Details View

Adds a new column to the Details list, which shows how
many files of the selected file age exist within the current
directory.

Show chart in 3D
View chart in 3D or 2D.

Color gradient as
background

Toggle the gradient in the background of the chart.

Colorize bars
Uses different colors for each of the displayed intervals.

Show grid
Show or hide grid lines for this chart.

Zoom in
Zoom in on the chart

Zoom out
Zoom out on the chart

Zoom 100%
Reset zoom to 100%

6.4.6 Top 100 Files

The Top 100 Files view lists the 100 largest files in the scanned branch.
Similar to the Details  view, you can configure the information shown here
using the column header of the list. Please note that files of the system
directory "System Volume Information" and the "Recycle Bin" will not be listed
in this view. In the Options  dialog you may adjust the number of files shown
in the list and whether they will be chosen based on their plain file size or the
space they actually allocate on the disk.
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Context tab: Top 100

The Ribbon tab for the "Top 100 Files" list provides several file-related
operations as well as common export features.

The following commands are available on the "Top 100" tab:

Delete
Delete all selected files.

Properties
Show the properties for the currently selected file.

Export
Save the contents of this list to a file. If multiple items are
selected, only the selected items will be saved.

Email
Send the content of the "Top 100" view via email.
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Clipboard
Copy the content of this list to the clipboard. Copy the
content of this list to the clipboard. If multiple Items are
selected, only the selected items will be copied.

Print right pane
Print the contents of this list.

Select all
Select all items in the list.

Select none
Unselect all list items.

Invert selection
Invert the selection.

Open in Windows
Explorer

Open Windows Explorer to show the folder containing the
selected file.

Copy as path
Copy the path of the selected items to the clipboard.

6.4.7 History

In the History view you can see line charts visualizing the size development of
the selected root folder. After each scan the size, allocated space, and number
of files of the root folder are stored automatically in an XML file in the users
profile of the currently logged-in user. These sizes are used to create this view.
As a result the shown interval and frequency depends on the scans you have
performed for this root before.

Please note:

· Only scans of the same path and the same exclude filters  will be
displayed in the history, since a common base is needed to compare scans.

· If you are interested in the size development of subfolders in the scanned file
system tree, we recommend using our disk space manager
SpaceObServer, which archives file system information in a database and is
able to track size development down to file level.
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Context tab: History

Use the "History" tab to customize the appearance of the chart, to export the
chart to a file, and to manage history data.

The following commands are available on the "History" tab:

Save
Save the current chart as graphic file.

Email
Export the current chart and send it via email. You can
configure your email settings in options dialog.

Clipboard
Copy the current chart to the clipboard, to paste it into
other applications.

Print right pane
Print the current chart.

Manage history
data

Provides actions for the export/import and purge of history
data. Additionally allows choosing a new storage location
for the data.

Show zero point
Show zero point as minimum value in the chart.
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Show
"Size/Allocated"
seires 

Do not only show the currently selected value
(size/allocated), but also the respective other one

Show grid
Show or hide horizontal and vertical grid lines for this chart.

Show average
series

Show or hide a line indicating the average trend for this
chart.

Show labels
Show info boxes (size values/number of files) in the chart.

Show total
diskspace

Show or hide a horizontal line showing the total diskspace.

Equalize chart
defines wether the chart is displayed interpolated or exact.

Color gradient as
background

Toggle the gradient in the background of the chart.

Show data points
Show or hide points on line chart.

Zoom in
Zoom in on the chart

Zoom out
Zoom out on the chart

Zoom 100%
Reset zoom to 100%

Remove data point

Using the context menu of the History view, you can remove single data points.
Please note that this requires the "Show data points" option to be enabled
(see above).
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6.5 Drive List

The Drive List shows the local drives as well as the connected network
drives. You can see the size of the drive as well as the free disk space. The
S.M.A.R.T. column offers a quick info about the health and hardware status
of supported devices.

Double-clicking starts a scan of the selected drive.

Notes 

· If you don't see your network drives in the Drive List, please refer to this FAQ
entry .

· S.M.A.R.T. is available only for local drives supporting the S.M.A.R.T.
standard (Self-Monitoring, Analysis and Reporting Technology). Windows
grants access to these values only to processes that have been started "as
administrator" and if the installed driver supports this.

· Additionally to the listed drive UNC paths can be added using the right click
menu.

· You can use wildcards when defining the paths to be scanned. This way, you
can even scan paths like "S:\Users\R*" or "R:\*\MyVideos".

· You can scan all shared drives in a domain by entering the domain name in
the drive combo box.

· The drive list can be automatically exported into an Excel, Text, or CSV file by
using the command line option  "/EXPORTDRIVESLIST".

Context tab: Drive List

The Drive List has its own Ribbon context tab providing several additional
actions for the Drive List.

The following commands are available on the "Drive List" tab:

Properties
Shows the properties for the selected drive.

10
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Open in Windows
Explorer

Opens the currently selected drive(s) in the Windows
Explorer.

Remove from list
permanently

Removes the selected path or drive permanently from the
list.

Map network drive
Opens the Windows "Map Network Drive" dialog.

Add drive or UNC
path

Enables you to select or enter a path or drive and add it to
the drive list.

Add all shares of a
server

Adds all shares of a server to this list as UNC paths.

Export
Exports drive list information (path, size, free space, etc.)
to an Excel or text file.

Copy list to
clipboard

Copies drive list information (path, size, free space, etc.) to
the clipboard.

Import from
clipboard

Imports all paths currently contained in the clipboard into
the drive list.

Print
Prints drive list information (path, size, free space, etc.).

6.6 Snapshots

The Snapshot feature of TreeSize provides a quick overview on the
development of disk space usage for the selected path. A snapshot can be
described as "photography" of the disk space status at a certain point in time. It
is created within seconds and Windows will automatically delete it if the space
it occupies is needed. The amount of disk space reserved for snapshots can
easily be configured via TreeSize or the Windows System Configuration
(Tools  > Configure Windows System Restore).

Creating a snapshot

Creating snapshots from within TreeSize is only supported for local drives, not
for network drives. You need to run TreeSize as administrator in order to be
able to create snapshots.

To create a new Snapshot, please click the "Create snapshot" button on the
"Tools " Ribbon tab. Creating the snapshot may take a moment.

If the feature is disabled on the system, no snapshot can be created for any
local partition. Check the settings in your Windows environment via Control
Panel > System and Security > Computer Protection : it must be switched to
ON for the system partition and for every partition you want to use with the
snapshot feature.

This feature is not supported on Windows XP.

26
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Comparison with a snapshot

You can compare a current scan with a previous scan using the comparison
feature . This gives you an in-depth overview of each folder and file and its
size development since the creation of the given snapshot. Not only remote
Windows systems are supported, but also non-Windows systems like storage
system from NetApp and EMC.

6.7 Disk Usage Comparison

For a detailed analysis of your disk space usage it may be helpful not only to
see the current usage, but also its development over time. 

TreeSize provides a powerful comparison mode enabling you to analyze size
development over a period of time. For that purpose, TreeSize compares data
of the current scan with historical data. There are two different data sources
available for the comparison:

· Previously saved TreeSize scans (XML report).

· Snapshots of the file system (available only for local NTFS drives).

To enable the comparison mode, please follow these steps:

1. Scan the path you want to view the size development for to get current
reuslts.

2. Go to Scan  > Compare with saved scan  or Compare with
snapshot .

o If you selected "Compare with saved scan", you may now choose the
XML file of the previously saved scan.

o If you selected "Compare with snapshot", a dialog will open enabling you
to choose a snapshot.

3. Select if you want to view size changes in the Directory Tree, in Views ,
or both.

By comparing a scan result with a previous scan, you can easily see which
filers and folders were added and removed and analyze the space
development in that time period. This can help to identify files and folders that
grow in size regularly and could eat up your space quickly if not handled at an
early stage.

Comparison with a snapshot

TreeSize provides several different ways to compare your scans with each
other. The easiest way to do this is the snapshot feature . A snapshot could
be described as a "photography" of the disk space status at a certain point in
time. Major benefits of this mechanism are, that it can be created within
seconds and Windows will automatically delete it if the disk space that it
occupies is needed.
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To compare a disk space scan with a snapshot, simply select a scan in the
Directory Tree . Now click the "Compare with snapshot" button on the
"Scan " Ribbon tab. You can also use the Application Menu  ("File" >
"Compare current scan" > "Compare with snapshot").

The following dialog shows a list of the available Snapshots sorted according to
their time-stamp. It also shows the free space of each Snapshot, making it
easy to spot exactly when the disk space on the hard drive where the current
scan path resides on has increased or decreased. After selecting a Snapshot,
click the "Compare" button to start the size comparison process.

Please note: if this list is empty or an error message "No snapshots available
for this scan" appears, there are two possible reasons for that: either no
snapshots are existing or not all necessary services are running on the
destination system. You can verify this by doing a right-click on the destination
directory, open properties and select the "Previous Versions" tab. If no
snapshots are listed there, the program itself can also not list any entries. If you
see entries there then not all required services have been running. These
services have now been started implicitly by opening the dialog and if you now
execute "Compare with snapshot" again , you should see the correct results.

Comparison with saved scan

31
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Scans results can be written into XML files at any given time, which provides a
history of your disk usage. These files can be stored away and reused in a later
step for detailed analysis. You can use this information to compare your
current scan results with the situation at any given time in the past.

To compare a disk space scan with a saved scan, select a scan in the
Directory Tree  and click the "Compare with saved scan" button on the
"Scan " Ribbon tab. You can also use the Application Menu  ("File" >
"Compare current scan" > "Compare with saved scan"). The subsequent
dialog allows you to select a previous scan that has been saved into an XML
file. 

Displaying the comparison

The result of the size comparison can be viewed in the "Directory Tree ", in
the "Details " view, or in both at the same time.

Elements that are highlighted in red have increased the disk space usage
compared to the saved scan or snapshot, while a green element indicates that
the disk space usage is now lower than in the saved state used for
comparison. You can choose whether you want to compare the size, the
allocated space, or the number of files between the two scans by clicking the
corresponding button in the "Home " Ribbon tab.

6.8 Options Dialog

The options dialog of TreeSize enables you to modify scan, appearance, and
startup settings of the application as well as customize any supported export
format (Text, Excel, etc).

These are the available options pages:

31
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Scan

General General settings influencing the scan behaviour of TreeSize.

Filter Define filtering options for TreeSize.

View

Display General settings influencing the appearance of TreeSize.

Details Configure the columns shown in the Details  view of
TreeSize.

Directory
Tree

Customize the appearance of the Directory Tree  of
TreeSize.

File
Groups

Define which file extensions will be grouped together in the
Extensions view  of TreeSize.

Age of
Files

Configure the intervals used to generate the charts of the Age
of Files  view. 

Export

Printer Configure printer settings for TreeSize.

PDF Configure the PDF file report of TreeSize.

Excel Configure the Microsoft Excel file report of TreeSize.

HTML Configure the HTML file report of TreeSize.

CSV Configure the CSV (comma-separated-values) file report of
TreeSize.

XML Configure the XML file report of TreeSize.

Text Configure the plain text file report of TreeSize.

Email Configure email settings for TreeSize.

System

Start Modify startup settings for TreeSize.

Context
Menu

Configure the Windows Explorer context menu integration of
TreeSize.
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6.8.1 Scan

6.8.1.1 General

General settings influencing the scan behaviour of TreeSize.

Please note

· Changes applied here usually require a rescan of the currently scanned
drives and folders to take effect.

Scan Depth

Track NTFS-specific features 
With this option you can control whether TreeSize should check each file if it is
just a hardlink  to another file, if contains alternate data streams (ADS)  or
uses the new NTFS compression features available in Windows 10. The will
result in more accurate results for the allocated space, but will also slow down
the speed of a scan.

Follow mount points and external symbolic links to directories

174 173
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You can decide if TreeSize should follow symbolic links and mount points (see
Notes on NTFS  for additional information) that point to other drives or folders
on other drives. Links that point within the scanned directory will never be
followed in order to prevent circular references and folders from being counted
twice.

Statistics

Create statistics for age of files
If this checkbox is activated, TreeSize will generate statistics for the age of files
in each sub tree. The results can be viewed on the Age of Files  view of the
main window. The creation of these statistics will increase the memory
consumption of the application.

Create statistics on file extensions
If this check box is activated, TreeSize will generate statistics for the file
extensions in each sub tree. The results can be viewed on the Extensions
view  of the main window. The creation of these statistics will increase the
memory consumption of the application.

Create statistics on file owners
If this check box is activated, TreeSize will generate statistics for the file
owners in each sub tree. The results can be viewed on the Users view  of
the main window. Since it is necessary to query the owner of each file, this
option will slow down the scanning process if activated.

Notifications

Show error messages during scan
Use this option to decide whether TreeSize should show error messages
during scanning. If you, for example, scan a network drive on a Windows
server and don't have reading access to all folders, Windows will pop up an
error message for every unreadable folder. If you don't want the scanning
process interrupted by these message boxes, uncheck this check box.

Notify when the scan is finished

Shows a message in the Windows system tray, once a longer running scan is
finished.

Thread Options (expert option)

Thread Priority
Enables you to define the priority with which the threads scanning the hard disk
are running. "Idle" means that the CPU will be used only if no other threads are
using it. "Idle" is a good setting if you want to make sure that a scan with
TreeSize has no impact on the performance of the PC or server. The default
and recommended value is "lower priority". Choosing a higher priority will result
in the scan threads having a higher priority than the thread of the user interface,
which can make the user interface unresponsive during a scan. This setting is
also used for the threads of the TreeSize File Search .
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Maximum number of threads per scan
TreeSize automatically adjusts the number of threads to the CPU usage. This
option lets you define the maximum number of threads that will be started for a
scan. If the system load is high, fewer than the maximum number of threads
may be started.

6.8.1.2 Filter

Define filtering options for TreeSize. If you need information about e.g. certain
file types only, you can specify a filter using this options page. Please note that
changes on this options page usually require a rescan of the currently scanned
drives and folders to take effect.

How to define a filter (exclude or include)

To define a new filter, please follow these steps:

1. Click the "Add pattern" button. An entry will be created in the filters list for the
new filter.

2. Decide whether this filter shall operate as an exclude or include filter
using the "Action" selector of the newly created entry. An exclude filter for
the pattern "*.exe" for example will make TreeSize to not show any files with
the extension ".exe". This will also affect the calculated values such as the
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"Size" in the Directory Tree  as well as any other view . An include filter,
on the other hand, will make TreeSize show only items that match this
pattern. To return to the previous example, an include filter of "*.exe" would
result in a Directory Tree showing only data related to files that have the
extension ".exe". If you have chosen to match against File Type, the edit
field will show a dropdown button that allows to choose file type groups
like "Office files" or "Video Files".

3. Define the actual pattern. You can either use simple Wildcard pattern such
as "*.exe", Regular Expression patterns such as ".+\.exe$", or patterns
that match full names like "notepad.exe". Please make sure that you select
the matching pattern type on the "Type" selector on the right side of the
window.

4. The "Match Against" selector is used to specify the element/attribute against
which the pattern is compared. Patterns can either be matched against file
names, (full) paths, owners, folder names, or object names. You can use
the "owner" filter to, for example, include or exclude certain file owners from
the TreeSize scan results. With the "full paths" or "folder name" filter you
can include or exclude complete directory branches matching a certain
pattern (e.g. "*\Program Files*"). The "file name" filter should be used when
you intend to include or exclude certain file extensions (e.g. "*.tmp"), like
described in step 2.

Preview the results

The "Preview" button enables you to view the results of a defined search
pattern. The preview will use the currently selected pattern to show an
Explorer-like view highlighting excluded and included items in appropriate
colors (red and green). The following screenshot shows the results of an
exclude filter for full paths that match the pattern "Program Files".

31 34
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The following list describes additional filter settings that can be defined on this
options page.

Additional Filter Settings

Include only files created in the past ... days
If this option is set, only files and folders which have been created within the
specified amount of days will be scanned. This can be useful to calculate the
size of backups or to identify "heavy growing" folders. A value of "0" means that
all files will be included (default). 

This is a volatile setting and won't be persisted. It applies to the running
instance of TreeSize only. 

Include only files with "archive" attribute
Check this option if you want to count only files for which the "archive" attribute
has been set. This can be useful to determine the size of backups.

This is a volatile setting and won't be persisted. It applies to the running
instance of TreeSize only. 

Exclude offline files
This option enables you to exclude files that are marked as "offline". Offline files
are often not physically present on the disk or are only cached temporarily on
the local disk.

Hide empty folders
Check this option to hide empty folders from the view. A folder is considered
empty if no file or folder has been found or if all contained files have been
filtered.

6.8.2 View

6.8.2.1 Display

General settings that influence the appearance of TreeSize.
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Visual Effects

Show compressed files and folders in blue
If this option is selected, compressed files on an NTFS volume are shown in a
blue color. Folders that are partially compressed will have a dark blue color,
files and folders that are entirely compressed will show up in a light blue color.
For more information on file-based compression see Notes on NTFS .

Show folders containing paths >260 chars in red
Select this option, if folders containing long paths should appear in a red color.
This is useful for finding file system structures that exceed the Windows
MAX_PATH constant. Many tools and the .NET framework have problems with
these long paths. Using the custom search  of the TreeSize File Search you
also can search for such files.

Show folders in bold that are larger than ...
Use this option to define a threshold at which folders in TreeSize will be shown
bold. You can either define a percentage value [% of the scanned folder] or a
size value [Megabytes (allocated space). Folders will be shown bold in the
Directory Tree  and in the Details view  of TreeSize.
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Language

Use language
Select the language that is used for TreeSize's user interface.

Date/Time Format

Use the following date/time format, e.g. for "Last Access":
The date/time format that is used by TreeSize in related columns like "Last
Access", "Last Change", or "Creation Date" can be defined here. Available
formats are date, date+time (without seconds), and date+time (with seconds).
Please note that in some rare cases TreeSize may display "wrong" date/time
format. For more information on this issue, please refer to this article from our
Knowledge Base.

Usernames format

Offers various choices how usernames should be displayed.

Expert Options

Number of paths in the "Recently scanned" list:
Here you can adjust the maximum number of entries shown in the "File ->
Recently scanned" list. The maximum value for stored paths is 20.

Automatically update right pane during scan
If this option is selected, the right pane of the window will be updated from time
to time. This allows you, for example, to watch the bars of a chart growing
while scanning large drives. Use the drag bar to set the interval of the updates.

Determine icons based on file extension only
If this option is selected, the default icon for files based on the file extension is
used. This is much faster, especially on network drives.

Enable Drag & Drop
Allows to deactivate the drag and drop features of TreeSize. Turning off drag
and drop should prevent unwanted changes on critical systems.

6.8.2.2 Details

This options page can be used to configure the columns shown in the
Details  view of TreeSize. For a description of the available columns please
refer to "Available columns ".
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Notes

· You can change the ordering of columns using the arrows on the left. Click
the desired column first, then click an arrow to move the column up/down.

· The column that should be visible in the Details view can also be configured
by right-clicking the column header (see screenshot below).
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6.8.2.3 Directory Tree

Use these options to customize the appearance of the Directory Tree  of
TreeSize.

31
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Grouping of Scans

Group all scans in a virtual root

Group scans under a virtual root folder showing summarized values for all
scans that are part of this group.

Files in Directory Tree

Do not show single files in the Directory Tree

If this options is activated, files will grouped into a special node with the name
"[Files]". This improves browsing of the directory tree, since you won't have to
bother with individual files on each folder level.

Show single files in directory tree

If this option is activated, the directory tree will list single files.
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Gradient Bars

Show gradient bars as size indicators in directory tree

If this option is active, a gradient bar is shown in the background of every folder
in the directory tree that indicates the size of the folder in relation to the entire
scanned file system tree. Use the color picker below to define a custom color
gradient.

Tooltip

Only for cut off labels

Typically no tooltip is shown. In case the text does not entirely fit into a label,
the full test will be shown as tooltip.

Show long tooltips in directory tree

If this option is active, a tooltip window with detailed information will be shown if
the mouse cursor hovers over a folder for a while. This is useful if you want to
take a look at detailed information of a folder without switching to the "Details"
view,

Show a preview of the hovered folder's contents

Allows you to peek into a folder without actually expanding the folder in the
directory tree.

6.8.2.4 File Groups

This page allows you to define which file extensions will be grouped together in
the Extensions view  of TreeSize.45
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Adding a new group

1. Enter the name of the group (e.g. "Text files") in the "Group definitions" text
field on top of the page.
The name is shown in the left column of the Extensions view .

2. Click "Add Group".

3. In the popup window, enter a meaningful description for the new group (e.g.
"Plain text files, log files, etc.").

4. Click the text field in the "Associated file types" area and enter the desired
file extensions (e.g. "*.txt"). 

5. Click "Add Pattern".

6. Repeat the step 4 and 5 until you have added all of the desired file
extensions.

7. Click "Apply" to save the settings.

Add/remove/edit file extensions of an existing group

1. Click the desired file extensions group in the "Group definitions" on top of the
page.

45
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2. Add new file extensions like described in steps 4 and 5 above
or
use the "Remove" button on the right to remove an existing file extension
from the list
or
right-click on an existing file extension and click "Edit Pattern" to change the
pattern of an item.

3. Click "Apply" to save the settings.

Edit caption and description of an exiting group

Simply right-click on the desired group and select "Edit Caption" or "Edit
Description".

Export/import list of file extensions

For existing groups, you can export the definition of file extensions by right-
clicking on the "Associated file types" listing and selecting "Export". A text file
containing one file extension in each line will be created. You can import a
definition into an existing group in the same way.

6.8.2.5 Age of Files

This options page allows you to configure the intervals used to generate the
charts of the Age of Files  view. 49
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You may change the limit of each interval, add additional intervals using the '+'
button, or remove intervals using the '-' button. You can turn off the creation of
the "Age of Files" statistics using the check box on top of the list. This will
slightly reduce the memory usage of TreeSize. Furthermore, you can select
whether the file ages should be determined based on the "Last Access Date",
the "Last Change Date" (default) or the file "Creation Date".

6.8.2.6 Charts

This section contains options that change the amount of information that is
shown in the chart related views of TreeSize and the way that they are
displayed.
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General Options

Show long tooltips
Activate this option to include additional tooltip information to the charts about
the data that is currently being displayed.

Show background
Adds a color gradient to the background of the charts tab.

Show legend
Provides a description of the different segments that are included in a chart.
The legend is shown below the chart.

Show free space
Includes a separate segment to the chart that indicates the amount of free
space that is available on the drive that is currently being displayed.

Bar chart
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Show grid
Adds a grid to the chart that corresponds to the current segmentation on the x-
axis on the chart.

Show labels
Additional labels for each segment that contain name and size information.

Pie chart

Show legend
Provides a description of the different segments that are included in a chart.
The legend is shown below the chart.

Tree map

Show full hierarchy
If activated, TreeSize will show the full directory structure when displaying the
tree map. If deactivated, it will only show the deepest nesting of the hierarchy,
which means that only files and folders without subfolders will be shown.

Show labels
These labels describe which file, or folder is currently being displayed in the
different tiles of the tree map.

Show legend
Provides a description of the different segments that are included in a chart.

Colorize Tree map items
This option allows to change how items are colorized in the tree map. You can
either select to use different colors for different file types, or to highlight the
level of a file within the file system with a corresponding color.

6.8.2.7 Top Files

This options page allows you to configure any options that apply to the Top 100
files  view.51
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Top Files

By default, TreeSize will identify the 100 largest files within a scan and show
them in a separate view. To adjust this number, or the way that these files are
determined, change the appropriate option in this section.

Visible Columns

All columns  that are checked in this list will be shown in the top files list. By
using the arrow buttons, you can also modify the order of columns that are
displayed. You can also change them in the user interface directly, by right
clicking the column header of the top files list and selecting the desired
columns from the context menu.

6.8.3 Export

6.8.3.1 Printer

Configure printer settings for TreeSize.

43
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Charts and lists to include

Configure the charts and lists that are added to the export
Check all the different chart types and list types that shall be included in the
report that will be printed.

Depth of Directory Tree

Export expanded folders only
Only the expanded/visible parts of the Directory Tree  will be printed.

Export the full directory branch
If this option is selected, the complete Directory Tree  will be printed.

Exported Elements

Do not export single files
If this option is selected, single files will not be printed. Instead, their values
such as "Size" and "Allocated" will be aggregated into a special node "[Files]".

31

31
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Include single files in export
If activated, single files will be printed. This may result in very large reports
compared to exporting the files in a grouped view (see option above).

Exported Columns

Use the column list to specify which information shall be included in printed
reports. A list of all available columns with their descriptions can be found
here .

Use same columns as in details view
Activate this option if you want to use the same columns that are currently
used in the details view .

Size of selected column
Define a pixel size that is used for this column when printing the report.

Formatting

Use bold text and colors for printed reports too
Turn this option on to apply the settings for bold folder names for printed
reports.

Setup

Print Setup...
Opens a dialog that allows to select the default printer, as well as the size and
orientation of the printed report.

Page Setup

Margin Left/Top/Right/Bottom
Change these margins to increase or decrease the spacing that is left near the
edges of the report.

Page orientation
Use "Portrait" for a vertically aligned report, or "Landscape" for horizontal
alignment.

6.8.3.2 PDF

Configure the PDF file report of TreeSize.

43
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Charts and lists to include

Configure the charts and lists that are added to the export
Check all the different chart types and list types that shall be included in the
report of this export type.

Depth of Directory Tree

Export expanded folders only
Only the expanded/visible parts of the Directory Tree  will be exported.

Export the full directory branch
If this option is selected, the complete Directory Tree  will be exported.

Exported Elements

Do not export single files

Single files will not be included in the report. Instead, their values such as
"Size" and "Allocated" will be aggregated into a special node "[Files]".

Include single files in export

31

31
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Single files will be listed in the report. This may result in very large reports
compared to exporting the files in a grouped view (see option above).

Exported Columns

Use the column list to specify which information shall be included in PDF
exports. A list of all available columns with their descriptions can be found
here .

Use same columns as in details view

Activate this option if you want to use the same columns that are currently
used in the details view .

Include header information

Use this option to control whether header information (such as the title and
date of the report) and the column headers should be added to the exported
file.

Formatting

Use bold text and colors for reports too
Turn this option on to apply the settings for bold folder names for PDF reports.

Page Setup

Margin Left/Top/Right/Bottom
Change these margins to increase or decrease the spacing that is left near the
edges of the report.

Page orientation
Use "Portrait" for a vertically aligned report, or "Landscape" for horizontal
alignment.

6.8.3.3 Excel

Configure the Microsoft Excel file report of TreeSize.

43
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Charts and lists to include

Configure the charts and lists that are added to the export
Check all the different chart types and list types that shall be included in the
report of this export type.

Depth of Directory Tree

Export expanded folders only
Only the expanded/visible parts of the Directory Tree  will be exported.

Export the full directory branch
If this option is selected, the complete Directory Tree  will be exported.

Exported Elements

Do not export single files
Single files will not be included in the report. Instead, their values such as
"Size" and "Allocated" will be aggregated into a special node "[Files]".

31

31
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Include single files in export
Single files will be listed in the report. This may result in very large reports
compared to exporting the files in a grouped view (see option above).

Exported Columns

Use the column list to specify which information shall be included in Excel
exports. A list of all available columns with their descriptions can be found
here .

Use same columns as in details view
Activate this option if you want to use the same columns that are currently
used in the details view .

Included information

Include summary information
Use this option to specify whether a short summary information, such as the
title and date of the report, should be added to the exported file.

Include units in export
If this options is activated, units like "KB", "MB", or "%" will be included in the
exported data. Uncheck this option, if you want to export plain values.

Size unit
The size unit that will be used for the export of Excel files. You can either select
a specific unit from Byte to Terabyte, let TreeSize automatically determine the
optimal unit, or use the same unit that was last used in the user interface.

Default Target File

Path of the default target file
Specify a file to which exported data should be written by default.

Formatting (Expert mode)

Use bold text and colors for reports too
Applies color and formatting options, such as bold text for larger folders, to
generated reports as well.

Generate expandable/collapsible Excel report
A dynamic Excel report will be created in which items such as folders can be
expanded/collapsed just like in the Directory Tree.

Format file and folder paths as

43
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Chose in which way the paths of files and folders should be formatted in the
Excel report. Paths can be formatted either as plain text or as hyperlinks.

6.8.3.4 HTML

Configure the HTML file report of TreeSize.

Charts and lists to include

Configure the charts and lists that are added to the HTML export
Check all the different chart types and list types that shall be included in the
report of this export type.

Depth of Directory Tree

Export expanded folders only
Only the expanded/visible parts of the Directory Tree  will be exported.

Export the full directory branch

31
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If this option is selected, the complete Directory Tree  will be exported.

Exported Elements

Do not export single files

Single files will not be included in the report. Instead, their values such as
"Size" and "Allocated" will be aggregated into a special node "[Files]".

Include single files in export

Single files will be listed in the report. This may result in very large reports
compared to exporting the files in a grouped view (see option above).

Exported Columns

Use the column list to specify which information shall be included in HTML
exports. A list of all available columns with their descriptions can be found
here .

Use same columns as in details view

Activate this option if you want to use the same columns that are currently
used in the details view .

Included information

Include summary information
Use this option to specify whether a short summary information, such as the
title and date of the report, should be added to the exported file.

Include units in export
If this options is activated, units like "KB", "MB", or "%" will be included in the
exported data. Uncheck this option, if you want to export plain values.

Size unit
The size unit that will be used for the export of Excel files. You can either select
a specific unit from Byte to Terabyte, let TreeSize automatically determine the
optimal unit, or use the same unit that was last used in the user interface.

Style Sheet

Path of the optional style sheet

Define an optional style sheet which will be used to customize the created
report.

Formatting (Expert mode)

Use bold text and colors for reports too

31
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Applies color and formatting options, such as bold text for larger folders, to
generated reports as well.

Format file and folder paths as
Chose in which way the paths of files and folders should be formatted in the
Excel report. Paths can be formatted either as plain text or as hyperlinks.

6.8.3.5 CSV

Configure the CSV file report of TreeSize.

Depth of Directory Tree

Export expanded folders only
Only the expanded/visible parts of the Directory Tree  will be exported.

Export the full directory branch
If this option is selected, the complete Directory Tree  will be exported.

31
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Exported Elements

Do not export single files
Single files will not be included in the report. Instead, their values such as
"Size" and "Allocated" will be aggregated into a special node "[Files]".

Include single files in export
Single files will be listed in the report. This may result in very large reports
compared to exporting the files in a grouped view (see option above).

Exported Columns

Use the column list to specify which information shall be included in CSV
exports. A list of all available columns with their descriptions can be found
here .

Use same columns as in details view
Activate this option if you want to use the same columns that are currently
used in the details view .

Included information

Include summary information
Use this option to specify whether a short summary information, such as the
title and date of the report, should be added to the exported file. For CSV
exports, this will also define whether or not the name of the columns is
included in the export.

Include units in export
If this options is activated, units like "KB", "MB", or "%" will be included in the
exported data. Uncheck this option, if you want to export plain values.

Used size unit
The size unit that will be used for the export of CSV files. You can either select
a specific unit from Byte to Terabyte, let TreeSize automatically determine the
optimal unit, or use the same unit that was last used in the user interface.

List separator

Separate list columns using:
This options allows you to select which separator should be used for the export
of CSV files. By default, the regional settings of the system will be used.

43
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6.8.3.6 XML

Configure the XML file report of TreeSize.

Please note:

· Certain columns cannot be configured for XML reports as these represent
required data for the "Load XML report" or "Compare with XML report"
features of TreeSize.

· TreeSize ships with an XSLT file that formats the data in the XML file for
output in a browser that supports XSLT processing (see option "Style Sheet"
below).

Depth of Directory Tree

Export expanded folders only
Only the expanded/visible parts of the Directory Tree  will be exported.

Export the full directory branch
If this option is selected, the complete Directory Tree  will be exported.

31
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Exported Columns

Use the column list to specify which information shall be included in XML
exports. A list of all available columns with their descriptions can be found
here .

Style Sheet

Path to style sheet (optional)
Define an optional style sheet which will be used to customize the created
report.

6.8.3.7 Text

Configure the plain text file report of TreeSize.

Please note:

· The "column" settings of the text export also affect the export to clipboard!

43
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Depth of Directory Tree

Export expanded folders only
Only the expanded/visible parts of the Directory Tree  will be exported.

Export the full directory branch
If this option is selected, the complete Directory Tree  will be exported.

Exported Elements

Do not export single files
Single files will not be included in the report. Instead, their values such as
"Size" and "Allocated" will be aggregated into a special node "[Files]".

Include single files in export
Use this option to control whether header information (such as the title and
date of the report) and the column headers should be added to the exported
file.

Exported Columns

Use the column list to specify which information shall be included in text
exports. A list of all available columns with their descriptions can be found
here .

Use same columns as in details view
Activate this option if you want to use the same columns that are currently
used in the details view .

Included information

Include summary information
Use this option to specify whether a short summary information, such as the
title and date of the report, should be added to the exported file.

Include units in export
If this options is activated, units like "KB", "MB", or "%" will be included in the
exported data. Uncheck this option, if you want to export plain values.

Used size unit
The size unit that will be used for the export of text files. You can either select a
specific unit from Byte to Terabyte, let TreeSize automatically determine the
optimal unit, or use the same unit that was last used in the user interface.

List separator

31
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Separate list columns using:
This options allows you to select which separator should be used for the export
of CSV files. By default, the regional settings of the system will be used.

6.8.3.8 Email

Configure email settings for TreeSize.

Email content

To
The email address the report will be sent to.

Subject
The subject of the email. Supports environment variables such as %DATE%,
%TIME% or %USERNAME%. 

Format
Choose an email format here.
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Transport

Use MAPI client
If this setting is checked, TreeSize will use the local MAPI client (for example
Microsoft Outlook) for sending mails.

Use SMTP server
TreeSize will use the specified SMTP server to send email reports. Please
make sure to test the connection settings before applying the current options.

Please note that you will have to enter valid SMTP settings in order to make
use of email reports in scheduled scan or search tasks  or all other kinds of
automated starts (e.g. batch programs or command line calls) (Professional
Edition only).

From
The email address that will be shown as the sender of the report.

Server
The name (DNS) or IP address of the machine hosting the SMTP
service through which messages are to be sent.

Port
The port on which the SMTP service specified in the "Server" field is
listening for connections.

Use secure (SSL) connection
Indicates that Secure Sockets Layer (SSL) should be used when
sending messages via SMTP.

This server requires authentication
Select this option if SMTP service specified by the Server field requires
authentication. Passwords will be encrypted before storing them in the
TreeSize settings file.

Test Connection
Test the SMTP connection settings. This will send a test email to the
email address specified in the "To" field.

Charts and lists to include

Configure the charts and lists that are added to the email export
Check all the different chart types and list types that shall be included in the
report that is send via email.

144
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Depth of Directory Tree

Export expanded folders only
Only the expanded/visible parts of the Directory Tree  will be exported.

Export the full directory branch
If this option is selected, the complete Directory Tree  will be exported.

Exported Elements

Do not export single files
Single files will not be included in the report. Instead, their values such as
"Size" and "Allocated" will be aggregated into a special node "[Files]".

Include single files in export
Single files will be listed in the report. This may result in very large reports
compared to exporting the files in a grouped view (see option above).

Exported Columns

Use the column list to specify which information shall be included in email
exports. A list of all available columns with their descriptions can be found
here .

Use same columns as in details view
Activate this option if you want to use the same columns that are currently
used in the details view .

Column list
Use the column list to specify which information shall be included in the report
for this export type. A list of all available columns with their descriptions can be
found here .

Included information

Include summary information
Use this option to specify whether a short summary information, such as the
title and date of the report, should be added to the exported file.

Include units in export
If this options is activated, units like "KB", "MB", or "%" will be included in the
exported data. Uncheck this option, if you want to export plain values.

Size unit

31
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The size unit that will be used for the export of Excel files. You can either select
a specific unit from Byte to Terabyte, let TreeSize automatically determine the
optimal unit, or use the same unit that was last used in the user interface.

Formatting (Expert mode)

Use bold text and colors for reports too
Applies color and formatting options, such as bold text for larger folders, to
generated reports as well.

Format file and folder paths as
Chose in which way the paths of files and folders should be formatted in the
Excel report. Paths can be formatted either as plain text or as hyperlinks.

6.8.4 System

6.8.4.1 Start

Modify startup settings for TreeSize.
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Start As Administrator

Always start this application as administrator
When activated, TreeSize will always start with administrator privileges. This
will trigger the UAC (User Access Control) prompt, if UAC is enabled.

Action at Application Start

Do nothing
The application will start with an empty window. A scan can be started using
the path selection drop-down list  or via the corresponding button on the
Home  tab.

Scan the same path(s) as last time
All paths shown in the directory tree the last time TreeSize was closed will be
re-scanned once the application is started again.

Always scan these paths
Enter up to five paths to be scanned when the application starts.

6.8.4.2 Context Menu

Configure the integration of the Windows Explorer context menu in TreeSize.

7

22
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Explorer Context Menu

Show TreeSize in Windows Explorer context menu of current user
Select whether TreeSize should appear in the context menu of folders in the
Windows Explorer. Click on the corresponding menu item to start TreeSize
and scan the selected folder immediately.

Show TreeSize File Search in Windows Explorer context menu of current user
Select whether the TreeSize File Search should appear in the context menu of
folders in the Windows Explorer.

7 Using the TreeSize File Search

The TreeSize File Search offers the ability to search for obsolete files or
perform a highly customizable search.

You can open the TreeSize File Search via the Windows "Start" menu or the
TreeSize "Tools " ribbon tab.26
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Learn how to use the TreeSize File Search in the following sections: 

· The File Search Window

· The Ribbon Bar

· The Search Options

· Biggest files

· Oldest files

· Temporary files

· Internet files

· Duplicate files

· Custom search

· Move checked files
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7.1 The File Search Window

These are the important elements of the TreeSize File Search window:

1
.

The Ribbon Bar  provides access to all commands of the TreeSize File
Search. It is divided into logical sections containing commonly used
functions and elements (e.g. the "Home " tab), or the tabs enabling you
to customize the appearance of the search results (e.g. the "View "
tab ). Press the "Start" button to start searching with the currently selected
search options in the selected drives and paths .

2
.

 TreeSize offers the following file search types:  

· Biggest Files

· Oldest Files

· Temporary Files

· Internet Files

· Duplicate Files

· Custom Search

Use the check box to activate a certain search type. When a new search
is started, all activated searches will be executed, after which the number
of results will be displayed. After the search has been completed, select a
search type (click on the caption) to show the search results of this search
(See 3.).

3
.

In the center of the window, the result list of the search type you selected
at 2. is shown. Files and folders that have been found, can be selected, or
checkmarked here.
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You can customize the amount of information shown by right-clicking the
header of the list. This opens a context menu that provides a selection of
predefined columns. Additional columns are available through a selection
dialog ("More columns"). TreeSize supports all columns that are available
in Windows Explorer.

A detailed description of the different columns can be found here .

4
.

This preview panel shows detailed information and a thumbnail image of
the currently selected element in the shown result list. You can hide this
panel at "View > Details pane ".

5
.

The status bar sums up information regarding the currently shown search
results. Potential errors during the search, such as missing permissions,
will be shown in this panel as well.

6
.

The Quick Access Toolbar  is a customizable shortcut to many useful
functions of the TreeSize File Search.

7
.

The drive list panel  shows the currently selected drives and paths that
will be used as starting point for the search. By clicking the dropdown
button, or the panel itself, you can open the full drive list and select or
deselect additional search paths.

7.1.1 The Ribbon Bar

The Ribbon Bar provides access to all commands of the TreeSize File Search.
It is divided into the following logical sections, called "Tabs":

File Enables you to select folders to search in and load or save your
search results and search options.

Home Contains the most commonly used actions and elements of the
TreeSize File Search.

View Contains all actions and elements influencing the general
appearance of the search results.

Tools Contains useful functions and settings of the file search.

Help Provides common help features, version information, and
management functions for your product license

File
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Browse and add path
Shows a dialog which lets you select a directory.
The directory will be added to the list of drives and
paths TreeSize will search in .

Please note: Use "Home > Search paths" to see the
complete list of searched drives and paths.

Search settings
Allows to Save the current search options to an XML
file, load a previously exported options file, or to reset
the current settings to their factory default.

Export
Saves the results of the latest search to a
configurable file format.

Available file formats are "Text files (.txt)", "CSV files
(.csv)", "Microsoft Excel (.xlsx)", "Rich Text Format
(.rtf)", "HTML (.html)", "PDF (.pdf), and email.

List of paths
Exports a list of the full paths of your current search
results ("Export path list") or import a list ("Import
path list") in the format Text or CSV (mandatory).

Print list
Prints the currently visible result list or configure
printer settings.

Options
Opens the options dialog , which allows to change
the current search settings.

About
Shows version number and contact information.

Exit
Exits the TreeSize File Search.

107
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Home

Search

Start
Starts the file search.

Stop
Stops the file search.

Edit

Cut
Removes the selected items and copies them to the
clipboard.

Copy
Copies the selected files and folders to the
clipboard. To insert them in a new location, use the
"Paste" command.

Select all
Selects all items in the list. 

A drop-down menu provides access to the additional
button "Invert selection", which will invert the
selection state of all search results.

List Actions

Check all
Checks all items in the active result list.

Check if
Checks all items for which the full path matches
certain patterns in the currently visible result list.
You can configure the patterns in a new window.

Please note: The check state of other items will not
be changed by this function.

Invert checkstates
Checked items will be unchecked and vice versa.

Uncheck all
Unchecks all items in the active result list.

Uncheck if
Unchecks all items for which the full path matches
certain patterns in the currently visible result list.
You can configure the patterns in a new window.

Please note: The check state of other items will not
be changed by this function.

Remove invalid
elements

Through changes on the file system, such as the
manual deletion of files via Windows Explorer, it may
be possible that previously found duplicate search
results have become invalid. This function checks all
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currently shown elements and removes those that
cannot be found on the file system anymore.

Export

Export
Saves the results of the latest search to a
configurable file format.

Available file formats are "Text files (.txt)", "CSV files
(.csv)", "Microsoft Excel (.xlsx)", "Rich Text Format
(.rtf)", and "HTML (.html)", and "PDF (.pdf)".

You can also export a list of paths for the current
search results. This list can be imported back into
the file search at a later point in time, without having
to perform a potentially long running search again.
This also works for duplicate search, which will be
exported including their group structure, if the option
"General > Export > Export path list > Include
duplicate groups " is enabled.

Email
Sends an email that contains the current search
results.

File Operations

Delete items
Deletes all checked search results.

See "Move checked files ".

Move items
Moves all checked search results to a destination of
your choice.

See "Move checked files ".

Archive
Archives all checked search results in a ZIP file.

See "Move checked files ".

Pass to executable
Passes the full path of all checked search results via
command line to an executable of your choice.

See "Move checked files ".

Remame items
Opens the renamer dialog , which allows to
rename all checked items simultaneously, using
different rulesets which determine the new name of
the files and folders.

Search Options

Options
Opens the options dialog , which allows to change
the current search settings.

Customize filter
Allows to customize the set of filters  that can be
applied globally, to any of the search types. 
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View

Unit Select the size unit, in which file sizes will be
displayed:

Auto
Automatically selects the optimal unit.

TB
File sizes are displayed in Terabytes.

GB
File sizes are displayed in Gigabytes.

MB
File sizes are displayed in Megabytes.

KB
File sizes are displayed in Kilobytes.

B
File sizes are displayed in Bytes.

Formatting

Decimals
Determines the number of displayed decimals
places.

Date and time
Chose the date format that is used in the
TreeSize file search for columns like "Last
Access", "Last Change", or "Creation Date"
here. Available formats are date, date+time
(without seconds), and date+time (with
seconds).

Visible columns

Configure columns
Set the visible columns in the search result list. 

This menu provides a large set of columns that
can be enabled or disabled, as well as the
option to activate one of the "additional columns"
that are also available in Windows Explorer,
such as "number of pages", for MS Word
documents, width and height of pictures, and
many more.

Please note: Before exporting scan results we
recommend deactivating all columns you do not
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necessarily need in your export. This will
increase the performance of the export and
reduce the size of the export files.

Show or hide

Show tooltips
Enables long tool tips in the search result lists,
showing detailed information about the file or
directory your mouse cursor hovers over.

Preview pane
Toggles a panel to the right of the result list,
showing a preview of the first currently selected
file or directory.

Tools

Tools

Options
Opens the options dialog , which
allows to change the current search
settings.

Schedule current search
Opens a dialog enabling you to create a
scheduled Windows task for the current
search options.

The drop-down menu provides access to
the additional button "Manage scheduled
tasks", which allows you to edit
previously created TreeSize tasks.

See "Schedule Dialog ".

Start as Administrator
Restarts the TreeSize File Search and
requests admin privileges.

Please note: This button is available only
if TreeSize was started without
administrator privileges.

Create portable installation
Creates a portable instance of TreeSize
on a removable device

Empty recycle bin
Deletes all items in the recycle bin to free
up disk space.

60
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Help

Help

Show help
Opens the "File Search"-specific help file.

Show PDF manual
Open the product manual as PDF (optimized for
printing).

File Search F.A.Q.
Opens the "File Search"-specific F.A.Q. section
in the help file.

Version

About
Provides information about TreeSize.

Check for Update
Checks for a newer version of TreeSize.

What is new?
Shows the changes that were introduced with
each new version of TreeSize.

License

Extend maintenance
Extends the maintenance period. Updates and
support are free within the selected maintenance
period.

Please Note: For the trial version of TreeSize, the Ribbon group "License"
contains different controls:

Purchase full version
Navigates to the JAM Software website and
shows a list of all available license models.
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Change to full version
Helps you switch to the full version after
purchasing the software.

7.1.2 Defining search paths

Drives and Paths to search

The expandable drive overview enables you to define the drives and paths to
search in. In its non-expanded state, it shows all searchable drives and paths
that are selected for the current search. Additional paths can be browsed for,
by using the plus symbol.

When expanded, the panel shows a list of all available drives, as well as the
previously selected search paths, in a drop-down menu. Use the check boxes
in front of each drive to select which file system branches should be searched
by the file search. You can add additional paths and network drives using the
buttons below the list. The first button will enable you to type in a path, the
second one will open a folder browser dialog.

The file search supports the same scan targets  as the main module of
TreeSize, including WebDAV, Amazon S3, and SSH.

Hint: You can search entire servers or PCs by using their UNC name like \
\SERVER. You can search your entire domain by using its UNC name, e.g. \
\DOMAIN. You can even search you entire network by choosing the network
neighborhood of Windows in the directory browser appearing after pressing
Browse and Add Path. TreeSize automatically browses for PCs and all shares
on them (including hidden shares) and performs the search on all shares it
finds.

30
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7.2 Biggest files

Context tab: Biggest Files

Enables you to search for the biggest files in the selected drives and paths .
You can specify a minimum file size. All files larger than this value will be listed
in the search results.

Search for files bigger than... Specify the minimum file size.

Exclude Filter Allows to activate, deactivate or
customize the global exclude
filters  for this search.

Like in all searches, you can move all checked files in the result list to a
position in the file system that you can specify by using the Move Items
 function. The main module of TreeSize is also showing a list of the 100
largerst files .

7.3 Oldest files

Context tab: Oldest Files

This search type detects files or complete directory branches in the chosen
drives and paths  that have not been changed or accessed since a certain
date.

Search for files not [accessed / changed]
Select which time stamp should
be checked: the last access date
or the last change date.

since
Define here for how long a file
must have been not accessed /
changed to be shown in the result
list. 
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You can either use a certain date
or a number of days.

Return complete folders only
Activate this option to show entire
folders as search results. In this
case only folders will be listed for
which all included files and sub
folders in any depth were not
accessed / changed. 
This enables you to identify
branches of the file system that
are not in use anymore.

Exclude Filter Allows to activate, deactivate or
customize the global exclude
filters  for this search.

Please note: The Custom Search  offers more sophisticated filter options for
the timestamps of files.

Like in all searches, you can move all checked files in the result list to a
position in the file system that you can specify by using the Move Items
 function. 

7.4 Temporary files

Context tab: Temporary Files

Allows you to search for temporary files on the selected drives and paths . 

TreeSize defines temporary files as files matching certain patterns which are
specific for temporary files (e.g. "*.tmp"), and files with certain other properties
(e.g. temporary file attribute is set). If you want to customize the search
settings that are used for this search, click "Configure temp patterns":
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Patterns

The main part of the temporary file search is based on typical filename
patterns. You can customize these patterns using the button "Configure temp
patterns" in the ribbon menu. You may change or delete existing patterns as
well as add new patterns. Using the check boxes on the left, you can
deactivate certain patterns without deleting them.

Allowed wildcards for pattern building:

* Replaces none or any number of alphanumeric characters.

? Replaces exactly one alphanumeric character.

Other criteria which are common for temporary files (Selectable via
"Additional Settings"):

Include files with temporary attribute
Applications that create a
temporary file may inform the
operating system with a
special flag about this fact.
This flag is represented in the
"Attributes " column of
TreeSize and the Windows
Explorer ("T" = temporary file). 
If this checkbox is activated,
TreeSize will include such files
in the search results.

Include files that do not belong to a valid
account (slow)

If a Windows account is
deleted, files belonging to this
account are not deleted

44
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automatically and may keep
occupying space on the hard
disks. 
If this checkbox is activated,
TreeSize will include such files
in the search results. 

Please note: Since it is
necessary to query the owner
of each file on the searched
disks, activating this option will
slow down the scanning
process.

Include invalid shortcuts
If this checkbox is activated,
TreeSize will check for .LNK
and .PIF files, if the destination
path exists. If this is not the
case, such a file will be
included in the search results.

Include Shortcuts from Recent Documents
If activated, TreeSize will check
for shortcuts from the recent
documents folder and list them
in the search results.

Configure temp patterns
Shows a list of patterns that
are used to determine which
files are considered
"temporary". The list can be
fully customized.

Exclude Filter Allows to activate, deactivate or
customize the global exclude
filters  for this search.

Like in all searches, you can move all checked files in the result list to a
position in the file system that you can specify by using the Move Items
 function. 

7.5 Internet files

Context tab: Internet Files

136

128



112

TreeSize 
 
                                                                                                                                                                                                                                             ©1995-2020 by Joachim Marder e.K.

Using the TreeSize File Search

This search type enables you to search for temporary internet files like the files
in the cache of the browsers Internet Explorer, Firefox, Chrome, Opera, and
Netscape Navigator.

Include cookies Activate this option to search and list cookie files.

Exclude Filter Allows to activate, deactivate or customize the global
exclude filters  for this search.

Hint: The search for temporary internet files can be automated using the
command line option  /SEARCH:Internet.

Like in all searches, you can move all checked files in the result list to a
position in the file system that you can specify by using the Move Items
 function. 

7.6 Duplicate files

Context tab: Duplicate Files

Searches for duplicate files on the selected drives or shares . 
In this context, duplicate files are files which seem to exist more than once.
Such redundant files increase the allocated space of your disks unnecessarily.

A detailed step by step example of how to use the duplicate search can be
found here .

Check all
Checks all items in the active result list.

Check if
Checks all items for which the full path matches
certain patterns in the currently visible result list.
You can configure the patterns in a new window.

Please note: The check state of other items will
not be changed by this function.

Check all but newest
Check-marks all files of the selected duplicates,
except the newest file of each group.

The drop-down menu provides access to
additional options that allow to select which
duplicate files should be checked. The dropdown
also includes the option "Ensure one unchecked
file per group" .
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Uncheck all
Unchecks all items in the active result list.

Uncheck if
Unchecks  all items for which the full path matches
certain patterns in the currently visible result list.
You can configure the patterns in a new window.

Please note: The check state of other items will
not be changed by this function.

Remove invalid elements
Through changes on the file system, such as the
manual deletion of files via Windows Explorer, it
may be possible that previously found duplicate
search results have become invalid. This function
checks all currently shown elements and removes
those that cannot be found on the file system
anymore.

Deduplicate
This function will replace duplicate files with NTFS
hardlinks .

Please find a detailed description of this function
below .

Delete items
Delete all checked search results.

See "Move checked files ".

Move items
Move all checked search results to a destination of
your choice.

See "Move checked files ".

Comparison method:

Defines which criteria should be used to identify files as duplicates. Here is a
list of the available strategies: 

Size, Name and Date
Select this option to identify duplicate
files by looking for equal names, sizes
and last change dates.

This is much faster than using check
sums to indicate duplicates, but it is
also less accurate.

MD5 Checksum
When using MD5 checksums, a so
called hash value is calculated based
on the contents of each file. Files with
the same content will have the same
hash value, files with different content
will almost certainly have different
values.
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Empty files are ignored, since there is
no content to compare.

This is more accurate then comparing
files by their name, size and date but it
is also much slower.

SHA256 Checksum
This search option works like the MD5
checksum mechanism, but uses the
SHA256 algorithm instead of MD5.

While it is very unlikely that the MD5
hash algorithm produces the same
hash value for different files, the
SHA256 algorithm further reduces the
statistical risk of such hash collisions.
However, the SHA256 algorithm is
significantly slower than MD5.

Name only
Select this option to find all files with
equal file names. 

This is not really a strategy to identify
true duplicate files, but this compare
type may be helpful when you are
searching for certain redundancies or
undesired copies (e.g. documents
which have been copied and modified
locally).

Name without Extension
Select this option to detect files with
equal names, without regarding the file
extension.

This can be interesting in case you
are searching for duplicated backup
files or e.g. row-data and compact
image or video files ("MyPhoto.bmp" -
"MyPhoto.png").

Name and Size
Select this option to identify duplicate
files by looking for equal names and
sizes.

Equal to the very first compare
criteria, but without regarding the "last
modified" time stamp of the files. 
This is helpful in case files had been
moved from one location to another,
which might modify this time stamp.

Size only
Select this option to find all files with
equal size. 
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This is not really a strategy to identify
true duplicate files, but this compare
type may be helpful when you are
searching for certain redundancies or
undesired copies (e.g Copied MP3 or
Video files).

Search Filters:

Additional options to customize the duplicate file search:

Minimum Size
Defines the minimum size for files which are
subjected to the duplicates search.

Please note: Using a minimum size will reduce the
number of files to compare. This will increase the
speed of the search, especially when comparing by
checksums.

Unchanged since
Restricts the duplicates search to files that haven't
been changed recently. Similar to the size filter, this
can help to further optimize the search by reducing
the amount of files that have to be compared.

Ignore NTFS hardlinks
If checked, hardlinks will not be regarded as
duplicate files. You can find this setting in the
options dialog under "Duplicate File Search" >
"Filter" .

Please note: NTFS hardlinks  do not allocate any
space so you will not free up disk space by deleting
them. Also, TreeSize uses hardlinks for the
Deduplication .

Duplicate filter
This option allows you to restrict the duplicate
search to a specific preselection of files.
Depending on whether you define an exclude, or
include filter, all files that match these filter
patterns  will be excluded from, or restricted to in
the duplicate search.

By using this option, you can prevent listing files of
certain directories (e.g. your local system
directories) as duplicates. Additionally, this option
will reduce the number of files to compare and thus
lead to a performance increase.

Deduplicate:

Use this button to replace all but one checked duplicate files by NTFS hardlinks
to one file. This will reduce the disk space blocked by your duplicate files (See:
NTFS hardlinks ). However, this will not influence the disk space shown in
the "properties" dialog of the Windows Explorer (See: Deduplication FAQ ). If
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you check only one file of a group, this file is replaced by a link to the
"newest" (latest last change date) unchecked file of this group. 

Please note: You cannot use hardlinks to replace files located on different
hard drives.

In the configuration window you can select a log file to log the performed
replacements to. You can also define how TreeSize will handle files located on
different hard disks. You can either replace files located on the same hard disk
with hardlinks separately or simply select a reference drive and replace all files
located on other hard disks with symbolic links . Please note that in case the
permission to create symbolic links can not be granted, a Windows shortcut
(.LNK file) will be created instead as fallback.

The context menu of the duplicate files list offers a feature named "Replace
duplicates by hardlinks". This function works just like the "Deduplicate"
function, but will handle all selected files instead of checked files.

To use deduplication with hardlinks you need these NTFS permissions in all
affected folders: Read permissions, write permissions, create files, delete files

Important: Please note that TreeSize does not offer the functionality to "undo"
a deduplication! 
All hardlinks pointing to the same file share the same "Security
Description" (access permissions). Deduplication will apply a unified set of
permissions to the one physical remaining file. Undoing a deduplication
manually is very difficult.

Ensure one unchecked file per group:

Activate this option, if you want to ensure that one file per duplicate group
remains unchecked. This can be useful when using a custom selection

173
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mechanism, such as "Check if", to ensure that at least one of the duplicate
files will not be included in a move or delete operation.

7.7 How to set up a duplicate search

The duplicate search is part of the TreeSize File Search, which can be started
from the "Home " tab within the main module, or via the separate shortcut in
your Windows Start menu.

Step 1: Activate the duplicate search and select a search path:

To set up a duplicates search, first enable the checkbox "Duplicate Files" on
the left side. Use the panel above the search result list, to select the drive or
path that you want to search. You can find additional information about how to
set up a search path in this  chapter. It is also possible to search for
duplicates across multiple drives or paths.

Step 2: Select a comparison method and minimum file size:

The next step is to select the mechanism that should be used to compare files
with each other. You can compare the files by their Name only, or a
combination of Name, Size and Date. The most accurate method, however, is
the checksum. A duplicate search that uses file checksums is slower, but will
be much more accurate, since the actual content of the files is used for the
calculation. 

It is also recommended to define a minimum size for the search, so that small
files can be skipped quickly. Smaller files do not contribute much to the total
size on the drive, so their removal would not gain much space. Both these
options can be changed in the contextual ribbon "Duplicate Files ".

Step 3: Run the search:

Once you have configured all necessary parameters, you can run the search
and analyze the results. Each occurrence of a duplicate is arranged under a
group in the result list. 

The following screenshot shows an example configuration as mentioned above
and shows the results of the search:
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Step 4: Analyze the results and perform the cleanup operation:

Deduplicate:

The easiest way to gain disk space with the duplicate search is the
deduplication  feature. Just check the files that you want to deduplicate and
select "Deduplicate" from the ribbon menu. TreeSize will replace all but the
newest file with NTFS hardlinks . After the deduplication, the copies will no
longer allocate space on the drive.

Delete/Archive:

Another way to free up space is to delete the duplicate files from the disk. In
contrast to the deduplication, the duplicate files will be removed from disk
completely, there will be no leftover link to the original data. This also requires
you to manually select the files that should be removed. However, TreeSize
offers a variety of functions that helps you select only the duplicate files, so that
one "original" file will always remain.

In the ribbon menu for the duplicate search, you can find the category "List
actions", which provides functionality for checking "All but the ..." newest,
oldest, first or last file of each duplicate group. This allows you to select all files
of a duplicate group but leave one file unchecked (the one file that will not be
deleted). If you want to make a more customized selection, such as "only files
from drive G:\", you can use the "Check if" dialog to create a custom selection
pattern. To this end, it may also be useful to select "Ensure one unchecked file
per group". If this option is enabled, TreeSize will ensure that one file per
duplicate group remains unchecked under all circumstances. This prevents
cases, where all files of a group were checked accidentally, so that no original
file would be left over, after the delete operation.
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After checking the files that should be deleted, click "Delete items" in the ribbon
menu to trigger the deletion dialog , where you can select what operation
should be performed. You can either delete the files, or move them to a
different location. In both cases, you can create a log file of the operation,
which provides a summary of the operation and allows you to verify the results.

Finally, click "Execute" to start the operation.

7.8 Custom search

Context tab: Custom Search

The custom search is more customizable than any of the predefined searches.
It can combine different filter patterns with date, size, or even attribute filters. 

You can add multiple custom searches and assign different search criteria to
each of them. You can, for instance, create a custom search for audio files that
were are larger than a certain threshold, and another custom search for files
with paths that exceed a length of 255 characters. Each of these searches can
be activated and deactivated separately, so you can store a set of custom
searches where each serves a different purpose. The ribbon menu can be
used to create, rename, or delete custom searches, or to set up the general
parameters of the current search:

Export Saves the results of the latest search to a configurable file
format, such as "Text files (.txt)", "CSV files (.csv)", "Microsoft
Excel (.xlsx)", "Rich Text Format (.rtf)", and "HTML (.html)", and
"PDF (.pdf)".

Move items Moves all checked search results to a destination of your choice.

See "Move checked files ".

Rename
items

Opens the renamer dialog , which allows to rename all
checked items simultaneously, using different rulesets which
determine the new name of the files and folders.

New
Custom
Search

Creates a new custom search and adds it to the list of available
searches.

Rename
current
search

Allows to rename the current custom search. A descriptive
name may help distinguish between multiple searches, where
each serves a different purpose.
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Delete
current
search

Removes the currently selected custom search.

Include
Files/Folder
s

Determines whether the current search should search for files,
folders, or both.

Customize
File Type
Groups

Opens the options dialog and navigates to the "File Groups "
options page. Here, you can modify the different file groups and
which file types they should contain.

Exclude
Filter

Allows to activate, deactivate or customize the global exclude
filters  for this search.

The search allows you to configure your own search operation using a large
variety of search criteria across the different option tabs.

The search can be configured on the following tabs:

· Filter Patterns  (search for file name, file type, owner, or file content)

· Date  (search for file dates)
 

· Size / Attributes  (search for file sizes and attributes)
 

· Other Filters  (search with other filters)

Please note: The tabs of the custom search that have filters set (= influence
the search result) are marked by a green checkbox shown left of the tab's
caption.

Like in all searches, you can move all checked files in the result list to a
position in the file system that you specified via the Move Items  function.

7.8.1 Search for file name, owner, or file content

This tab enables you to define include or exclude patterns for files or folders
which should be found by the custom search.
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How to define a filter

To define a new filter, please follow these steps:

1. Click the "+" button in the "Add" column. A entry will be created in the filters
list for the new filter.

2. Decide whether this filter shall operate as an exclude or include filter
using the "Action" selector of the newly created entry. If, for examle, an
exclude filter for the pattern "*.exe" is set, TreeSize will not show any files
with the extension ".exe". An include filter, on the other hand, will make
TreeSize show only items that match this pattern: an include filter of "*.exe"
would result in showing only files that have the extension ".exe".

3. Define the actual pattern. You can either use simple wildcard pattern such
as "*.exe", regular expression patterns such as ".+\.exe$" or patterns that
match the whole name like "notepad.exe". Please make sure that you
select the pattern type you want to use in the "Type" column.

4. The "Match Against" column is used to specify the element/attribute
against which the pattern is compared. Patterns can be matched against
the file or folder names, (full) paths, owners, name the parent folder, name
of any parent folder, or any arbitrary meta data that the file provides. You
can use the owner filter, for example, to include or exclude certain file
owners from the TreeSize search results, supported are usernames and
SIDs. With the full paths or folder name filter you can include or exclude
complete directory branches matching a certain pattern (e.g. "*\Program
Files*"). File or folder name should be used when you intent to include or
exclude certain file extensions (e.g. "*.tmp"), like described in step 2).

Search for Meta data:

In addition to the predefined set of attributes that can be used to search for
files, TreeSize allows to use any of the available meta data, such as "Last
saved by" for office documents, or "tags" for JPG and Office files. Select
"Match Against > Other" to open a selection dialog with all available meta
data .

Wildcards allowed in Wildcard patterns:

* Replaces none or arbitrarily many alphanumeric characters.

? Replaces exactly one alphanumeric character.
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Not only names of files and folders are allowed, the patterns may also contain
parts of directories. Multiple patterns can be used by separating them using
semicolons.To force the exact match (instead of a substring match) of a
pattern, please select "whole name" in the Type column for this pattern.
Regular expressions  can also be used as patterns by selecting "RegEx" in
the Type column.

The following table shows possible patterns:

Pattern Match Against Type Result

*.doc File or Folder
Name

Wildcard Searches for all files with
the extension "doc".

*\Windows\Syste
m32\*.exe

Full Path Wildcard Searches for all
applications in the path
"Windows\System32".

"New Text
Document.txt"

File or Folder
Name

Whole
Name

Searches for all files
named "New Text
Document.txt".

[A-Za-z]:\\([ \̂\]+\\)
{2,4}[ \̂\]+$

Full Path RegEx Searches for all files on
drives with a directory
depth from at least 2 and at
most 4. 

admin* Owner Wildcard Searches for all files with a
file owner starting with
"admin..." (e.g.
"Administrator" or
"Administrators")

7.8.1.1 Search for file content

In addition to file name, fullpath, or owner, you can also search for files that
have a specific content. The TreeSize File Search can analyze the textual
content of a file and look for a given set of search terms. If TreeSize finds this
text inside of a file, the file is returned by the custom search. This is possible
for non-plain text file formats as well, such as PDF, Microsoft Excel or
Microsoft Word.
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To get started, create a new include filter as described here  and select
"Match Against" > "File Content" or "File Content (Case Insensitive). TreeSize
will match the content of all file candidates with the text that is defined under
"Pattern" and retrieve all files that contain this text.

Plain text and IFilter

TreeSize is able to search plain text files very quickly, by traversing them
directly on file system level and matching their content to the given search
term. All commonly used file encodings, such as ASCII, Unicode, or UTF-8 are
supported.

For more complex file types, such as Microsoft Word, Excel or PowerPoint,
TreeSize uses the IFilter interface, which is provided by the operating system.
Any application can register their own filter handler for a specific file type. Some
handlers are already shipped alongside with Windows. An example for such a
filter handler is the one that handles document types and allows to read the
content of files that are saved in the .docx format.

Other file types, such as PDF, can be read by filter handlers that are installed
by PDF reader applications. They are registered during the installation of the
PDF reader application and available for TreeSize automatically.

Case sensitivity

If you want to perform an exact search for a specific term, including the use of
capital and small letters, select the match target "File Content". 

If, however, you want to ignore case sensitivity during the search, you can
select "File Content (Case Insensitive)". With that option, TreeSize will analyze
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the file content while disregarding differences in capital or smaller case letters.
In order to do so, TreeSize  will use the code page associated with the
currently specified locale.

Searching for multiple terms

In some cases, it might be useful to search a file's content for multiple search
terms and return all results that contain at least one of these search terms. In
other cases, however, it might be preferable to return only files where all of the
search terms match. Both of these cases are possible with the file content
search.

In general, multiple include filters of the same type are combined via the "OR"
condition in the custom search. This means, that by simply creating multiple
"Include" filters, you can define a search that returns files where at least one
of the filters matches.

In order to combine them via "AND" condition and search for files where all
given search terms match, you have to use a specific syntax. The different
terms have to be encapsuled by paranthesis and need to be separated by a
semicolon. The general structure of such a pattern would be
{term1;term2;term3}.

For example: 

The pattern {quick;dog} will match:

· The quick brown fox jumps over the lazy dog

· This dog is quick

but will not match:

· The dog is lazy

· Foxes do get tired very quickly

7.8.2 Search for file dates

On this tab you can customize a search for files and folders by looking for their
last change, last access, or creation date timestamps. The searched time
period can be determined by defining an interval between two dates (between X
and Y) or by defining a duration relative to the current date (Since X days).

Changed / Not Changed Search for all files/folders (not) changed within
a certain period of time.
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Accessed / Not Accessed Search for all files/folders (not) accessed
within a certain period of time.

Created / Not Created Search for all files/folders (not) created within
a certain period of time.

Between X and Y Define a custom time interval, or a specific
start and end date that you want to limit your
search to.

Since X days Define a duration (measured in days) counting
back from today.

Defining a time period can be done by:

Selecting a time interval (relative to the current date):

· Predefined interval: The most commonly used intervals, such as "Last
week", "This month", "Last year", etc. are available as predefined options.
They are evaluated in relation to the current date when the search is
executed.

· Since X days/weeks/months/years: Select a custom time interval that must
have passed since the file/folder was (not) changed / (not) accessed / (not)
created.

Selecting a specific date manually:

· entering only a start date: the filters will only find files/folders with a matching
date past the selected date. The selection menu provides checkboxes, which
allow to enable, or disable the start and end date of an interval for the search.

· entering only an end date: the filters will only find files/folders with a matching
date before the selected date.

· entering a full interval: the filters will find only files/folders with a matching
date within these boundaries.

Please note: Selecting "Not Accessed/Changed/Created" will negate the
selection above. The file search will only return items with date values outside
of the specified interval.

Time picker

Searching for a specific file date can be customized even further by enabling
the option "Show time picker in custom search ". This allows to specify a
time values in addition to the dates when searching for files within a given time
frame.

7.8.3 Search for file sizes and attributes

This tab enables you to customize a search for files or folders of a certain size
and/or with certain file attributes.
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Minimum Size Sets the minimum file size of wanted files.
The associated combo-box determines the
size unit of the numerical specification.

Maximum Size Sets the maximum file size of wanted files.
The associated combo-box determines the
size unit of the numerical specification.

Attributes

Include Files
Decide here if you want to search for files...

Include Folders
... or for folders/directories.

Please note: You can activate both options to
search for files and folders. At least one of
these options has to be activated.

You can also toggle searches for the following file attributes:

Readonly Looks for the "read only" attribute in
files/folders.

Hidden Looks for the "hidden" attribute in files/folders.

System Looks for the "system" attribute in files/folders.

Archive Looks for the "archive" attribute in files/folders.

Compressed Looks for the "compressed " attribute in
files/folders.

Sparse Looks for the "sparse " attribute in
files/folders.

Encrypted Looks for the "encrypted" attribute in
files/folders.

Offline Looks for the "offline" attribute in files/folders.

Temporary Looks for the "temporary" attribute in
files/folders.
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Alternate Data Streams Lists only files/folders that have (do not have)
NTFS Alternate Data Streams  included.

Reparse / Mount Points Lists only files/folders that are (not) flagged as
reparse points or mount points .

7.8.4 Search with other filters

On this tab you can configure several search filters.

Minimum/Maximum directory level
TreeSize will only search for files that
are located within the specified
minimum or maximum directory level.

Use directory level [in the file
system/relative to search path]

Determines whether the directory level
should be evaluated relative to the
current search path , or as absolute
level within the file system.

For example: 

(Use directory level relative to search
path:)

Level 1: Items that are direct children of
the current search path.

Level 2: Items within the first level of
subfolders of the current search path.

(Use directory level in the file system:)

Level 1: Direct children of the current
drive (e.g. "C:\file.txt").

Level 2: Items that have one parent
folder (e.g. "C:\Users\anotherfile.txt".

etc.

Ignore NTFS hardlinks
If checked, no NTFS hardlinks  will be
listed in the search results.

Minimum Number of hardlinks
Use this option to find files with a
minimum number of NTFS hardlinks .
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Full Path longer than X characters
Sets the minimum size a file's path has
to have to be included in the search.

7.9 Move checked files

This function enables you to move all checked files and folders in the search
result lists to a destination of your choice, archive them in a ZIP file, delete
them, or process the files. This function is accessible at "Home > Move
items ".

Additional options enable you to configure the file system operations to suit
your needs. In this section all available operations and options are listed and
described.
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Move Operations:

Move checked
items to
Recycle Bin

Moves all checked files directly to the Recycle Bin. To delete
these files completely, you have to empty the Recycle Bin.

Delete
checked
items from
disk

Deletes all checked files (a security prompt has to be
confirmed).

Move checked
items to ZIP
file

Moves checked files to a ZIP file you specify in the edit field
bellow. ZIP files containing Unicode paths can only be
unzipped properly by Unicode-compatible ZIP tools like
WinRAR, WinZip, or 7-Zip (see: "Unicode Zip files ").

Move checked
items to path
or burn to disc

Moves all checked files to the path you specify in the edit field
bellow or burns them to an optical medium. The original
directory structure can be preserved in the destination path.
The security attributes can be copied as well. If this option is
not selected, the moved files will inherit the security attributes
from the parent elements. You can choose to leave shortcuts
or links at the original position (read more below).

Copy checked
items to path
or burn to disc

Copies all checked files to the path you specify in the edit field
bellow or burns them to an optical medium. The original
directory structure can be preserved in the destination path.
The security attributes can be copied as well. If this option is
not selected, the copied files will inherit the security attributes
from the parent elements.

Pass items to
executable as
parameter

An executable file will be called for every checked file and the
full path of the file will be passed as parameter on the
command line. The executable file may also be a batch, a
PowerShell script or VBScript file (or something similar). The
Windows Scripting FileSystemObject offers powerful and
easy-to-use capabilities for file system and path operations.
Please find an eaxmaple for the use of a PowerShell Script
below.

Move Options:

Skip/Rename/
Replace
existing files

Configure how TreeSize will handle name collisions in the
move destination, in case a file with the same name already
exists. You can skip the existing files, replace them by the new
one, or rename the existing files.

Please note: Only available for "Zip" and "Move to path"
operation. Not supported when burning to an optical medium.
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Delete empty
directories
after the
operation

Deletes all folders that have been emptied due to this move
operation.

Preserve
directory
structure

If this option is activated, the file system structure will be kept
at the destination. If this option is unchecked, all files will be
moved into one folder.

Please note: Only available for "Zip", "Move", and "Copy"
operation.

Include
directory with
drive letter to
avoid name
collisions

Indicates if a directory named like the source drive should be
included in the destination path. Activate this option to avoid
name collisions when moving files form several drives.

Please note: Only available for "Zip" operation.

Leave out
directories up
to level x

Use this option to configure the level of parent directories to
preserve. The first x parent directories will not be included in
the destination path.

For example, when moving a file "C:\Users\Smith\My
Document.doc" to destination "D:\Obsolete Files" you will get
the following results: 
x = 0 > "D:\Obsolete Files\C\Users\Smith\My Document.doc"
x = 1 > "D:\Obsolete Files\Users\Smith\My Document.doc"
x = 2 > "D:\Obsolete Files\Smith\My Document.doc"

Please note: Only available for "Move" and "Copy" operation.

Preserve
permissions
of the original
items

If this option is activated, the permissions of the original file will
be used for the file in the new location.

Please note: Only available for "Move" and "Copy" operation.
Not supported when burning to an optical medium.

Leave
shortcut/link
at original
location
pointing to
new location

If this option is activated, a shortcut or link will be created at the
original location pointing to the location the file has been moved
to. If you choose to leave a link and the files are on the same
partition, an NTFS hardlink  will be created. If the creation of
a hardlink is not possible, a symbolic link is used (Windows
Vista and later). If a symbolic link cannot be created, a
Windows shortcut will be used as a fallback.

Please note: Only available for "Move" operation.

Logging:

Number of
checked
items

Displays the total number of checked objects.
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Total size of
checked
items

Displays the total size of all checked files. 

Log
performed
operations to:

Produces a log file with a name of your choice under the path
of your choice. Environment variables like %DATE% or %TIME
% can be used in the file name.

Create Undo
script

Creates a batch file which can be run after the operation was
finished to undo the changes applied during this operation.

Please note: Only available for "Move" and "Copy" operation.
Not supported when burning to an optical medium.

PowerShell Scripts using the example of SharePoint

We would like to show you in a practical example the use of a PowerShell
script with the TreeSize File Search. The task is to prepare thousands of
documents for uploading them to a SharePoint server. The problem is that
certain characters are not allowed in filenames on SharePoint, that are valid in
the normal file system and that are commonly used. Using a regular
expression, which you can find in the chapter Regular Expressions , it is
easy to find all files that violate the SharePoint naming rules. When the search
is finished, please choose in the dialog to move the checked files to pass them
to an executable. As executable please choose this PowerShell script, which
you have previously save e.g. as  "SharePointRename.ps1":

Param([string]$filepath="")

[char[]]$illegal = "~", "#", "%", "&", "*", "{", "}", "\", ":", "<", ">",
"?", "/", "|"

$replacement = "-"

$filepathNew = [io.path]::GetFileName($filepath)

foreach($char in $illegal){$filepathNew = $filepathNew.Replace($char,
$replacement)}

Rename-Item $filepath $filepathNew 

The script can be easily adapted or extended for further use cases.

Logging

Tip: Logging your move, archive, or delete operations provides an clarity and
improves security for your system maintenance and is highly recommended.

The log produced by TreeSize shows all the necessary details to trace a
maintenance act. The file will be saved in plain text format. A typical log file
looks like this :

Starting file operation at 28.08.13 16:46.

Moving the following objects to "C:\Obsolete":

"D:\Data\BGInfo.bmp" => "C:\Obsolete\D\Data\BGInfo.bmp"

"D:\Data\readme.txt" => "C:\Obsolete\D\Data\readme.txt"
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"D:\Data\Help\article.chm" => "C:\Obsolete\D\Data\Help\article.chm"

Finished file operation at 28.08.13 16:46.

Affected objects: 3 | Failed objects: 0 | Invalid objects: 0

Freed Space: 114170 Bytes (111 KB)

7.9.1 Unicode Zip files

TreeSize is able to zip files with file names including characters which are not
part of your activated code page (Unicode file names). To restore this Unicode-
decoded Zip files you will need an Zip tool able to handle Unicode encoding.

Here is a list of tools we have tested for Unicode compatibility:

· WinRAR (V3.8 or higher)

· WinZip (V11.2 or higher)

· 7-Zip (V4.6 or higher)

· PeaZip (V5.1 or higher)

· BitZipper (V2013.13.4.16 or higher)

· IZArc (V4.1.8.2988 or higher)

· Windows integrated Zip tool (Windows 8 / Server 2012 or later)

Please note that the integrated Zip tools of Windows Vista, Windows 7,
Windows Server 2003, and Windows Server 2008 are NOT Unicode
compatible.

7.10 Bulk rename

This dialog allows renaming multiple files at once, using one of several types of
rules. This function can be accessed via "Details > Bulk Rename " in the
main module, or "Home > Bulk Rename " in the file search.

To define a new renaming rule, select the desired options on the left hand side
of this dialog and then select "Add Rule". The section "Available Rules "
shows all rules that have previously been created. Each rule can be activated
or deactivated individually and will be applied in the order that they are
displayed in. You can reorder existing rulesets by simply dragging and dropping
them within the list of available rules.
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The right hand side show a preview  of the current ruleset. It shows the file
names before and after the rename operation and provides a quick overview of
whether or not the filename will change or remain the same after the operation.

Select Renaming Rule

Defines what type of renaming should be applied. TreeSize supports a variety
of renaming types, ranging from a simple "Search & Replace" to a fully
customizable "Serialize" function that allows to include a uniform numbering
scheme to the selected file names. The following rule types are supported:

Repl
ace

A simple search and replace operation for file names. Under
"Configuration", you can enter the search term to search and what to
replace it with. Activate the option "Use Regular Expression", if the input
term should be interpreted as a regular expression, instead of an exact
match. Further information about regular expressions can be found
here .

Inse
rt

Inserts the given text to the file name at the position that is defined under
"Configuration". The text can be appended as prefix, as suffix, or at a
specific position.

Seri
alize

Adds a number to the files, starting with the value that is defined under
"Configuration". The number can be added as prefix, as suffix, or at a
specific position. It is also possible to unify the numbering to a minimum
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length. Check the option "Pad to length", in order fill up numbers with
leading "0"s and ensure a unified length.

Dele
te

The delete rule has two options: Search and removes a certain text, or
delete text at a certain position within the target file names. "Delete text"
will remove all occurrences of a given search term. "Delete from
position" will remove text at a given position within the target file names.
Use "Length" to define how many characters should be removed.

The selection "Filename", "Extension only", "Filename + Extension"
determines which part of the file name should be affected by the rename
operation. This selection can be configured for each rule individually.

Available Rules

This list shows all previously created renaming rules. The rename operation
will be applied in the order of this list. To change the order that the rules are
applied in, simply drag and drop the rules to their designated position within the
renaming chain. You can also use the right click menu to move the current
selection up, or down in the list. 

Existing rules can be temporarily disabled via the left hand checkboxes. Only
active rules will be regarded in the actual renaming operation.

Preview

This panel shows a preview of the rename operation with the current selection
of active renaming rules. The column "Name" shows the original file name,
while "New Name" shows a preview of the names as they would be after the
rename operation. The "Change" column shows at one glance which names
will change and which will remain the same. The column "Success" will show
whether or not the renaming of a file was successful, after the operation has
finished. If a file could not be renamed successfully, e.g. due to missing
permissions, it will be shown in this column.

Execute

Starts the actual rename operation. All active rules will be applied to the files on
the right hand side, one after another. Once the operation has finished, the
status is shown in the column "Success" of the preview list. 

Undo

Reverts the last renaming operation back to its previous state. This effectively
means that another rename operation is triggered that renames the files back
to their original name.
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7.11 Options Dialog

Using the Options dialog you can adjust various settings which affect the
appearance, the search behavior, the export and the start of the TreeSize File
Search.

These are the available options pages:

General

Search Engine General settings influencing the search
behaviour of TreeSize File Search.

Exclude Filter Define filtering options for TreeSize File
Search.

View General settings influencing the
appearance for the search results of
TreeSize File Search.

Export Configure options for export generation of 
TreeSize File Search.

Email Customize email settings for   TreeSize
File Search.

Start Define start parameters for  TreeSize File
Search.

File Groups Defines the available file groups and which
file types should be assigned to which
group.

Duplicate Search

Filter Configure specific settings just for the
Duplicates Search.

7.11.1 General Options

· Search Engine

· Exclude Filter

· View

· Export

· Email

· Start
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· File Groups

7.11.1.1 Search Engine

Follow mount points and external symbolic links to directories

You can decide if TreeSize should follow symbolic links and mount points (see
Notes on NTFS  for additional information) that point to other drives or folders
on other drives. Links that point within the scanned directory will never be
followed in order to prevent circular references and folders from being counted
twice.

Skip offline files in searches that access file content

Certain search types, such as the duplicates search via MD5-checksum, or
the custom search for file content, accesses the content of a file. This would
trigger the download of offline files, which is not intended in most cases.
Activate this option, to prevent this.

Select whether a comparison against file sizes will regard the normal file size
or the size on disk.

You can decide if the file size or the allocated size (size on disk) will be used
when for example minimum or maximum values are set for file size search
criteria.

7.11.1.2 Exclude Filter

Global Exclude Filter

The file search was designed to identify obsolete or very large files in order to
clean up a system. Certain files like system files, however, should not be
deleted because they are needed by the operating system or other software.
Files known to be important for a system can be added to the exclude list here
and will then not be shown in the results any more. 

This option allows you to define exclude patterns which will be used when
searching for files . Each file/ folder will be compared against the patterns
and,if matching, not listed in the result list.

An exclude pattern can be a complete folder or share as well as an regular
expression pattern. 
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Additionally, you can exclude files that have been changed in the past hours. If
a file has been changed recently, there is a high probability that the file is not
truly obsolete.

Please note: This option will NOT be applied to the duplicate file search
and to the custom search  by default. However, you can enable it by
activating the corresponding option ("Use global exclude filter") for these
searches.

Apply global search filter to the following search types 

Via these check boxes you can quickly select for which of the predefined
search type the currently defined search options are valid. By default the
custom search type is excluded here so the user each time decides in the
search mask what criteria shall apply for the custom search.

How to define an exclude filter

To define a new filter, please follow these steps:

1. Click the "Add pattern" button. An entry will be created in the filters list for the
new filter.
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2. An exclude filter for the pattern "*.exe" for example will make TreeSize to not
show any files with the extension ".exe". 

3. Define the actual pattern. You can either use simple Wildcard pattern such
as "*.exe", Regular Expression patterns such as ".+\.exe$", or patterns
that match full names like "notepad.exe". Please make sure that you select
the matching pattern type on the "Type" selector on the right side of the
window.

4. The "Match Against" selector is used to specify the element/attribute against
which the pattern is compared. Patterns can either be matched against file
names, (full) paths, owners, folder names, or object names. You can use
the "owner" filter to, for example, include or exclude certain file owners from
the TreeSize scan results. With the "full paths" or "folder name" filter you
can exclude complete directory branches matching a certain pattern (e.g.
"*\Program Files*"). The "file name" filter should be used when you intend to
exclude certain file extensions (e.g. "*.tmp"), like described in step 2.

Hint: New files or folders can also be easily added to this list using the right-
click menu of the result lists ("Add to exclude list").

Remove pattern

Deletes the currently selected pattern row.

Preview the results

The "Preview" button enables you to view the results of a defined search
pattern. The preview will use the currently selected pattern to show an
Explorer-like view highlighting excluded items.

Additional Filter Settings

Exclude files and folders created in the past ... hours

If this option is set, only files and folders which have been created earlier than
the specified amount of hours will be scanned. This can be useful to calculate
the size of backups or to identify "heavy growing" folders. A value of "0" means
that all files will be included (default). 

7.11.1.3 View

File and Folder Options

Determine icons based on file extension

If this option is set , you will see the default icon for a file of this extension type
in the search result list.

Show compress files/folder in blue
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If this option is set, NTFS compressed files/folder will appear in blue color in
the search result list.

Check results by default

If this boxed is checked, all results in the list will be automatically checked so
processing additional steps (like Export, Move items,etc) can be performed
with one click.

Show long tooltips

If this option is active, a tooltip window with detailed information will be shown if
the mouse cursor hovers over a file or folder for a while.

Show time picker in custom search

When searching for files with a specific date, you might want to further
customize the search and look for files that were modified/accessed/created at
a specific time. Enable this option to show time pickers, in addition to the date
selection, in the custom search .

Language

Use language
Select the language that is used for TreeSize's user interface.

Date/Time Format

Use the following date/time format, e.g. for "Last Access":

The date/time format that is used by TreeSize in related columns like "Last
Access", "Last Change", or "Creation Date" can be defined here. Available
formats are date, date+time (without seconds), and date+time (with seconds).
Please note that in some rare cases TreeSize may display "wrong" date/time
format. For more information on this issue, please refer to this article from our
Knowledge Base.

Username Format

Format for the username appearance if displayed in search result list or export
files.

Either just the username is displayed or user name including the related Active
Directory domain where user belongs to.

Notifications

Notify, when the search has finished

If this option is enabled, TreeSize will play a notification sound, when the
search has finished. If TreeSize is minimized, when the search finishes, it will
also show a notification in the Windows notification center, which includes a
summary of the search that was just performed and the results that were
found (Only supported in Windows 8 and higher).
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7.11.1.4 Export

Header information

You can specify the amount of additional header information that is included in
exports of the file search. 

Add summary information

Activate this option to include a short summary of the search into the export.
This summary contains the path(s) that were processed, the date/time of the
search, and the number and size of files and folders that were found.

Add column headers

If this option is set, TreeSize will include a row that displays the names of the
columns, in addition to the actual search results.

Include units in export

If this options is activated, units like "KB", "MB", or "%" will be included in the
exported data. Uncheck this option, if you want to export plain values.

Export path list

Include duplicate groups

This option allows the export of duplicate search results via "File > List of paths
> Export path list". If this option is enabled, TreeSize will include the group
structure of the duplicate search, when generating a list of files. This allows
importing a previously performed duplicate search, without the need to perform
the search again.

7.11.1.5 Email

Configure email settings for TreeSize File Search.

Email content

To

The email address the report will be sent to.

Subject

The subject of the email. Supports environment variables such as %DATE%,
%TIME% or %USERNAME%. 

Format

Choose an email format here.

Transport

Use MAPI client
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If this setting is checked, TreeSize will use the local MAPI client (for example
Microsoft Outlook) for sending mails.

Use SMTP server

TreeSize will use the specified SMTP server to send email reports. Please
make sure to test the connection settings before applying the current options.
Please note that you will have to enter valid SMTP settings in order to make
use of email reports in scheduled scan or search tasks  or all other kinds of
automated starts (e.g. batch programs or command line calls) (Professional
Edition only).

From

The email address that will be shown as the sender of the report.

Server

The name (DNS) or IP address of the machine hosting the SMTP
service through which messages are to be sent.

Port

The port on which the SMTP service specified in the "Server" field is
listening for connections.

Use secure (SSL) connection

Indicates that Secure Sockets Layer (SSL) should be used when
sending messages via SMTP.

This server requires authentication

Select this option if SMTP service specified by the Server field requires
authentication. Passwords will be encrypted before storing them in the
TreeSize settings file.

Test Connection

Test the SMTP connection settings. This will send a test email to the
email address specified in the "To" field.

Exported lists

Active list / all lists

Select which search result lists shall be included in the email : only the
currently active search types or all search types.

Exported elements

Checked items / all items in the list

Select here, if you want to have just the checked/marked result list entries or all
entries from the result list included in the email report.
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7.11.1.6 Start

Modify startup settings for TreeSize File Search

Start As Administrator

Always start this application as administrator

When activated, TreeSize will always start with administrator privileges. This
will trigger the UAC (User Access Control) prompt, if UAC is enabled.

Action at Application Start

Load last search settings.

Open file search with the last used settings. Does not start a search
automatically.

Run a search using the last load search settings.

Open file search with the last used settings and automatically start a search
with these settings.

Run a search using the the following saved search settings.

Start File Search and directly run a search based on previously saved search
settings. The XML file containing these settings must be specified here, either
by typing the path into the edit field or via browsing in Windows Explorer after
clicking the folder button.

Explorer Context Menu

Show TreeSize File Search in Windows Explorer context menu of current user

Select whether the TreeSize File Search should appear in the context menu of
folders in the Windows Explorer.

7.11.1.7 File Groups

This page allows to modify the different file type groups that are available in the
file search and which file extensions should be assigned to which of the
different groups. Each of these groups can be used as a search pattern  in
the custom search. The input field "Pattern" can be used as a dropdown, to
select one of the available file type groups. 

More information, about how to customize these groups, can be found in the
chapter "File Groups " for the main module of TreeSize. Both the file search
and the main module share the same file type groups, so any information that
you may have gathered with the help of the Extensions  view can be further
analyzed with the appropriate file search filter.
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7.11.2 Duplicate File Search

7.11.2.1 Filter

Define filtering options explicitly for TreeSize Duplicate File Search here.

Define a filter (exclude or include)

To define a new filter, please follow these steps:

1. Click the "Add pattern" button. An entry will be created in the filters list for the
new filter.

2. Decide whether this filter shall operate as an exclude or include filter
using the "Action" selector of the newly created entry. An exclude filter for
the pattern "*.exe" for example will make TreeSize to not show any files with
the extension ".exe". This will also affect the calculated values such as the
"Size" in the Directory Tree  as well as any other view . An include filter,
on the other hand, will make TreeSize show only items that match this
pattern. To return to the previous example, an include filter of "*.exe" would
result in a Directory Tree showing only data related to files that have the
extension ".exe".

3. Define the actual pattern. You can either use simple Wildcard pattern such
as "*.exe", Regular Expression patterns such as ".+\.exe$", or patterns
that match full names like "notepad.exe". Please make sure that you select
the matching pattern type on the "Type" selector on the right side of the
window.

4. The "Match Against" selector is used to specify the element/attribute against
which the pattern is compared. Patterns can either be matched against file
names, (full) paths, owners, folder names, or object names. You can use
the "owner" filter to, for example, include or exclude certain file owners from
the TreeSize scan results. With the "full paths" or "folder name" filter you
can include or exclude complete directory branches matching a certain
pattern (e.g. "*\Program Files*"). The "file name" filter should be used when
you intend to include or exclude certain file extensions (e.g. "*.tmp"), like
described in step 2.

Preview the results

The "Preview" button enables you to view the results of a defined search
pattern. The preview will use the currently selected pattern to show an
Explorer-like view highlighting excluded and included items in appropriate
colors (red and green). The following screenshot shows the results of an
exclude filter for full paths that match the pattern "C:\temp".

31 34
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Additional Filters

Ignore NTFS hardlinks

Ist diese Option aktiviert, werden Hardlinks nicht als Datei-Duplikate betrachtet.

Hinweis: NTFS Hardlinks  allokieren keinen Speicher. Deshalb wird durch
ihre Löschung kein zusätzlicher Speicher verfügbar gemacht. Darüber hinaus
verwendet TreeSize Hardlinks für die Deduplizierung .

Exclude offline files

Files with the attribute "offline" will be excluded from the search. Offline files are
often not physically present on the disk or are only cached temporarily on the
local disk. During the duplicates search, TreeSize will calculate the checksum
of a file, using the file content. Accessing the file content would restore cached
files, which might be undesirable. With this option, you can prevent the
duplicate search from accessing these files.

8 Using Scheduled TreeSize Tasks

This section is related to the Professional Edition of TreeSize only, since the
Personal Edition does not offer scheduling or command line options!

Keeping your storage in a "clean" state is an ongoing task and requires a
consistent overview of the usage. In a real world scenario it is important to find
space hogs that use up large portions of the disk as soon as possible.
Therefore you might want to use TreeSize to scan your storages regularly after
a certain period of usage. Rather than having to do this manually every time,
TreeSize offers a functionality to create tasks that automatically run according
to a predefined schedule. This allows you to perform scans, send reports or
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perform any customized action that you can define freely at any time of the
day. Defining a new task can be done by using the Schedule Dialog . 

The dialog allows you to choose one ore multiple paths to scan and allows a
variety of ways to export the results of the scan.

All settings that are defined here will be applied to the scan task automatically.
TreeSize will assign the corresponding Command Line Options  to the new
task and reapply them to the user interface when you want to edit an existing
task at a later point in time.

8.1 Schedule Dialog

It is possible to schedule tasks using the "scheduled tasks" folder of
Windows. This dialog will help you create a scheduled TreeSize Professional
task with the corresponding command line options. 

Please note: This feature is only available in the Professional Edition.

Open the dialog by clicking on "Scan > Schedule this scan " from within the
TreeSize Professional main application or on "Tools > Schedule current
search " from the TreeSize Professional File Search.
The TreeSize tasks can be configured, viewed, and edited using the following
tabs:

Current Task

Options Contains general options, such as the scan
path, sorting, or filter that you want to apply to
your scan results.

Export Allows to define which in which formats you
want to export your reports in this task.

Move Operation
(TreeSize File Search
only)

Search results can be moved automatically by
this task. This option can be enabled and
configured here.

Advanced Provides advanced customization possibilities,
such as a custom title for the export, or a
different list separator.

Command Line A preview of the command line parameters that
will be used for this task. In this page, you can
test the current settings, copy the parameters
to the clipboard, or save them to a batch file.

Schedule Here you can set up a date and time when the
task should be executed.

All Tasks
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List of Tasks Shows a list of all TreeSize tasks that were
created in the past.

Use the "Save Task" button to save your configurations in a new Windows
scheduled task.

8.1.1 Options Tab

You can specify further options for the scan and the exported results here.

Path(s) to scan
Enter the path or multiple paths to be scanned here. 
Please note: Multiple paths have to be quoted using
double quotes (") and have to be separated by a blank.

Options file
Use this option to apply previously exported user
settings to the current operation. User settings of the
main application can be exported using "File > Options
> Export "; settings of the TreeSize File Search can
be exported through "File > Save search options ".

155

18

100



147

TreeSize 
 
                                                                                                                                                                                                                                             ©1995-2020 by Joachim Marder e.K.

Using Scheduled TreeSize Tasks

Export Options

Sort By
Choose a view type  to sort the export reports by.
Select "Last used in user interface" to use the view
type configured when TreeSize was used the last time.

In addition to the list of columns that are selectable,
you can also manually enter the name of any other
column, such as "Owner", by using the free text input.

Size Unit
Specify the unit size values will be displayed in. Select
"Last used in user interface" to use the size unit
configured when TreeSize was used the last time.

Include units in export
If this option is check-marked, units of measurement
like "KB", "MB", or "%" will be included in the exported
data. Uncheck this option if you would like plain
number values to be exported. Without units, the
thousands separators will also be omitted, thus
simplifying further processing of the exported data.

Expand
Specify how many levels in the directory tree will be
expanded after scanning. If you select "Full", all folders
will be expanded. Instead of a directory level you can
also indicate a minimum folder size. In this case, all
folders larger than the specified amount will be
expanded.

Filter

Include single files
Activate this option to ensure that single files are
included in exports of this scheduled scan.

Hide elements smaller
than

Defines a minimum size for small files and folders.
Only elements that exceed this value will be shown in
the export.

Exclude following file
types

Specify patterns for files and folders to be excluded
from a scan.

Include only following
file types

Enter a file pattern filter here. Only files matching
certain patterns (e.g. *.MP3 or *.DOC) will be included
in the scan.

Include only files with
archive attribute set

This option will include only files in the scans for which
the Windows archive bit was set. This option can be
very useful if you want to calculate the size of a backup
based on the Windows archive bit for a certain
directory.
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8.1.2 Export Tab

Here you can select which of the export options supported by  TreeSize
Professional will be used for the scan.

Directory Tree Export

Excel file
Exports the collected data to Excel and saves it under
the selected file name.

Generate
expandable/collapsible
Excel report

Activate this option to create an interactive Excel
report, where each directory can be expanded and
collapsed separately.

Automatically
generated sheet name
(including date and
time)

The new Excel sheet will be automatically named in an
informative way, including date and time information in
the sheet name.

Sheet name
Enter a sheet name here.

Please note: If the sheet name is not unique in the
selected Excel file and you check-marked "Append to



149

TreeSize 
 
                                                                                                                                                                                                                                             ©1995-2020 by Joachim Marder e.K.

Using Scheduled TreeSize Tasks

existing file", the new export will be appended to the
existing sheet. If "Append to existing file" is unchecked,
a suffix will be added to the sheet name to make it
unique."

HTML file
Saves the collected data to a HTML file which can be
viewed with any HTML browser.

Text file
Saves the results to a text or CSV file after the scan or
search operation is finished.

XML file
Saves the results to a XML file. The file may be loaded
at a later date and can be used for comparisons (See:
"Compare with saved scan ").

PDF file
Saves the results to a PDF file after the scan or
search operation is finished.

Print report
Prints a report for the scanned directory branch on the
default printer. 
Choose "First page only" to print only the first page of a
report or "All pages" to print all pages.

Send email
Sends an email with the chosen exports to the
recipients specified here.
Note: Multiple email addresses have to be separated
by a semicolon (;).

Attach generated files
to email

Activate this option to attach all generated report files
to this email.

Send email only if
results were found

(File Search only) With this option,  TreeSize will only
send an email if at least one result has been found by
either of the activated file searches.

Right Pane Export

Top 100 files
This option allows you to save the "Top 100 Files "
of the scanned file system branch to an Excel, CSV, or
text file.

Statistics on file types
This option allows you to save the "Extensions "
statistic of the scanned file system branch to an Excel,
CSV, or text file.

Statistics on user
names

This option allows you to save the "Users " statistic
of the scanned file system branch to an Excel, CSV, or
text file.

Charts to include
Saves the Pie-, Bar-, Age of Files-, History-,
Extensions-, Users-, or Tree Map chart of the scanned
directory to a bitmap, GIF, JPEG, or PNG file. The file
type depends on the extension of the specified file
name.
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Charts to include

Saves the Pie-, Bar-, Age of Files-, History-, Extensions-, Users-, or Tree Map
chart of the scanned directory to a bitmap, GIF, JPEG, or PNG file. The file type
depends on the extension of the specified file name.

Please Note: Some of the statistics can additionally be exported in a text
format, such as CSV.

General Options

Append to existing file
Activate this option to append the selected exports to
existing files. to run scans regularly every night or
every weekend.

Add date and time to
filenames

This option will add the current date and time to all
exported file names.

8.1.3 Move Operation Tab

Here you can configure move operations to be performed automatically after
the TreeSize File Search has finished.
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Move search results
Configure move operations to be performed with the
results of a TreeSize File Search. The options are
comparable to the options of the "Move Checked
Files " operation.

You can find the additional information about the
creation of scheduled move operations in this
chapter.

Please note: This option will perform changes on your
file system. These changes cannot be reverted
automatically. Please use with caution!

8.1.4 Advanced Tab

Here you can specify advanced options for the scan and the exported results.

Advanced Settings

Start without user
interface

No window will be shown and the application will not
appear in the task bar. Useful for background scans.

Title for this report
Can be used to change the title of the printed or
exported report. The use of environment variables is

128
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allowed.

Compare with a saved
report

Compares the scanned path with a saved XML report.
The exports you configured on the "Export " tab will
show the differences of the current file system
compared with the saved XML report.

Empty recycle bin
If this option is active, TreeSize will automatically
empty the recycle bin of the current user before any
other operation is executed.

Group scans in a
Virtual Root Folder

Using this option will group all scanned directories
under a "virtual root folder", corresponding to the option
"View > Group scans " from the main user interface.
See topic Directory Tree  for more information.

List separator
Configure the separator to be used for text and CSV
exports here.
Select "Default" to use the most suitable separator for
the selected export type (tabulator for text files, list
separator from the systems regional settings for CSV
files).

Custom command line parameters

This input field allows to add custom command line parameters . TreeSize
supports a variety of command line parameters , not all of which are
available as option in the user interface. With this text field, however, you can
add them manually.
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8.1.5 Command Line Tab

In this tab you can view the full command line of the currently configured task. 

Use the context menu or the corresponding buttons below the command line to
save the TreeSize task to a configurable batch file, to run the TreeSize task
now, or to copy the task to the clipboard.
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8.1.6 Schedule Tab

Here you can specify when and in which interval the task should be executed.

Schedule Interval

Once
The task will be executed only once, at the specified
"Start at" date and time.

Daily
The task will be executed every day, or all 2,3,4... days,
starting at the date and time specified under "Start at".

Weekly
The task will be executed weekly (on a specified week
day), starting at the date and time specified under
"Start at".

Monthly
The task will be executed monthly. You can set up a
task to run either

· on all specified days. For example: "On day 1,15,
and 30 of the month.

· on certain weekdays, such as "every second and
last Monday" of the month.
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Both options will be applied after the starting time and
date that was specified under "Start at".

8.1.7 All Tasks Tab

Shows a list of all scheduled Windows tasks that trigger an execution of
TreeSize. 

This list shows detailed information about each task:

Name
The name that was given to the task when it was
created. This can help you identify unique tasks, for
example a specific search, or a monthly scan.

Command line options
Shows the command line parameters that will be used
for this task.

Schedule options
The time parameters that were defined for this task.
This determines when and how often it will be
executed.

Run as...
The account information that is used for this task.
Please note: If no explicit options file is used for this
task, TreeSize will use the settings of this user.
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Last Status
The last status of this task. This column shows if the
last execution of a task was successful, if it failed, or if
it has never been executed yet.

By right clicking one of the tasks, you can open the context menu that allows to
activate or deactivate an existing task, edit it in Windows directly, or perform
other operations. Some of these can also be quickly accessed via the buttons
at the bottom of the page:

Edit Task
Allows you to load the currently selected task into the
schedule dialog, so that it can be modified.

Delete Task
Deletes the currently selected task.

Activate/Deactivate
Task

Activates or deactivates the currently selected task.

Execute Task
Executes the selected task, using the specified user
credentials of the task.

Import from file
Allows to import existing tasks from an XML file. This
can be useful when migrating existing tasks from an
existing system to a new one.

Export to file
Exports an existing task to an XML file, which can be
imported again at a later point in time, or on a different
system, using the function "Import from file".

Open Windows Task
Scheduler

Opens Windows' task scheduler dialog.

Event Log
Provides a direct shortcut to the "Application" section
of the Windows Event Log. Any error that occurs
during the execution of a scheduled task will be logged
here.

Refresh List
Loads the list of tasks from the system again and
refreshes the user interface accordingly.

8.2 Command Line Options

The Professional Edition of TreeSize accepts command line options enabling
you to run scheduled scans or to have the results of a scan on your monitor
the next morning. The Schedule dialog  will help you compile a command
line with the options below. Please note: These option are not available in the
Personal Edition.

Treesize.exe [/OPTION] SCANPATH

/?  
or   /HELP

Shows this help page.
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/AGEOFFIL
ES

Saves the graph on the "Age of Files" tab of the scanned
directory to a bitmap, GIF, PNG, JPEG, Text, or CSV file. The file
type depends on the extension of the specified file name. The
following example creates a JPEG image file of the"Age of Files"
graph for your local drive C:

Treesize /AGEOFFILES "C:\Documents\c_file_ages.jpg" "C:\"

/APPENDT
OFILES

If this option is used, TreeSize will append its output to existing
files when doing an export, e.g. when using /TEXT.

Please note: This parameter will not work with exported
images, XML and PDF files. Those files will be overwritten,
except when using the switch /DATE.

/ARCHIVEBI
TFILESONL
Y

This option will include only files for which the archive bit set in
the scans. This option can be very useful if you want to calculate
the size of a backup. In this case, you can create a shortcut on
your desktop or in your start menu that will automatically start
calculating the size of your backup. Example:

Treesize /ARCHIVEBITFILESONLY "\\Server\Backup\This"

/ATTACH
If specified, all exported files will be attached to the email. If not
specified, files with an explicitly given path are not attached. This
is useful in case you XML or Excel files are getting quite large
and fill up you email account.

This example will export to an Excel file but not attach it to the
mail:

TreeSize.exe /EMAIL "treesize@example.com" /EXCEL "C:
\Temp\test.xlsx" "F:\"

These examples will attach the Excel file to the email:

TreeSize.exe /EMAIL "treesize@example.com" /EXCEL "F:\"

TreeSize.exe /EMAIL "treesize@example.com" /ATTACH /EXCEL
"C:\Temp\test.xlsx" "F:\"

/BARCHART
<filename>

Saves the bar chart of the scanned directory to a bitmap, GIF,
PNG, or JPEG file. The file type depends on the extension of the
specified file name. This example creates a PNG image file of
the bar chart for your local drive C:

Treesize /BARCHART "C:\Documents\c.png" "C:\"

/COMPARE
<filename|
path>

Compares the scanned path with a saved XML report. The
following example scans drive C: and compares the result with a
saved XML report for this drive:

Treesize /COMPARE "C:\Reports\TreeSize\c.xml.zip" "C:\"

Instead of an XML file, you can also use a path with this
command line parameter. The given path will be compared with
the current scan result. The following example scans drive C:\
and additionally uses the path D:\Backup_of_C to perform a
comparison between the two:

Treesize /COMPARE "D:\Backup_of_C" "C:\"
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Alternatively, you can compare two already existing XML reports
e.g. "c1.xml.zip" and "c2.xml.zip" by using this command :

Treesize /OPEN "C:\Reports\TreeSize\c1.xml.zip" /COMPARE "C:
\Reports\TreeSize\c2.xml.zip"

The /OPEN command prepares the comparison of the two files
by expanding the first file ("c1.xml.zip") into a scan file. The
second file ("c2.xml.zip") will be compared to this expanded scan
file, just like it would happen, if "c2.xml.zip" was compared to a
"real" scan.

/COPYTO
<path>

This option can only be used in combination with the command
line option /SEARCH .
It copies the results of a TreeSize file search  to the target
location. 
The following command will search on your local drive C: using
the latest search options and copies the search results to the
folder "C:\temp\ObsoleteFiles":

Treesize /SEARCH:Start /COPYTO "C:\temp\ObsoleteFiles" "C:\"

See also: Move checked files

/CREATED
PASTDAYS
ONLY <n>

This option will include only files in the scans, which were
created during the number of days entered in the argument. In
the following example, this option will only include only files
created during the last eight days in the scan:

Treesize /CREATEDPASTDAYSONLY 8

It corresponds to the option "Include only files created in the past
X days" in the Options  dialog.

/CREATESN
APSHOT
<drive>

Creates a snapshot for the drives that are given after this
command line paramter. Example:

Treesize /CREATESNAPSHOT "C:\" "D:\"

Creating snapshots may require administrative privileges.

/DATE 
This switch will add the current date and time to all export file
names in the command line. This is useful if you want to do
scans regularly, e.g. every night or every weekend. The following
example will scan the network path "\\Host\Share" and save the
result to a file like "C:\Scans\name_2013-08-14_17-18-24.xls":

Treesize /DATE /EXCEL "C:\Scans\name.xls" "\\Host\Share"

/DEDUPLIC
ATE

This option can only be used in combination with the command
line option /SEARCH .
It will replace the duplicate files that were found by the TreeSize
duplicate file search  with NTFS hardlinks :

Treesize /SEARCH:Start /DEDUPLICATE "C:\"

/EMAIL
<recipient>

Sends the collected data to the given email address. This
parameter can be used only once on the command line, and only
one email with all results will be sent. Multiple recipients can be
separated with semicolons (;) or commas. To send emails via
the command line, you need to specify valid SMTP settings on
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the corresponding page  in the TreeSize options dialog.
Example:

Treesize /EMAIL treesize@example.com "\\SERVER\C$"

If no other parameters have been specified, the email will be sent
in the format that is set in the options (HTML or plain text). If you
would like to define the format independent from the current
options, you can use the parameters /TEXT or /HTML right
behind the definition of the recipient address(es). Example:

Treesize /EMAIL treesize@example.com /TEXT "\\Server\Share"

By combining parameters you can also add attachments to the
email. The following example will add an Excel report of the scan
as an attachment to the email:

Treesize /EMAIL treesize@example.com /EXCEL "\\Server\Share"

/EMAILIFRE
SULTSFOU
ND 

This option can only be used in combination with the command
line options /SEARCH  and /EMAIL . If this parameter is
specified, TreeSize will only send an email with the current
search results, if at least one file or folder has been found during
the search, by any of the specified search types.

/EMPTYRE
CYCLEBIN

If you use this option, TreeSize will empty the recycle bin before
running the current scan. Example:

Treesize /EMPTYRECYCLEBIN "C:\"

/EXCEL
<filename>

Exports the collected data in Microsoft Excel format and saves it
under the entered file name. Supported formats are the
conventional .XLS file format (Excel 97-2003) as well as the
.XLSX format (introduced with Excel 2007). The used format
depends on the extension of the specified file name. The
application will terminate itself after saving. Example:

Treesize /EXCEL "C:\Documents\c.xls" "C:\"

If the file name already exists, the file will be opened and a new
worksheet will be added. 

Please note: In the TreeSize File Search (/SEARCH) the results
of each search type are collected in their own specific
worksheet. If the file under the given path already exists, these
sheets will be overwritten. To prevent this, you need to use the
command line option /APPENDTOFILES.

/EXCLUDE
<pattern1;pa
ttern2>

This option enables you to specify patterns for files and folders
that should be excluded from a scan. Multiple exclude patterns
can be separated using a semicolon (;). If one or more of the
patterns contain spaces, the complete pattern string must be set
into quotes ("). The following example will ignore files and folders
that end with ".tmp" or where the exact name is "system":

Treesize /EXCLUDE "*.tmp;system" "\\Server\Users"

/EXPAND
<level|size>

This option lets you specify how many levels in the directory tree
will be expanded after scanning. If you don't specify a number
after this option, all folders will be expanded. Instead of a
directory level you can also indicate an amount in Mega Byte
(MB). In this case all folders larger than the given amount will be
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expanded. The unit "MB" must follow the number without a blank.
The following example will scan the folder "H:\User", expand all
folders larger than 10 MB and save the result to the Excel file "C:
\Results\Allusers.xlsx":

Treesize /EXCEL "C:\Results\Allusers.xlsx" /EXPAND 10MB "H:
\User"

/EXPANDAB
LEREPORT

If this option is used, Excel exports will use
expandable/collapsible groups that can be navigated similar to
the directory tree.

/EXPORTD
RIVESLIST
<filename>

This option enables you to export the contents of the "Drive
List " to an Excel, Text, or CSV file. The file type depends on
the extension of the specified file name. Example:

Treesize /EXPORTDRIVESLIST "C:\Results\AllDrives.csv"

/EXPORTFI
LES 

If specified, files will be included in all exports. So this option is
equivalent to activating the option "Tools > Options > Export > * >
Exported elements > Include single files in export "

/EXPORTG
ROUPSEXP
ANDED

if specified, the export of the extensions list  will contain all
information about the extensions contained within groups. 

/EXPORTPA
THSLIST
<filename>

This option can only be used in combination with the command
line option /SEARCH .
Exports a simple list that contains all search results. The list will
contain only the full paths of the search results and no other
information. Supported formats for the destination file are .txt and
.csv. 
This example will search for, and create a list of all exe files on
drive C:

Treesize /SEARCH:Start /FILTER "*.exe" /EXPORTPATHSLIST "C:
\Results\SearchResults.csv" "C:\"

It can be used to import results of a previous search back into
the user interface, by using "File > List of paths > Import path
list", or the parameter /IMPORT .
If the option "Tools > Options > Export > Include duplicate
groups " is activated, you can also use this function to export
and import results of the duplicate search including their group
structure.

/EXTENSIO
NSLIST
<filename>

This option enables you to save the statistics on file extensions /
file types of the scanned file system branch to an Excel, HTML,
Text, or CSV file. The file type depends on the extension of the
specified file name. The exported columns will be those that
were enabled in the user interface on the tab "Extensions" when
it was last used, or at the time when the configuration file
supplied via /OPTIONS  was written.

The following example scans drive C: and creates an Excel file
named "D:\TreeSize Reports\C_filetypes.xls" with the statistics
of the file types on this drive:
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Treesize /EXTENSIONSLIST "D:\TreeSize
Reports\C_filetypes.xls" "C:\"

/EXTENSIO
NSCHART
<filename>

Saves the small graph shown on the bottom of the
"Extensions " page to an image file (bitmap, GIF, PNG, or
JPEG).

/EXTENSIO
NSPIECHAR
T
<filename>

Saves a piechart that shows the distribution of "file extensions
" to an image file (bitmap, GIF, PNG, or JPEG).

/FILTER
<
p
a
t
t
e
r
n
1
;
p
a
t
t
e
r
n
2
>

Sets a file filter counting only files with certain extensions, e.g.
".mp3" or ".doc". Multiple patterns may be passed, separated by
semicolon (;). The following example will search for MP3 and AVI
files in the "Users" directory on the server:

Treesize /EXCEL "C:\Results\UsersMediaFiles.xlsx" /FILTER
"*.mp3;*.avi" "\\Server\Users"

When performing a TreeSize File Search (/SEARCH), you can
also use the /FILTER command line switch to specify the
patterns of the Custom File Search . To perform a more
complex custom file search you should save the search
options  to a file and pass the resulting XML file to the
command line after /SEARCH.

/FOLLOWR
EPARSEPO
INTS

If this switch is added to the command line, TreeSize will follow
mount points  and external symbolic links when scanning a file
system tree.

/GROUPSC
ANS

Using this command line switch will group all scanned directories
under a virtual root folder. Use /GROUPSCANS FALSE if you
want to ensure that no virtual root folder is used.

/HIDESMALL
FOLDERS
<value>

Allows to hide objects that are smaller than a minimum size,
which is useful for getting clear exports. <value> can be a size
value with unit, or a plain byte value without unit. Cannot be used
in combination wih /EXPAND. In this example only folders having
a minimum size of 50MB will be exported:

TreeSize /HIDESMALLFOLDERS 50MB /EXCEL "C:
\Results\DriveC.xlsx" C:\

/HISTORYC
HART
<filename>

Saves the graph on the "History " tab of the scanned directory
to a bitmap, GIF, PNG, or JPEG file. The file type depends on the
extension of the specified file name. This example creates a
JPEG image of the history graph for drive C:

Treesize /HISTORYCHART "C:\Documents\c_history.jpg" "C:\"
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/HTML
<filename>

Saves the collected data to a HTML file which can be viewed with
any HTML browser. You can specify which information of the
scan will be included in the export via "Home > Options > Export
> HTML > Charts and lists to include . You can select which of
the additional lists, or charts should be added to the export. They
will automatically be embedded into the HTML file that is
generated after the scan.

The following example will generate an HTML report for the drive
C: and save it to "D:\HTML":

Treesize /HTML "D:\HTML\treesize.html" "C:\"

If you would like to scan and export multiple drives or folders, we
recommend either using one call for each drive or folder or using
the command line option presented in the following example:

Treesize /HTML "D:\HTML\drive-c.html" "C:\" /HTML "D:
\HTML\drive-d.html" "D:\"

If you want more than one scan to be part of the HTML file, you
should add the command line switch /GROUPSCANS. When
exporting to HTML without an included image, you could
alternatively us the switch /APPENDTOFILES.Without one of
these flags, the HTML file will get overwritten.

/IMPORT
<filename>

This option can only be used in combination with the command
line option /SEARCH .
Loads a list of paths into the user interface of the TreeSize file
search . The file can be in .txt, or .csv format. This parameter
can be used to import results of a previous search. The imported
files and folders can be moved/copied/deleted/archived, like any
"live" search result, using the file operation dialog .
Example:

Treesize /SEARCH /IMPORT "C:\Results\filelist.txt"

You can also combine this parameter with the
parameter /MOVETO , to automatically move or delete the files
that are contained in the text file. Example:

Treesize /SEARCH /IMPORT "C:
\Results\filesToDelete.csv" /MOVETO "Recycle Bin"

/LISTSEPAR
ATOR
<separator
char>

Enables you to define the separator used when exporting text or
CSV files. Text files use the tabulator by default, CSV-files the list
separator from the regional settings of the Windows control
panel. Please specify a single character or the string "TAB" for
tabulator after this switch. Examples:

Treesize /LISTSEPARATOR ; /TEXT "C:\Results\c.txt" "C:\"

Treesize /LISTSEPARATOR TAB /TEXT "C:\Results\c.csv" "C:\"

/MOVETO
<path|zip
file|"Recycle
Bin"|
executable>

This option can only be used in combination with the command
line option /SEARCH .
It moves the results of a TreeSize file search  to another
location, ZIP file, the recycle bin, or passes them to an
executable file as parameter. To move the files to the recycle bin,
specify the name of the recycle bin (as seen in the Windows
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Explorer) or "Recycle Bin" after the /MOVETO option. 
The following command will search on your local drive C: using
the latest search options and moves the search results to a ZIP
file called "ObsoleteFiles.zip":

Treesize /SEARCH:Start /MOVETO "C:\temp\ObsoleteFiles.zip"
"C:\"

This call moves the search results to your system recycle bin
instead:

Treesize /SEARCH:Start /MOVETO "Recycle Bin" "C:\"

This example will load saved search options  with the file
name "SearchOptions.xml" and move all files that were found to
the path "E:\Obsolete Files":

Treesize /SEARCH:Start /MOVETO "E:\Obsolete Files"
"SearchOptions.xml"

This example uses the same search options, but instead of
moving the files it will pass the full file path to your batch file
"Archiver.bat". This batch file may e.g. trigger an archiving
process for the passed files:

Treesize /SEARCH:Start /NOGUI /MOVETO "Archiver.bat"
"SearchOptions.xml"

For ZIP files the /DATE parameter can be used to add the current
date and time to the ZIP file name.

See also: Move checked files

/NOGUI
No window will be shown and the application will not appear in
the task bar. Useful to execute scans or searches in background,
without visual feedback. 

Caution: Use this switch only if you have tested the rest of the
command line options because error messages cannot be
displayed in this mode. 
However, errors will be logged in the Windows event log.

/NOHEADE
RS

Omits the header lines usually written on top of scan or search
export files. This makes it easier to receive plain data for
postprocessing.

/NOUNITS
Omits the units usually written after size values. This option in
combination with /SIZEUNIT 0 will export plain byte values. This
makes it easier to receive plain data for postprocessing.

Please note: This command line will only effect exports of the
directory tree, generated by using
the /TEXT, /EXCEL, /HTML, /EMAIL, or /PRINT
options. /EXTENSIONSLIST, /USERSLIST, /EXPORTDRIVESLI
ST, or /TOPFILESLIST will not be effected.

/OPEN
<filename>

Opens a saved XML report  on application start. Example:

Treesize /OPEN "C:\Reports\Drive_C.xml.zip"
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/OPTIONS
<filename>

Use this parameter to apply exported user settings to TreeSize.
User settings can be exported at "File > Options > Export".
Example:

Treesize /OPTIONS "C:\Temp\User Settings.xml"

Hint: Change as many settings a possible in the user interface
before saving the options to reduce the amount of command line
parameters you need. 

/PDF
Saves the results to a PDF file after the scan or search is
finished. The application will terminate itself after saving. The
following example will execute a scan of your local drive C: and
save the results to a PDF file:

Treesize /PDF "C:\Results\C_scan.pdf" "C:\"

/PIECHART
<filename>

Saves the pie chart of the scanned directory to a bitmap, GIF,
PNG, or JPEG file. The file type depends on the extension of the
specified file name. The following example will scan the drives C:
and D: and exports a pie chart for each one in PNG format:

Treesize /PIECHART "C:\Reports\C_pie.png" "C:\" /PIECHART
"C:\Reports\D_pie.png" "D:\"

/PRINT
Prints a report for the scanned directory tree using default printer
configured in your system settings. The application will be
terminated after printing. Example:

Treesize /PRINT "\\SERVER\USERS" 

/RESTRICT
ED

Starts TreeSize in a restricted mode in which many features are
disabled that are not of interest for "normal" (non-admin) users.
Among the disabled features are: Check for Update, Open
Software applet of Windows Control Panel, Schedule TreeSize
scans, connect network drive, configure Windows System
Restore, Run as administrator, exports, and apply NTFS
compression. You can supply a path that should be scanned,
e.g. the user's home directory, at the command line or using the
Startup Paths  in a saved configuration file. If you additionally
pass the command line option /READONLY, the user won't be
able to delete or move files in TreeSize, so it will be usable as
reporting tool only.

/SCAN
<filename>

Scans all paths that are found in the text file specified after this
switch. The text file must contain one path per line. The following
example scans all paths that are found in the file "D:
\PathsToScan.txt" and writes each scan result to a separate
sheet in an Excel File with today's date:

Treesize /EXCEL "D:\Results\%DATE%.xlsx" /SCAN "D:
\PathsToScan.txt"

You may also call TreeSize in a "for" loop with one of the paths
only, please find an example below .

/SEARCH[:<
Start|
Internet>]

Opens the File Search  window of TreeSize. If ":Start" is added
to this command line option, the search is started immediately
with the last settings. A previously saved XML file containing
search settings  may be passed, these settings will then be
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used to perform the search. Please note that files which are
found in this search are automatically checked. The following
example performs the search with settings that have previously
been saved to the file "SearchSettings.xml" and saves the results
to at text file:

Treesize /SEARCH:Start /TEXT "T:\SearchResult.txt"
"SearchSettings.xml"

If ":Internet" is added to this command line option, it will start
searching for temporary internet files . The drives activated
during the last regular scan will be scanned, a special set of
drives and paths can be specified on the command line
(separated with blanks). Example:

Treesize /SEARCH:Internet "C:\"

Hint: In general, the last search settings or a former saved set of
search settings will be used. However, you can specify the
search patterns for the custom search  using the /FILTER
command line option.

/SHEETNAM
E <title>

Enables you to specify the name of the sheet that will be added
to an Excel file when using the /EXCEL  command line switch.
Please note that an Excel sheet name must be unique in an
Excel file and certain special characters like slashes,
backslashes and colons are forbidden. TreeSize will always
create a unique sheet name by replacing invalid character with
underscores and by adding date and time if necessary.

/SHORTDA
TEFORMAT
<format>

Alters the short date format for this process, which can be
configured in the regional options of the Windows Control Panel.
Exports of TreeSize will use this format for date values. 
Example:

Treesize /SHORTDATEFORMAT YYYY-MM-DD /TEXT "D:\export.txt"
"E:\"

/SIZEUNIT
<n>

This option can be used to specify the unit to be used for
displaying size values: N can have the values 0 to 5 which mean:
0 = Bytes, 1 = KB, 2 = MB, 3 = GB, 4 = TB, 5 = Automatic Units.
Without this option the last used configuration in TreeSize will be
used.

/SORTBY
<ColumnNa
me>

Enables you to specify by which value the generated exports will
be sorted. Possible values are column names like "Size" or
"Name". The last used sort type in the TreeSize user interface
will be used by default. Example:

Treesize /SORTBY Size /TEXT "D:\export.txt" "E:\"

Treesize /SORTBY Name /EXCEL "D:\export.xlsx" "E:\"

/SUBJECT
<subject>

This option allows you to customize the subject that will be used
for emails that are sent at the end of the scan. Example:

Treesize /EMAIL treesize@example.com /SUBJECT "TreeSize
Professional Scan Report" "\\Server\Share"
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/TEXT
<filename>

Saves the results to a text or CSV file after the scan or search is
finished. The application will terminate itself after saving. The
following example will execute a scan of your local drive C: and
save the results to a text file:

Treesize /TEXT "C:\Results\C_scan.txt" "C:\"

This example will save the results of a File Search on your local
drive C: with the last search configurations to a CSV file:

Treesize /SEARCH:Start /TEXT "C:\Results\C_search.csv" "C:\"

/TITLE
<title>

Can be used to change the scan title in a printed report or
exported file. This allows you to supply additional information to
the user when using TreeSize in an automated environment. The
use of environment variables is allowed. Example:

Treesize /TITLE "This is drive C on Server3" /PRINT "\
\Server3\C$"

The title will be applied only to scans which appear after this
options on the command line. Multiple /TITLE flags are allowed to
apply separate titles to different scans.

/TOPFILESL
IST
<filename>

This option enables you to save the contents of the Top 100 list
to an Excel, HTML, Text, or CSV file. The file type depends on the
extension of the specified file name. Example:

Treesize /TOPFILESLIST "C:\Temp\C_top_files.txt" "C:\"

/TREEMAP
<filename>

Saves the treemap of the scanned directory tree as bitmap, GIF,
PNG or JPEG file. The file type depends on the extension of the
specified file name. Example:

Treesize /TREEMAP "C:\Dokumente\treemap.jpg" "C:\"

/USERSLIS
T
<filename>

This option enables you to save the statistics showing the results
grouped by username to an Excel, HTML, Text, or CSV file. The
file type depends on the extension of the specified file name. The
exported columns will be those that were enabled in the user
interface on the tab "Users" when it was last used, or at the time
when the configuration file supplied via /OPTIONS  was
written.

The following example scans drive C: and creates an Excel file in
"C:\Temp" with the statistics of the users on this drive:

Treesize /USERSLIST "C:\temp\C_users.xls" "C:\"

/USERNAM
E
<username>

Specifies the username that should be used to authenticate for
the scans. Use /PASSWORD to specify a password for this
username. It is recommended to instead use the Microsoft tool
RUNAS.

/USERFILTE
R
<username>

With this option only files owned by a certain user will be taken
into account when scanning. Provide the name of this user after
this switch. Please note that you cannot use multiple user names
here, but the  wildcards "*" and "?" are supported. Example:

Treesize /USERFILTER miller "\\Server\GroupDrive"
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/USERSCH
ART
<filename>

Saves the small graph shown on the bottom of the "Users "
page to an image file (bitmap, GIF, PNG, or JPEG).

/USERSPIE
CHART
<filename>

Saves a pie chart that shows the "user statistics " of the
current scan to an image file (bitmap, GIF, PNG, or JPEG).

/VIEWTYPE
n

Defines on which values the "Percent of Parent", the "Growth"
columns and the "Age of Files" chart are based. Possible value
are:

2: Size
3: Allocated Space (Size on disk)
7: Number of Files

/XML
<filename>

Saves the scan results to a XML file that can be loaded for
comparisons at a later date. Example:

Treesize /XML "C:\Results\Allusers.xml.zip" "H:\users\"

This option can be combined with the /EXPAND switch to limit
the exported directories.
Please note: When loading a limited XML export to TreeSize,
you cannot navigate though the complete directory branch, but
only the exported directories.

SCANPATH
At the end of the command line, you may pass one or more
paths that should be scanned by TreeSize. 
Several paths are separated using a blank. Paths containing a
blank has to be quoted ("). Example:

Treesize "C:\Program Files\" "C:\Windows"

The wildcards "*" and "?" are allowed. Example:

Treesize "H:\users\A*"

To start one instance for each folder, you may use the Windows
"for" command like this:

for /D %i in (H:\Users\A*) do @start /w Treesize.exe %i

In case an error occurs, it will be returned as Windows error code in the exit
code of the process. Environment variables (e.g. %APPDATA%) can be used
In filenames for the export as well as in the scanned paths.

Scanning Multiple Directories

If you need to scan multiple directories, it might be a good idea to merge
several calls in a Batch file, for example:

START /WAIT "TreeSize" "C:\Program Files\JAM Software\TreeSize
Professional\Treesize.exe" /EXCEL "D:\Share1.xls" "\\Server\Share1"

START /WAIT "TreeSize" "C:\Program Files\JAM Software\TreeSize
Professional\Treesize.exe" /EXCEL "D:\Share2.xls" "\\Server\Share2"

START /WAIT "TreeSize" "C:\Program Files\JAM Software\TreeSize
Professional\Treesize.exe" /EXCEL "D:\Share3.xls" "\\Server\Share3"
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The command "START /WAIT" ensures that the jobs start sequentially. Not
starting the jobs parallel is usually better because a single job takes more
advantage from caches and system resources. It is also possible to store the
shares that should be scanned in a text file and use the Windows "for"
command like this:

FOR /F %%p IN (Paths.txt) DO START /WAIT Treesize.exe /EXCEL "c:
\temp\TreeSize-Reports-%DATE%.xls" "%%p"

FOR /F "tokens=1" %%i IN (Shares.txt) DO START /WAIT Treesize.exe /EXCEL
"c:\temp\%%i.xls" "\\Server\%%i"

Please note: The double percent characters are required in batch files, on the
command line use a single percent only.

Scheduled Start

You can use the Windows Scheduled Tasks to run TreeSize with certain
command line options daily, weekly, or monthly at a certain time. The
"Schedule Dialog " of TreeSize will help you setting up a scheduled task.

You can also use the "SCHTASKS" command to perform scheduled scans. If
you, for example, want to scan the drives C: and E: next night at 03:00 a.m.
and save the results to an Excel file, you could use the following command line:

SCHTASKS /Create /SC DAILY /ST 03:00 /TN TreeSizeScan /TR "'C:\Program
Files\JAM Software\TreeSize\Treesize.exe' /EXCEL C:\Temp\tsp.xls /EXPAND
2 C:\ E:\"

Get help about the "SCHTASKS" command on Microsoft's pages or by typing:

SCHTAKS /Create /?

Please note: Error messages occurring during scheduled scans are listed in
the systems Windows event log.

PowerShell

Windows PowerShell can be useful in combination with TreeSize. This
example shows how to search a couple of remote computers that are queried
using an LDAP query in the Active Directory (AD):

$computer = Get-ADComputer -SearchBase "ou=client
computers,ou=intranet,dc=intranet,dc=jam-software,dc=com" -Filter *
foreach ($comp in $computer.name)
{
    $path = "\\$comp\C$\Windows"
    Add-Content Scan.txt "$path" 
}
#debug
Get-Content -Path Scan.txt
# start TreeSize with the collected paths
&"C:\Program Files\JAM Software\TreeSize
Professional\Treesize.exe" /SEARCH:Start /SCAN Scan.txt /FILTER
*.exe /Export FoundFiles.txt

Windows Scripting Host

If you intend to use the Windows Scripting Host (WSH), your command to start
TreeSize will look like:
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Set Shell = CreateObject("WScript.Shell") 
Shell.Run """C:\Program Files\TreeSize Professional\Treesize.exe"" /XML
""C:\Reports\drive_c.xml.zip"" ""C:\""" 

Exit Codes

If the operation was completed successfully, the exit code is 0. If an error
occurred TreeSize will return a Windows error code as exit code if available, or
1 to indicate a general error. In any case the Windows Event Log will contain
further information in the "Application" log, Event Source "TreeSize".

8.3 How to schedule a file search

Like the main module, the TreeSize File Search can also be scheduled as a
task, that runs at certain times. The general approach to create such a task is
to set up a search in the user interface and then selecting "Tools > Schedule
current search"  from the ribbon menu.

The following description shows an example configuration and demonstrates
the different steps that are necessary to create your own, customized search
task.

Step 1: Set up a search via user interface

The file search offers a vast variety of different options that can be customized
to your specific use case. The first step in creating a task is to set up either
one of the predefined search types, or to create a new custom search . Any
combination of options, including the selection of multiple different searches, is
possible.

Step 2: Execute the search and check the results

Once you have set up the search, it is best to execute it and validate that it
returns the desired results. The more specific a search is, the more likely it is
that you need to do a bit of tweaking to ensure that only the results are returned
that match your given use case. The following example will return all audio files
on drive C:\, except those that are located within the Folder C:\Windows:
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Step 3: Create a task with the current search settings

The final step is to open the schedule dialog , using the option "Tools >
Schedule current search"  from the ribbon menu. At this point, TreeSize will
automatically take your current search parameters and create an option file
that represents the search that was just set up. Under "Options" , you can
see that the file was automatically included to the task.

Please note: Any previous selection that was made in the "File operation "
dialog, such as the creation of a log file, or the different "Move options" will be
added to the options file as well. If you add any type of file operation to the task,
it will use these settings as well.

After setting up the task with the desired schedule options and defining export
or move operations, you can review the command line parameters  under
"Command Line". Here, you can also test the current task, copy its parameters
to the clipboard, or create a batch file.

Once everything is set up, click "Save Task" and enter your credentials, to
create a new task and add it to Windows' task library.

8.4 How to schedule a move or delete operation

This chapter explains how you can set up a search that automatically moves
all files and folders that were found to another location. This also applies if you
want to delete, archive, or copy the search results with the help of an
automated task, or batch file.

The basic steps that are required for the creation of an automated search can
be found in the previous chapter . The same steps are needed, if you want to
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create a task that automatically moves the search results. However, the main
difference is, that you need to define the move options that should be used,
before scheduling the task. Possible options include the creation of a log file,
an undo script, or whether or not you want to use the same directory structure
when moving files, that they had in their original location.

These options can be changed under "Home > Move items”. The “move” dialog
not only allows to trigger the actual operation, but it also contains a section with
possible settings that are applied to move operations in general. Make sure to
apply your preferences in the groups "Move Options" and "Logging":

 

After choosing the desired options, click “Close” to dismiss the dialog and
apply the selected settings.
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If you select “Schedule current search ” to open the scheduler at this point,
TreeSize will automatically generate a settings file with your current search
configuration, including the previously selected move options. Under "Move
Operation ", you can then select the operation that you want to perform
(delete, move, copy, or archive).

9 Tips & Annotations

· Especially scans of larger network drives may take a long time. With the
Professional Edition you may perform such scans overnight using
Scheduled Scans  and save the results to a XML file which can be loaded
again later.

· Use the TreeSize File Search  to find obsolete files on your hard drives. 

· TreeSize supports drag&drop file system operations in many places.

· For continuous analyzing of disk usage on large servers we recommend our
product SpaceObServer. It collects the data using a background system
service and stores it in a SQL database. It uses less RAM than TreeSize,
and the reporting capabilities are more flexible because it is built on a
database. More information is available at  https://www.jam-
software.com/spaceobserver/

9.1 Notes on NTFS

The file system NTFS can be used with the operating system Windows NT or
later. It offers some special features which also have effects for TreeSize. We
will describe some of these features and their impacts on this software in the
following paragraphs.

Access Control Lists

The way users can access files and folders can be restricted. One can grant
or deny other users or groups certain rights like reading, writing, executing or
deleting. That way one can even deny administrators to access files and
folders. If an administrator tries to access a folder in the Windows Explorer to
which the owner denied any other users reading access, an "Access Denied"
error message will be displayed. However, TreeSize is able to scan such
folders, if you are logged in as administrator or as a user that has the right to
perform backups (This option can be changed at "Control Panel >
Administrative Tools > Local Security Policy" and with the user editor of
Windows).

File Based Compression

NTFS supports compression on an individual file basis. Files that are
compressed on an NTFS volume can be read and written without first being
decompressed by another program. Decompression happens automatically
and transparently during the reading of the file. The file is compressed again
when it is saved. 

The space occupied by a compressed file is usually much smaller than its
normal size. As a consequence, for folders that are partially or completely

105
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compressed, the allocated space reported by TreeSize may be smaller than
the size reported for this folder. TreeSize is able to show the compression ratio
in an extra column on the "Details" tab. Additionally it can show compressed
files and folders in a different color. These features can be turned on or off in
the Options  dialog.

TreeSize is able to compress and decompress entire file system branches
using the context menu.

In Windows 10 Microsoft introduced new transparent compression-features in
NTFS, designed to compact the files of the operating system, mainly DLL and
EXE files. In contrast to old file based compression, these files are not flagged
as compressed in their file attributes.

Sparse Files

Files which are large but only partially used are called sparse files. Because
the operating system does not allocate disk space for the unused parts of a
sparse file, it occupies less disk space than its actual size is. TreeSize treats
sparse files like compressed files and also calculates the compression ratio for
them.

Reparse Points: Volume Mount Points and Symbolic Links

A volume mount point is an existing path where you "mount" another volume.
Given this, users and applications can refer to the mounted volume by that
path. There is no need to assign a drive letter to this volume. It allows you to
unify multiple file systems into one logical file system. Symbolic links, also
known as junction points, work similar: If you for example have an empty folder
"C:\Documents\Images", you can create a symbolic link to "E:\Pics" for it.
Applications will then see the content of "E:\Pics" in "C:\Documents\Images".
Unlike an NTFS junction point a symbolic link can also point to a file or remote
SMB network path.

If the Option  "Follow Mount Points and Symbolic Links" is turned on,
TreeSize will include the contents of these folders when scanning. Since they
are not physically stored on the drive you are scanning, this may produce
results for the allocated space that are larger than the total size of the drive.

Alternate Data Streams (ADS)

In NTFS, a file consists of different data streams. One stream holds the
security information (access rights and such things), another one holds the
"real data" you expect to be in a file. There may be alternate data streams,
holding data the same way the standard data stream does. These alternate
data streams are hidden. That means that you can have a file with 1 byte in the
official main data stream and some hundred MB in one or more alternate data
streams. The dir command, file managers or windows explorer will show 1
byte as the size of this file, but it actually allocates much more space on your
hard drive.
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TreeSize can detect alternate data streams and add their sizes to the allocated
file size. 
Please note: ADS may store information in the same cluster as the main data
stream, so if a file has one or more ADS, this file does not necessarily allocate
more disk space.

You can choose to detect alternate data streams, to get a more accurate
allocated space of directory branches, in the TreeSize Options  dialog. This
option is deactivated by default, because querying the ADS takes some time
and increases the overall time needed for a scan. You can search for files
containing alternate data streams using the Custom File Search of TreeSize.

Hardlinks

In a Windows environment a hardlink is a reference, or pointer, to physical data
on a NTFS storage volume. All named files are hardlinks. The name
associated with the file is simply a label that refers the operating system to the
actual data. On NTFS volumes, more than one name can be associated with
the same data. Though called by different names, any changes made will
affect the actual data, regardless of how the file is called at a later time.
Hardlinks can only refer to data that exists on the same file system. The data is
accessible as long as at least one link that points to it exists. When the last link
is removed, the space is considered free. Please note that all hardlink pointing
to the same file share also the same Security Descriptior (access
permissions).

To create a hardlink, the user must have write permissions for file attributes on
the respective folder branch and on the share, if the drive is not a local drive.

If more than one hardlink points to a file's data, the space is allocated only once
by these files, no matter how many hardlinks exists. In the Options  dialog
you can tell TreeSize to detect hardlinks, to get a more accurate allocated
space of directory branches. This option is deactivated by default, because

62
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querying the hardlinks takes some time and increases the overall time needed
for a scan.

The TreeSize File Search uses the hardlinks to remove redundant file content
of duplicate files. Use the "Deduplicate " function to remove duplicate files by
using hardlinks. This will reduce the allocated space of your hard disk.

Automatic Data Deduplication

Windows Server 2012 and later offer a data deduplication feature: The data
deduplication segments files with fractionally equal content into so-called
"chunks" which are moved into the subfolder "System Volume
Informaton\Dedup\ChunkStore\" located on the corresponding NTFS partition.
After the deduplication has been applied by Windows, the original data is
replaced by a pointer to the corresponding chunk in the ChunkStore directory.
After they have been deduplicated by the NTFS deduplication two identical files
will only require half of the disk space they occupied before. Since the original
files now only contain a small pointer instead of the data, the allocated disk
space will be indicated by Windows with a much smaller value than before (for
two identical files the occupied disk space would be indicated as "0 Byte"). To
make TreeSize show the original file and folder sizes, simply switch the view
mode from "Allocated Space" to "Size". The "Allocated Space" shown in
TreeSize is the disk space you would obtain by deleting the corresponding file.

Offline Files

Windows Server and some 3rd party tools and appliances offer a feature called
"offline files": Files that have not been used for a long time will be automatically
moved to cheaper and slower storage, and a small stub file remains at its
original location. Usually TreeSize reports the allocated space of such a stub
file correctly, which is often only the size of one file system cluster.

There is however one situation in which the allocated space for stub files may
not be reported correctly. In case TreeSize runs into Access Denied errors, it
uses Windows API functions intended for backup software in order to be able
to scan also those parts of the file system and provide values for their size and
allocated space. We have seen some appliances which reported the full file
size as allocated space in this case for the stub files, most likely because this
would be the size occupied in a backup. To avoid this, ensure that the user
which runs the scans has full read access to the scanned file system and
check this FAQ entry :

9.2 Wasted Space

The wasted space is the amount of space in clusters on your hard disk that are
not entirely filled. This is the last (or only) block of a file.The FAT32 file system
may have very large cluster sizes, depending on the partition size.

FAT32

Partition Size Default Cluster Size

01 - 08 GB 4 KB
08 - 16 GB 8 KB
16 - 32 GB 16 KB

>32 GB 32 KB

115
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If you have a FAT32 with a size of 32GB or more, a cluster size of 32KB will be
used on it. If you store 10 files of 1 KB on this partition, this would use 10 *
32KB = 320KB of disk space, and 320KB - 10KB = 310KB would be wasted.
Especially a huge number of small files significantly increases the amount of
wasted space on FAT32 partitions.

To reduce the wasted space, you can format your hard disk with the NTFS file
system . It usually operates with a cluster size of 4KB and so stores small
files more effective.

9.3 Regular Expressions

Regular expressions describe patterns in strings and can be used i.a. to
determine whether a given pattern occurs in a text or not. In TreeSize regular
expressions can be used to find specific files and / or folders that match the
criteria specified by regular expressions

The following table shows some examples:

Expressio
n

Syntax Description Example

Any
character

. Matches any single
character except a
line break.

a.o matches "aro" in "around" and
"abo" in "about" but not "acro" in
"across".

Zero or
more  

* Matches zero or
more occurrences
of the preceding
expression, and
makes all possible
matches.

a*b matches "b" in "bat" and "ab" in
"about".

e.*e matches the word "enterprise".

One or
more

+ Matches at least
one occurrence of
the preceding
expression.

ac+ matches words that contain the
letter "a" and at least one instance of
"c", such as "race", and "ace".

a.+s matches the word "access".

Beginning
of word

< Matches only when
a word starts at this
point in the text.

<in matches words such as "inside"
and "into" that begin with the letters
"in".

End of
word

> Matches only when
a word ends at this
point in the text.

ss> matches words such as
"across" and "loss" that end with the
letters "ss".

Any one
character
in the set

[]  Matches any one of
the characters in
the []. To specify a
range of characters,
list the starting and
ending characters
separated by a dash
(-), as in [a-z].

be[n-t] matches "bet" in "between",
"ben" in "beneath", and "bes" in
"beside" but not "bel" in "below".
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Any one
character
not in the
set

[^...] Matches any
character that is not
in the set of
characters that
follows the .̂

be[^n-t] matches "bef" in "before",
"beh" in "behind", and "bel" in "below",
but not "ben" in "beneath".

Or | Matches either the
expression before
or the one after the
OR symbol (|).
Mostly used in a
group. 

(sponge|mud) matches "sponge
bath" and "mud bath.

Tagged
expression
(or
backrefere
nce)

\ Matches the
character that
follows the
backslash (\) as a
literal. This lets you
find the characters
that are used in
regular expression
notation, such as
{ and .̂

\^ searches for the  ̂character.

Markierter
Ausdruck

{} Matches text that is
tagged with the
enclosed
expression.

{does}n't identifies the text that
precedes the replacement in the
replace string \1 not to change every
occurrence of doesn't to does not.

Repeat n
times

^n Matches n
occurrences of the
preceding
expression.

[0-9]^4 matches any 4-digit
sequence.

Grouping () Lets you group a set
of expressions
together. If you want
to search for two
different
expressions in a
single search, you
can use the
Grouping
expression to
combine them.

If you want to search for [a-z][1-3] or
[0-9][a-z], you would combine them:
([a-z][1-3])|([0-9][a-z]).

Further examples:

[0-9] or /\d Find all files/folders with at least one digit in its
name. 

a|b Find all files/folders containing "a" or "b" in their
name.

(?=.*a)(?=.*b) Find all files/folders containing at least one "a"
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character and one "b" character.

((?=.*help)|(?=.*online))
(?=.*readme)

Find all files/folders containing the words 'help' and
'readme' or 'online' and 'readme'.

[^(A-Za-z)] Find all files/folders containing at least one other
symbol than a character in their name.

^E[0-9]{7}$ Find all files/folders which start with an "E" followed
by exactly 7 digits.

C:\\Windows\\[^\\]*\.[^\\]
*$

Find all files/folders whose parent folder is "C:
\Windows".

[A-Za-z]:\\([^\\]+\\){2,4}[^\
\]+$

Find all files/folders with a folder depth of at least 2
and at most 4. 

[^\x00-\x7F] Find all files/folders with invalid ASCII characters.

[^\P{C}] Find all files/folders with Unicode characters which
cannot be printed.

[\xA0] Find all file/Folder names that contain the non-
breakable space character (Unicode NOBR,
U+00A0) instead of a normal space character.

[~,\",#,%,&,\*,\:,<,>,\?,\/,\\,
{,|,}]

Find all files and folders, that contain characters in
their name which are invalid on SharePoint
servers.

Further information and additional examples can be found here.

A description of all special characters that can be used with regular expression
can be found here.

For further help in forming regular expressions following tools can be used:

http://gskinner.com/RegExr/ (online)

http://regexpal.com/ (online)

http://sourceforge.net/projects/regexpeditor/ (download)

http://sourceforge.net/projects/regextester/ (download)

http://sourceforge.net/projects/regaxe/ (download)

9.4 Translations

We are proud of the popularity of our award-winning disk space management
software TreeSize and would love to offer it to everyone in her/his native
language. In this way, all our worldwide users can enjoy localized TreeSize
software with ease. TreeSize is already available in German and English.
Thanks to the help of our great volunteer translators we are able to provide
these translations:

https://www.jam-software.com/redirects/?regex_wiki
https://www.jam-software.com/redirects/?regex_libreoffice
https://www.jam-software.com/redirects/?regexr
https://www.jam-software.com/redirects/?regexpal
https://www.jam-software.com/redirects/?regexpeditor
https://www.jam-software.com/redirects/?regextester
https://www.jam-software.com/redirects/?regaxe
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Greek: Thanks to GeoVasi69, and Prodromos Makridis

Spanish: Thanks to MS-PC, J. M. Fustero, and Pichifino

French: Thanks to Alexandre Mongin, David Dissard, Ignace Le Roux, and
Gaillard S-G, and others

Japanese: Thanks to Kyotaro Iijima, Sriram Iyer, and Tetsuro Shimazaki

Dutch: Thanks to Kees Bakker, Linda Bijlsma, Jaap Kramer, Leroux, and
others

Portuguese: Thanks to Ian Lima Souza, Maria Pombo, and Carlos Figueiredo

Russian: Thanks to kopejkin, Polina Morgan, Alexander Vorfolomeev,
Temtaime, Gennady Morozov, and others

Slovenian: Thanks to Boštjan Pecovnik, Jadran Rudec, and one other
unnamed translator

Ukrainian: Thanks to kopejkin

Would you like to help us translate TreeSize to your language? Please find
more information online.

10 Copyright & Contact

Copyright ©1995-2020 by Joachim Marder e.K.

JAM Software GmbH
Am Wissenschaftspark 26
54296 Trier
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FAX: +49-651-145653-29

WWW: https://www.jam-software.com
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Commercial register
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